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1. ABOUT FILEHOLD

FileHold is a document management software system that is easy to use, easy to install, and is
affordable for small to large organizations. It integrates with existing applications and enriches
Microsoft SharePoint deployments. Features include web access, search, version control,
tagging, workflow, secure user rights, mark up and annotations, redaction, scanning, and OCR
and indexing.

Records Management features allow records to be converted to archives, put into legal hold, or
be scheduled for final disposition.

2. ACCESSING FILEHOLD

You are able to access FileHold many ways:
e Web Client via a web browser.
e FileHold Desktop Application (FDA)

e Microsoft Office applications including Word, Excel, Outlook, and PowerPoint

e Mobile FileHold through your mobile device such as an iPhone or Android

Access to files can be gained through any of the methods by users with a valid FileHold
account.

Access via the web client can occur using LAN, WAN, an Intranet or over the Internet. Working
with files via the web client does not require installation of our document management
software. However, to access the system via the FileHold Desktop Application (FDA) or
Microsoft Office applications, users will be required to install FDA on their computer.

The web client and the FDA interface are very similar. You can use either to access the
document Library but it is recommended that you generally use FDA as it is faster than going
over the web and has more advanced functions than the web client. See a list of differences
between the Web Client and FDA.

2.1. FILEHOLD DESKTOP APPLICATION (FDA)

The FileHold Desktop Application (FDA) has a very simple, intuitive and familiar Library
structure similar to your traditional filing cabinets (cabinets > drawers > folders > documents)
and Microsoft Windows Explorer folder hierarchy.
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You may have your connection settings set to automatically log into FileHold when you start
the FDA. If you have not selected that option, you will need to login manually.

2.1.1. FDA Connection Options

In order to connect to the FileHold server via the web client, FDA, or Microsoft Office
applications, you must ensure that you have entered the correct connections settings. The
connection settings are set in the FDA. You must have your username, password, know
whether it is a locally managed account or domain (Active Directory) account, and the URL
path to the FileHold server.

To SeET THE FDA CONNECTION SETTINGS

1. Open the FileHold Desktop Application (FDA) and select File > FileHold Connection
Options.

2. Select the following options that you want to enable:

e Automatically run FileHold application when | logon to Windows — This option will
automatically start up FileHold after you log into your computer.

e Automatically logon to FileHold Library when Desktop Application starts — This option will
automatically log you in after you launch the FDA. You do not need to enter your username
and password.

2 ©FilcHold
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3.

Remain logged in even if no activity is performed — This option keeps your account logged
into the system even if you are not using it. This is dependent upon the settings made by
the system administrator. This option can only be set when logged into the FDA and may
be locked down by a system administrator.

Select one the following options:

Always prompt for credentials — You will always need to log in with a username and
password.

Use my windows account username and password to logon — This uses your Microsoft
Windows account username and password to login. You will need to ask your system
administrator which type of account you are using.

Use the following username and password to logon — Your system administrator will
provide you with a username and password. Enter the username and the password twice.

. Select the default domain:

Local FileHold Account — Select this option if a username and password was provided by
your system administrator.

“Domain Name” — Select this option if you are using your Microsoft Windows user account
to login to FileHold.

Enter the FileHold Server URL. The URL will be given to you by your system administrator
and should be in the format

http://yourcompanyservername/FH/FileHold
or
https://yourcompanyservername/FH/FileHold

Enter the number of maximum simultaneous transfers. This is the number of documents
that can be uploaded or downloaded at a time. This number should be kept at 1. NOTE:
This option may be locked down by your system administrator.

. Select the Share my Inbox with others check box if you want to share your Inbox with other

users of the same local computer. See Sharing Inboxes for more information.

. Click Test URL. If the server URL is correct, you will receive a “Connection Successful”

message.

Click Test Logon. If the username and password are correct, you will receive a “Logon
Successful message.”

10. Click OK.

2.1.2.

Logging into the FDA

Ensure that the connection options have been configured prior to logging in. You may have
your connection settings set to automatically log into FileHold when you start the FDA. If you
have not selected that option, you will need to login manually.

ToLoG INTO FDA

1.

2.

April 2017

Open the FDA. If there is not a shortcut to FDA on your desktop, go to Start > Programs
> FileHold > FileHold Desktop Application.

Select one of the following options:

Go to File > Logon to FileHold Server as username — This uses your stored Microsoft
Windows or locally managed username and password.
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e Goto File > Logon to FileHold Server as... — This allows you to login using an
alternative user name and password than the one that is stored in the connection options.
Enter a username, password, and select a domain. Click OK.

3. You are now logged into FileHold. Click OK to close the Welcome Screen.

e Select the check box on the Welcome Screen to not display this screen when FDA
starts. You can re-enable this screen in the User Preferences.

2.1.3. FDA Menus and Toolbars

The FDA has several methods in which functions can be performed.

e The FileHold toolbar that can be used to perform operations on single or batch (many
documents at once) documents such as check out or get a local copy.

e Arright-click context sensitive menu where only those functions that can be performed will
be available to use.

e The main menu bar where other functions of the FDA can be performed.
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[ Inbox (Send to Library) ~ 4 = 5
-8 My FleHold z - Canadian Union/ Accounting/ AR Select View: = Default View
- iew: 7
s $ @ K 17 g FileHold Toolbar o)
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b Reports ) @ ) 1nvoice-TP0300018851  Invoice 0 1 CheckedIn  08/12/2010 8:55 AM Edit
[l FileHold'09 Reports =
=3 Library @ 2] 1nvoice-TPO300018852  Invoice 0 2 Checked In 08/12/2010 12:45PM Edit
= Canadian Union <7 © B 1nvoice-TP0300029031  Invoice 0 1 Checked Out 08/12/2010 12:51PM
-5 Accounting =i (| S
— * %) Bl o 2 — = 0 Edit
e I} Open
18 AL Make a Local C
[+-{&) Dedsion Tracking ake a Local Copy ) ]
-9 HR Email & Check Out S RIS%h[E-S?tI:Sg r(?r?;r:ﬁ)(t
{5 Legal oy Check Out This Document
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=~ Accounting -
[#-{&) Payments View Linked Documents
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=3 Admlns.strauvell-IR . Create Shortcut
- Autofiing SchemaCabinet
--[Z) Copy of Test Cabinet Cat Copy or Move
(- InvoiceCabinet & Delete
. .
< 1 » Convert to Offline

The following table describes the functionality of the FDA FileHold Toolbar buttons.

Button Description Permissions Needed
&k i Add a file to Library Users with Publisher rights or higher.
Add File
(a Makes a copy of the All users with access to the folder.
Make a documents to the local
local copy user computer.

of Checks out a document for | Users with Publisher rights or higher.
Check editing.

out
S Link Creates a link between two | Users with Publisher rights or higher.
=InK or more documents.
documents
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Button Description Permissions Needed
b ¢ Del Deletes a document from Users with Publisher plus Delete rights or
Delete the Library. higher.
Deleted documents can be
recovered by a library
administrator before a set
amount of time. See the
Library Administration
Guide.
=] Email Emails the document as an | Users with Publisher rights or higher and
ma attachment or as a link in email settings have been enabled by the
the body of an email. library administrator.
=7 Checks the document out Users with Publisher rights or higher and
Check | and sends it in an email email settings have been enabled by the
out and Email | attachment or as a link in | library administrator.
the body of an email.

2.1.4. FDA Shortcut

keys

The following are a list of the hotkeys (shortcut keys) found in the FileHold Desktop

Application.

Shortcut Key

Description

ALT +L Performs a database lookup. Can only be
used when the metadata panel is in edit
mode and the Lookup button is available.

Alt + N Saves the metadata values and moves to

the next document in the list (Save and
Next). Can only be used when the metadata
panel is in edit mode.

ALT + Shift+ S

Saves the metadata in the metadata pane.

Alt+T Invokes Click To Tag when in the metadata
panel.
CTRL+C Copies information about selected

documents from the documents grid to
Clipboard.

CTRL + Shift + O

Adds an offline document

CTRL + Shift + R

Opens the report viewer.

CTRL + Shift + V

Opens the document viewer.

CTRL +V

Adds files from the Clipboard to the current
folder or Inbox. Files can be selected in
Windows Explorer and copied using CTRL +
C (the source files will not be deleted after
uploading) or CTRL + X (the source files will
be deleted).
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2.1.5.

Shortcut Key Description

CTRL+Double-Click Opens the document in its native application
and checks out the document from the
Library at the same time.

CTRL+F Cursor moves to simple “Google” like
Search bar.

CTRL+Shift+A Adds a file to the Library.

CTRL+Shift+F Adds a folder to the Library.

CTRL+Shift+L Logoff from FileHold.

CTRL+Shift+P Show/hide metadata and properties pane.

CTRL+Shift+T Show/hide the document tray.

Double-click Opens a document in its native application

but does not check it out.

F5 Refreshes the screen.

Sharing Inboxes

When importing documents into FileHold, you can now share the contents of your Inbox with
other users if you have sufficient rights.

Documents in the Inbox can be shared between users on the same computer. Sharing your
Inbox allows others to file the contents of your Inbox on your behalf. For example, if there is a
dedicated scanning station with several people scanning documents to be added into FileHold,
all users who can log into the Windows environment of that scanning station will be able to file
all the scanned documents in the Inbox. This is because the Inbox is shared between all the
users who can log in with a Windows user account.

You can set whether you want to share your Inbox in the Connection Options window. Note
that if you change this setting, it won’t take effect until you log off and then log back in.

NOTE: The Shared Inbox check box option is only available to users who have at least the
Write permission to the common application data folder (usually “C:\ProgramData”), which
normally defaults to members of the Administrators group only. See the Manage Imports Tool
in the Library Administrator Guide or the Knowledge Base for more information.
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2.2. WEB CLIENT

To access the FileHold web client, you will need to use a valid web browser. See the browsers
that FileHold supports:

& FileHold

& scanner Inbox
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& Reviews & Approvals
£ search
& (5 Virtual Folders
= E3 Library
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B Partners
= B Qualty Assurance

A
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(] Document name
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Panel link
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Linked Ver Status

Last Modified On

»

Add File to Folder | Metadata Fields

‘\ | {7 © "X ocrtifsample 100

URL Address

0 1 CheckedIn
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Edit |

Documents in
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Document schema
URL Address
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ul e

ocr tif sample 100

hitp:ifwww kodak com

B {5 Projects Summary
[ FileHold'14 Cwner: sysadm
B sales Metadata and Location. Quality Assurance / Projects /
. FileHold14
B Training and Support VErsion
& Development properties URL to File: Default URL
e 10f1
& F Library Archive Library tree ersion. o
: FileHokd 1D 453.1
Typs of File paf
Hes Markups: No
Format: Electronic Document
Size: 32MB
Checked out by: Document is not checked out
Last Modified By: 05 January,
Created By y, 05 January

& FileHold Systems Inc. 2016 *[ilzHold

The interface of the web client is similar to that of the FDA. Most functions are identical but
there is more end-user functionality in the FDA.

Library Administration and System Administration functions are performed through the web
client as well using the Administration Panel.

TOLOG INTO THE FILEHOLD WEB CLIENT

1. Open a web browser and enter the URL for the FileHold login screen. This should be
provided by your system administrator. It is usually in the format:

http (s) ://yourcompanyservername/FH/FileHold/WebClient/LoginForm.aspx

TIP: It is recommended that you create a bookmark, favourite, or shortcut to the web client
URL for easy access.

2. Enter your username, password, and select the domain.
3. Click Log In.

NOTE: If you are using Active Directory in conjunction with FileHold, your administrator may
have configured the web browser for authentication. If this is the case, click the Logon with
Windows Authentication link on the login page.
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2.2.1. Web Client Menus and Toolbars
The Web Client has two methods in which functions can be performed.

e The FileHold Toolbar that can be used to perform operations on single or batch (many
documents at once) documents such as check out or get a local copy. To select multiple
documents, select the check box next to the document name.

e A context-sensitive menu where only those functions that can be performed will be
available to use. The context sensitive menu is accessed by right-clicking on a document
name or a level in the library tree.

Q“'r_, THH02000 [ ':nwnwm::lrmm
E: Q: AT Wektios ,, & ) i ..
I s - - : e Yy decurrant maotadsts 8 preparsn - e
= S R -
0 ewrvice J:::- '-'.\:.r_ B Sandic " [ - -
B | O N— . g iy
- (2 Prom i . ) & . W e TR
2 P d [ s B L SOy OF et E
e Py Cmbsreat B 2 Dhalwtn bart e ) | Mo
The following table describes the functionality of the Web Client FileHold toolbar buttons.
Button Description Permissions Needed

Get a copy Makes a copy of the documentsto | All users with access to the folder.

the local user computer.

Check out Checks out a document for editing. | Users with Document Publisher

rights or higher.

Edit metadata | Opens the metadata pane for Users with Document Publisher

editing. rights or higher.

Link Creates a link between two or more | Users with Document Publisher

documents. rights or higher.

Move/copy Moves or copies the document from | Users with Document Publisher

one area in the Library to another. rights or higher and have ownership
of the document.
Users with Organizer rights or
higher.

Delete Deletes a document from the Users with Document Publisher

Library. plus Delete rights, Publisher plus
Delete rights, and Organizers, who
Deleted docume_nts can be_ . have ownership of the document.
recovered by a library administrator
before a set amount of time. See Organizer plus Delete and higher
the Library Administration Guide. roles.
<®
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Library archive

Button Description Permissions Needed
Convert to Converts the document to an offline | Users with cabinet administrator
offline document. Offline documents are rights or higher and are owners of

those documents that are stored the cabinet.
outside the FileHold repository,
such as a library, file room or filing
cabinet.
Send to > Tray | Adds the document to your All users with access to the folder.
document tray.
Send to > Sends the document to a Virtual All users with access to the folder.
Virtual folder folder. A Virtual folder must be
available or created.
Send to > Emails the document as an All users with access to the
Email attachment or as a link in the body | document and email settings have
of an email. been enabled by the library
administrator.
Send to > Checks the document out and Users with Document Publisher
Email and sends it in an email attachment or rights or higher and email settings
check out as a link in the body of an email. have been enabled by the library
administrator.
Send to > Sends the document to the Archive. | Users must be a member of the

system administrators / Senior
library administrators group OR a
member of the library administrators
group which is the owner of the
cabinet where the document
belongs.

template name

Selecting more than one document
will start a multiple document
workflow.

Send to > Adds main or supporting Users with Document Publisher role

Existing documents to an existing workflow. | or higher. User must have access to

Workflow all added documents and be owner
of the document version when
adding main documents.

Initiate Allows you to select the workflow Users with Document Publisher

Workflow > template name from the list and rights or higher and is owner of the

workflow start a workflow. document.*

*Unless the ‘Allow non document
version owner to initialize workflow”
permission setting is enabled. See
the System Administration Guide for
more information.

2.3. MICROSOFT OFFICE APPLICATIONS

FileHold software has tight integration with Microsoft Word, Excel, Outlook, PowerPoint, Visio,
or OneNote (2010 and greater) applications to provide a comfortable work environment. The
FileHold Office Client (FOC) window is used when opening, browsing, getting a copy, checking
infout, adding attachments, or approving or reviewing documents from within Microsoft Office

applications.

April 2017

< Hold




FileHold 15.2 End User Guide

The Desktop Application must be installed, running and a user must be logged onto the
document management system in order for the FileHold Office Toolbar icons or Menus options
to be active.

+0

|

/ Home Insert Page Layout References Mailings Review View Developer Add-Ins

&5 Browse FileHold | 58 [ [ [& [ ]

Send to FileHold ~

O\ 9-0)+

Menu Commands Custom Toolbars

Microsoft Office 2007 — Add-Ins Tab

== wem I

Home Insert Page Layout References Mailings Rewiews Wiew FileHald

Q + v

Browse Add  Check-In Rewiew /
Approwe

Actions

Microsoft Office 2010 and 2013 — FileHold Tab

Using the FileHold Toolbar and menu commands you can browse the Library, add a document,
check in a document, send for approval or review (workflow) and in Microsoft Outlook you can
add an attachment to an email from FileHold. See the table below for details.
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2.3.1.

Button/Menu item

Description

Permissions Needed

$ &

Browse to FileHold

Opens the Get From FileHold
window where you can select which
document you want in the Library.

All users with access to
the folder.

ij‘i}/ﬁ\dd

Send to FileHold > Add
Document.

Opens the Add Document to
FileHold window where you can
select the location in the Library
and enter metadata for the
document.

Users with Publisher
rights or higher.

v
[ Check-

Q / In

Send to FileHold > Check
In Document

Opens the Check Document Back
Into FileHold window where you
can check your document back into
the Library.

Users with Publisher
rights or higher

i Review /
é | Approve
Send to FileHold > Send

Review / Approval
Feedback

Allows you to select the document
you are reviewing or approving and
enter any comments and feedback.

Users with Publisher
rights or higher

'@ / Attach

Add Attachment from
FileHold

Opens the Get From FileHold
window where you can select which
document you want in the Library to
add as an attachment to an email.

All users with access to
the folder

Working with Documents using Microsoft Office Applications

The FileHold Office Client (FOC) window allows users to browse the library, get a copy of
documents, check them out or into the document management system. Users can also add
new files, add approvals or reviews (workflow), or add attachments to emails.

In the FOC window, the Library tree looks and performs the same as it does in the web or
desktop applications. Users can also see the associated metadata. In the Get From FileHold
window, you can perform various functions such as get a copy of a document, check it out,
rename, delete, view version history, and open the file after it has been downloaded.

In the Add Document to FileHold window (shown below), you can select the location in the
Library structure for the document, fill out the metadata, close the document before adding to
the repository, delete the local copy, and email folder members to notify them that a document

has been added to the folder.

To change the document name, click on the name of the document and type a new one.

April 2017
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When opening FileHold from a Microsoft Office application, the Library tree looks and performs
the same as it does in the web or desktop applications. Users can also see the associated
metadata. In the Get From FileHold window, you can perform various functions such as get a
copy of a document, check it out, rename, delete, view version history, and open the file after it

has been downloaded.

2.4. LOST OR FORGOTTON USERNAME AND/OR PASSWORD

In the event that a locally managed user has forgotten their user ID or password, the system
administrator can configure FileHold so that two links can be made available on the web client

login screen and FDA login screen.

If a user has forgotten their user ID, they are asked to enter their email address. An email

containing their user ID is emailed to them.

If a user has forgotten their password and wants to reset it, then the user is prompted to enter
their email address and is sent a time-sensitive link in which they will need to use in order to
reset their password. Once the link is clicked, the user is prompted to reset their password in
the web client. If the time limit on the email expires, then the user will need to resend the reset

password request from the login page.

An additional security measure can be put into place using a two-step verification process via a
mobile phone. This will send a text message to the user’'s mobile phone containing a PIN code.
This code is needed to reset the password. See your system administrator for details.

If a mobile phone number is required to reset the password for the user, it can be set by a user

in the User Preferences > Contact Information tab > Mobile field.

If your system administrator has not configured these options, you will need to contact them

directly.

L € FileHold
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TO REQUEST A FORGOTTEN USER ID
1. From the web client or FDA login screen, click the | forgot my user ID link.
2. Enter your email address and click Recover.

3. The message “If the address matches a local account in the system you will be sent an
email with your user id” displays. Click OK.

4. Your user ID is sent to the email address provided.

TO RESET A FORGOTTEN PASSWORD
1. From the web client or FDA login screen, click the | forgot my password link.
2. Enter your email address and click Recover.

3. The message “If the address matches a local account in the system you will be sent a time
limited email with password reset instructions” displays. Click OK.

4. An emalil is sent to the address provided. The email contains a time sensitive link to reset
the password. If the link provided in the email is not used with a certain time period, the link
expires and you will need to click | forgot my user ID link to be sent another password
reset link email. See your system administrator for time limit details.

In the email, click or copy and paste the link provided into a browser window.
If you are not using the two-step mobile phone verification process:
e Enter your User ID.

e Enter your Password twice and click Save. You will now be logged into FileHold with your
new password.

Select a new password in order to log in.

Userid*

Pazsword *

Paszword (confirm) *

| Save || Cancel |

7. If you are using the two-step mobile phone verification process:
e Enter your User ID.
e Enter your Password twice.

e Select the Phone Number to be sent the verification code and click Continue. Only a
partial phone number is shown in the list.

€ FileHold .
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Select 2 new password in order 1o log in.
User ki *| basie
Password *| sesess

| >

o

Select a phone ber for identity verfication A PIN will be sent to your mobile phone.

Phone number | £0%esee11

o Enter the 4-digit PIN that was sent to your phone and click Save. You will now be logged
into FileHold with your new password.

Select a new password in order to log in.
Select a phone number for identity verification. A PIN will be sent to your moblie phone

Phone number *[ 6071y =l
Please enter the verification PIN that you received on your mobde phone
R |
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3. UNDERSTANDING ROLES, PERMISSIONS, AND ACCESS TO THE LIBRARY

Only users with the correct role can use and manage certain parts of the Library structure.
Your system administrator assigns users to groups and a role to each group. Your library
administrator will have created the Library structure and assigned group membership to the
cabinets, folders, and document schemas. The role assigned to the group will determine what
permissions you have in terms of functions in the system and accessing cabinets, folders, and
documents.

All roles provide document emailing capability. Roles higher than Document Publisher have the
Courier functionality. These functions can be disabled on a role by role basis by a System
Administrator in the FileHold Groups area. See the System Administrator Guide for more
information.

NOTE: You can be logged into FDA and the Web Client at the same time but you cannot be
logged into two FDAs or web clients at a time. Only one user account can log into FileHold at a
time.

Role Name Description

Guest User A Guest User has read-only rights, meaning they can only get a copy or
view documents. Unlike all other roles, many users with the guest user role
can log into FileHold at once using a single guest username and password.
If multiple people log into FileHold with the same guest user name, the log
files records the same user regardless of the actual person that logged into
the system. You can purchase low cost packs of guest user connection
licenses in groups of 50 to be used with the portal. You will need at least
one named user regardless of how many connection licenses are
purchased.

Guest users may be restricted from downloading or printing documents.

With the guest user role you can optionally bypass the login process
entirely by setting up a Self-Service Portal with a guest user account. The
Self-Service Portal is an optional module that allows users to access
FileHold with a special URL. The portal does not require a login as this is
done programmatically. The user simply visits the URL and the portal page
appears. For more information about guest user licenses, contact
sales@filehold.com.

Read Only A Read-Only user role may only download or open and read documents
from FileHold. They cannot edit, delete, or create documents. They can
email documents if given this functionality by system administrators.

Read-only users may be restricted from downloading or printing documents.

Read-only users can participate in workflows but cannot initiate workflows.

Document Document Publisher user role can read, get a copy, add, check-in/check-
Publisher out, edit documents, and metadata. They can move documents that are
owned by them. They cannot delete any documents including those which
they have added to the system.

Document publishers can initiate workflows, participate in workflows, and
initiate Courier transmissions.
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Role Name Description
Document Document Publisher Plus Delete user role can do everything a Document
Publisher + Publisher can do and delete their own documents. They must be the owner
Delete of the document in order to delete it. To see the owner of a document, you
can look at the version properties in the metadata pane.
Publisher Publisher user role can do everything a Document Publisher can do plus:

e Create new folders and folder groups.

e Copy or move folders that they have already created.

e Clone folders and folder groups created by other users and become the
owners of the folders / folder groups.

e Publishers cannot delete existing documents, folders or folder groups
including those which they have added /created. All documents and folders
created by the Publisher will be owned by them and they cannot change
the ownership.

Publisher Publisher plus Delete user role can do everything that a Publisher can do

+ Delete plus delete documents, folders and folders group owned (created) by them.

Organizer The Organizer role is for users who are responsible for organizing
documents that are scanned or imported into the system or who are
assigned to organize documents added by other users. For example,
organizers would move the documents generated by scanner operators to
their correct folder in the library. Only trusted personnel should be given this
role. Organizer role user can:

e Move all documents (which they have an access to) in other places in the
library including documents which they do not own. In other words, they
can move documents that are owned by other users.

e Move, copy or clone all folders and folder groups regardless of their
ownership. In case of cloning they will become the owners of folder / folder
groups. In case of copying and moving the original ownership of folders /
folder groups is preserved.

e Change folder properties regardless of ownership.

e Add folders / folder groups (in which case they will become their owners)
and rename folders and folder groups.

¢ Delete documents that they own.

e Change document owner regardless of ownership

e Convert offline documents to electronic documents

e Export documents

Organizer Organizer plus Delete role can do everything that Organizers can do plus
+ Delete delete all documents, folders and folder groups regardless of their

ownership. This organizer and delete role can only do this within Cabinets,
Folders and Schemas that they are a member of.

This role should be used by trusted personnel only.
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Role Name

Description

Cabinet
Administration

Cabinet Administrators can only administer the cabinets that they own; they
cannot create cabinets for themselves. They can:

Create, edit, and delete drawers, folder groups and folders and manage
their properties (i.e. membership structure).

Access all documents (in Publisher and Delete capacity) from anywhere in
the library structure unless they are restricted from that area of the library
structure. If they do not have access to the Cabinet and Folder they will not
be able to access the documents.

Delete and move electronic records as long they are owners of the cabinet
Electronic records can only be moved to another Cabinet in which they
own.

Move documents between cabinets as long as they are owners of the
Cabinet. If users need to move documents between Cabinets that they do
not own, then use an organizer role instead.

Have access to all document schemas.
Change document owner for documents in the cabinets that they own.

Convert electronic documents to electronic records and vice versa for
cabinets that they own.

Convert electronic documents to offline documents for cabinets that they
own.

Manually move document to and from the library archive as long as they
are the Cabinet owner in the library archive.

Library
Administration

Library administrators can perform, within their cabinets, the same functions
as Cabinet Administrators plus:

Create cabinets for which they will be the owner of and manage them in
the Library.

Access to Library Administration functionality where they can manage
metadata fields, schemas, events, set up workflow templates, manage
numerous global settings (i.e. viewer permissions, search engine settings,
reporting services permissions and more), perform various managerial
functions such (as check-in for user, change document owner, recover
deleted document etc.) and access many useful reports and usage logs for
the cabinets that they own.

Library administrators cannot create cabinets for Cabinet Administrators to
own. If a library administrator creates a cabinet, then they are the owners.

Senior Library
Administration

Senior library administrators have full control of the FileHold library itself
and library administration area. Senior library administrators can create
cabinets to be managed by any Library Administrator or Cabinet
Administrator.
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Role Name

Description

System
Administration

System administrators have complete control of the system. They can
perform all of the functions of all other roles. However, the main tasks of the
system administrators are to add users to the system (including assigning
the initial password and setting requirements for all new passwords and
ability to self-register), assign users to their appropriate groups, enable
document control numbers and version control numbers, manage user
accounts, user groups and the system license pool. The system
administrator also has access to various global settings (outbound e-mail,
system wide configurations for managing the various documents format
conversion permissions etc.) and as well as user activity reports.

NOTE: All roles provide document emailing capability. This can be disabled on a role by role
basis by a system administrator in the FileHold Groups area. See the System Administratration
Guide for more information.

3.1. DOCUMENT PERMISSION ICONS

The permission icon to the left of the document indicates the degree of access you have to a
file in the document management system. The permission that you have to the document is

dependent upon the r

ole you were assigned.

Document Mame re

B Ea T

&

& I8 131011095009
C |8 131011095002
] 131011095009

Descriptions for permission icons are outlined below in order from most flexible to most

restrictive access to t

he document.

Permission Icon

Description

@

Red, Yellow and Green Dots indicates that the user has full access
to that file in the document management system and is able to
read, edit or delete the document. This document is being stored as
an electronic document type and not as an electronic record and
can therefore have multiple versions associated with it.

Red and Yellow Dots indicate that the user can only read or edit the
document.

Red Dot indicates that the user has Read-Only access to the
document. This could indicate that the user has read-only
permissions, the document is checked out by another user, or
under workflow.

Gray Dot indicates that the document is an electronic record and
not an electronic document type. This means that there will only be
one version of this file and there are very strict restrictions for all
users for the deletion of this document.
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Permission Icon

Description

Rectangle with Dot indicates an external/physical documents
(called an "off-line document”) for which metadata is available but
there is no electronic file associated with it in the documents
management system

"H" indicates that the document version is hidden while it is
undergoing a workflow. The "H" is only seen by those that are
observers or participants of the workflow

indicates that the current document is under workflow. Only
previous versions are available at this time. The "I" is seen by those
who are not observers or participants of the workflow.

Purple dot indicates an electronic document is in the library archive.
Electronic records in the archive keep a grey dot.
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4. LIBRARY TREE OVERVIEW

The Library structure view of FileHold provides a familiar and intuitive means to view and
search for content held in the document management system. When users first logon to
FileHold the file structure appears on the left side. The upper folders, including the My FileHold
group, act as a personal space for users to organize and work with items retrieved from the
system. The rest of the tree represents the hierarchical arrangement of the entire document
management system. The library is at the top and is divided into cabinets, drawers, folder
groups and folders. The following is an overview of each major section of the Library file
structure.

#+[_] Inbox (Send to Library)
-8 My FileHold

----- "7 My Favorites

----- [ Chedked Out Documents
----- [] Document Alerts

----- [ Document Reminders
----- [] Recently Accessed
----- [7] Recently Added

----- j Calendar

+ -qg Reviews & Approvals
-7l Recent Folders

142 Search

-5 Virtual Folders

+ Library

Library Archive

e Inbox (Send to Library) Folder - The Inbox folder contains a list of documents that are
queued for processing prior to being sent to FileHold. Note: The Inbox view is only
available to users accessing the document management system using the FileHold
Desktop Application software. The FileHold Desktop Application is designed to streamline
the importing of legacy files into the document management system by removing the
bottlenecks associated when adding and classifying files en masse.

e My FileHold - The My FileHold section provides users with personalized views of files. The
files located in the My FileHold area is local to the user's machine and login credentials.

e Reviews & Approvals - See the review or approval tasks you have been assigned and the
workflow status report.

e Recent Folders — A list of the last 10 used folders is displayed in the tree in FDA, the Select
Destination windows, and FileHold Office Client window. The Recent Folders list is not
displayed in the Web Client. This is useful for viewing and keeping track of what areas of
the document management system you are using and quick access to the documents in
those folders.

e Search - Provides access to saved search results.

e Virtual Folders - Virtual Folders are personalized custom folders that allow users to
reference to files located in different folders throughout FileHold without the need for
duplicating the files. This allows users to logically group and organize documents for
individual use without compromising security or clogging up the document management
system with personal folders full of nothing more than duplicates.
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Reports (if configured) - Provides easy access to various custom reports developed by the
IT department using SQL Server Reporting Services.

Library — Where active documents are stored. FileHold provides a completely customizable
hierarchy to store and manage electronic documents and records using a cabinet / drawer /
folder group / folder metaphor. Research shows that filing documents 3 to 4 levels deep is
the most organized means to store files and provide for efficient retrieval. By expanding the
various levels of the library or library archives users are able to browse down to the various
folders in the system.

Library Archive — Located at the bottom of the file structure is usually a clone of the library
structure. It is meant to be the long term storage space for records or other important
documents which are no longer active and were moved to the Library Archive manually or
by an automated process based on the document life cycle policies defined by library
administrator(s).

Hold
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5. INBOX (SEND TO LIBRARY)

The FileHold Desktop Application’s (FDA) Inbox is designed to streamline the importing of
many documents into the library by removing the bottlenecks associated when adding and
classifying files en masse. The Inbox is a queue or list of files that have not yet been copied to
the FileHold Server.

The Inbox is specific to each user's FileHold Desktop Application (FDA) on their workstation
and user account profile unless you share your Inbox. Sharing your Inbox allows others to file
the contents of your Inbox on your behalf. For example, if there is a dedicated scanning station
with several people scanning documents to be added into FileHold, all users who can log into
the Windows environment of that scanning station will be able to file all the scanned
documents in the Inbox. This is because the Inbox is shared between all the users who can log
in with a Windows user account.

The Inbox is the first category visible in the library structure. The Inbox acts as a staging area
for documents that are queued for processing on the client machine prior to be sent to the
Library. All documents in this list remain on the client machine until they are sent to the library.
Files located in the Inbox will only be ready to be sent to the Library once they have both
required metadata (tags) values entered and a destination folder associated with each file.

File  Wiew Tools  Administration  Help User! Basie Fie  J

Library

& Revisws & Approvals
7)) Recent Folders
& search Document Name . Status Document Schema Coming From Going To Progress

on | Remove From Inbox  Edit Metadata Edit Destination Send  Send Al i

g:’;:‘:':”‘de” [ 131011005000 Info Required Fhotos CoUsers\Admin,..documents Set Destination
 w-E Corporate &) 131016145027-1L Info Required Photos CiilUsers\admin,..jdocuments Set Destination
- Development [ 131018145221 Info Required Fhotos C:\Userstadmin.. \documents et Destination
- Partners
=] .ﬂ 131016145857-1L Info Required Fhotos C:\Usersiadmin, . jdocuments  Set Destination
B Quality Assurance
B sales .ﬂ 131017163721 Info Required Fhotos C\Usersiadmin,,jdocuments - Set Destination

{ =-F Training and Support

Users can quickly add all the files from a network folder to the Inbox to prepare for filing. Files
in the Inbox that still need to have their metadata or destinations set will have a status of “Info
Required”. This information is necessary before they can be filed in the Library.

NOTE: The Inbox is not available in the Web Client interface.

The status column lets users know if more information is required before the file can be sent to
the document management system. A status of "Info Required" indicates that the required
metadata or a destination have not been set. Once all the required information is set, the status
changes to "Ready to Send" and file can then be uploaded by clicking the Send or Send All
(used when multiple files are ready to be sent to the Library). The documents are then sent to
their destination folders and are removed from the Inbox.

The Inbox can be sorted by document name, type, coming from, or going to by clicking on the
column header name. The columns can be sorted in ascending or descending order by clicking
on the arrow button next to the header name.

Click arrow to sort ascending Select View:

or decending

My Personal View

Remove From Inbox Edit Metadata Edit De

Document Name - Document Schema Coming From Going To Progress
7'_- FileHold14_2_Release-Guide_Jan052015 Info Required Product Documentation .. \documents20150981101225( Set Destination
-',:- FileHold14_2_Library_Administrator_Guide_Jan... Info Required Product Documentation ...\documents2015091101225( Set Destination
rﬂ] FileHold14_2_EndUser_Guide Info Required SetMetadata ...\documents2015091101225( Set Destination

The following table describes the functions of the Inbox:
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Function

Description

+ (Add documents)

Adds documents from outside the document management
system.

Remove from Inbox

Removes the selected document(s) from the Inbox.

Edit Metadata

Allows you to enter the metadata for the selected
documents...

Select multiple documents to be filed under the same
schema and click Edit Metadata. You can set all the
metadata fields to the same value.

Edit Destination

Allows you to select the destination folder for documents.

Select multiple documents to be filed under the same folder
and click Edit Destination. You can set the destination to
the same folder.

Send Sends a single document to the Library. The metadata and
the destination must be set in order to send a document to
the repository.

Send All Sends all documents that have set metadata and
destination to the library.

Auto-File Automatically files documents in folders. This needs to be

configured. See the Library Administration Guide for
information on auto-filing.
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6. MY FILEHOLD

The My FileHold area of FileHold provides views of documents that are unique to each user. In
other words, it is a personal document workspace for you. This area allows you to access the
documents that you use most frequently, documents that you have checked out, documents

that are awaiting your review and/or approval, and any alerts or reminders that you have set on
documents.

-4 My FileHald

----- 77 My Favorites

----- 1 Checked Out Documents
----- 1 Document Alerts

----- [ Document Reminders

----- [ Recently Accessed

----- [ Recently added

----- :ﬁ Calendar

6.1. MY FAVORITES

My Favorites is a list of files that the user has flagged as favorites. To make a document a
“favorite”, click the star next to the document name so it turns yellow. A yellow star indicates a
favorite document and will show up in the My Favorites list.

Document Name « Type Linked Ver Status Last Modified On
» @ &) nvoice-TP0300018852  Invoice 0 Checked In  04/03/2011 1:46 PM

1
1’?@&?0300029031 Invoice 0 1  CheckedIn 04/03/2011 1:46 PM
Yellow star indicates a

"favourite" document

m
Q.
=3

m
I
=

6.2. CHECKED OUT DOCUMENTS

Checked Out Documents are a listing of documents that the user has checked out of the
system. For more information on how to check a document in and out, see Checking In/Out.

- My Checked Out Documents

Select View: = Default View
(Y of # =] = | ChecklIn

Document Name Location Type Linked Ver Status 1
e @J FileHold_EndUser_Guide_v0S Product Development / Guides [ User Guide Quality Assurance 0 1 Checked Out 1

6.3. DOCUMENT ALERTS

Document Alerts is a list of notifications received about documents or folders users have

subscribed to. For more information on setting document alerts, see Setting Document Alerts
and Reminders.

6.4. DOCUMENT REMINDERS

Document Reminders is a list of reminders to check on certain documents at a set time. For
more information on document reminders, see Setting Document Alerts and Reminders.

. R Hold

April 2017



End User Guide FileHold 15.2

6.5. RECENTLY ADDED AND RECENTLY ACCESSED

Recently Added is a list of files that the user recently added to any location in the document
management system in the last 2 weeks.

Recently Accessed is a list of files recently accessed (opened, checked out/in, reviewed, etc.)
to any location in the document management system in the last 2 weeks.

- My Recently Accessed Documents Select View:  Default View
@y T I PEY

Document Name Location Type Linked Ver Status Actio
17 @ E‘ﬂ FileHold_EndUser_Guide_v09 Product Development / Guides / User Guide Quality Assurance a 1 Checked Out Dowrlo
i © 3 Invoice-TPO300018852 Canadian Union [ Accounting / AR Invoice i} 2 Checked In Checke:

6.6. CALENDAR

The Calendar helps keep you organized by showing all of your tasks, reminders, and event

schedules so you can become more proficient at accomplishing your document management
goals.

The Calendar is shown in the My FileHold area of the Library tree in the FileHold Desktop
Application (FDA). The Calendar is not available in the Web Client.

e view to the

Events can be seen for System
eek, or Day

AT Hm e ) and Library Administrators

h-E My FileHold
"7 My Favorites
[ Checked Out Documents
[ Document Alerts Monday
-] Document Reminders 30 31
[ Recently Accessed ( W']
Scroll through the
B provals months and years
{71 Recent Folders 6 7 g 9 10 11 12
=42 Search
}J My Saved Searches
-4 Public Saved Searches Task is not
590 virtual Folders overdue
=-EH Library 13 14 15
& B Reelonen: [ 1 reminder ) [ 1 event [ 4 events )
[=-{&P Projects e———— - /s g
[ FileHold09
EB Engineering
[ {5 Projects 20 21 2 23 24

-] FileHold 12 and Beyol Jj
1 task
] FileHold'10 - &

=-E Training and Support | 1 reminder | Task is overdue
{59 Filetiold 12
[ Auto-initiate o7 28 20 a0 7 2 5

0 s ToggingFokir  Lemnde ) Ltk
1 Email )
1 Forms

] New Features
H==—

Calendar

Wieek Day  Today 4@ = June, 2011

Tuesday Wednesday

Friday Saturday Sunday

Z5 z26

To ACCESS THE CALENDAR
1. In FDA, got to My FileHold > Calendar.

2. The Calendar can be viewed by the Month, Week, Day, or today (current date). You can also
scroll through the months, weeks, days, and years using the scroll arrows.

3. Click Today to bring you back to the current date (today’s date).
4. You can click on a day in the Month or Week view to see the details for the day.

5. Click on a task or a reminder in the Day view to open the document in the My Tasks view for
tasks or in the My Document Reminders View for reminders.
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You can view the following items in the Calendar:
e Active, overdue, and completed workflow tasks:
e Completed tasks are in a light green background.

e Due tasks are in a green background with bold text and then number of tasks due in
brackets.

e Overdue tasks are shown in red with bold text and the number of overdue tasks in
brackets. A task is considered overdue the day after the task is due. Note that this
shows that there is only one task overdue but two tasks were due on that day. Only
one task was completed.

e Reminders are displayed in cyan background. Active reminders that have not been marked
as read are bolded with the number of active reminders listed in brackets (). Active
reminders that have been marked as read will be unbolded. Only the current days’
reminders are considered active. Lapsed and future reminders are not active.

e Scheduled events when the Include Events button is selected. Only users with library
administrator roles and above can access this feature. Events are for when documents are
set to be archived, converted to a record, disposed, or a user defined event. Events are
displayed in yellow background.

RECENT FOLDERS

The Recent Folders area displays a list of the last 10 used folders is displayed in the tree in
FDA, the Select Destination windows, and FileHold Office Client window. The Recent Folders
list is not displayed in the Web Client. This is useful for viewing and keeping track of what
areas of the document management system you are using and quick access to the documents
in those folders.

Hold
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7. REVIEWS AND APPROVALS (DOCUMENT WORKFLOW)

Organizations typically have a number of internal processes for tasks such as order
processing, purchase requests, travel expenses, and so on. The FileHold Document Workflow
module brings order to these independent processes in a transparent, dynamic, and robust
fashion making it a key part of the electronic document cycle.

The document workflow engine is designed to streamline the review and approval process of
electronic documents as they proceed through their lifecycle. In collaborative work
environments, this labor intensive growth stage of the document is where the most time
savings can be realized through the use of workflow.

Document workflow is an optional module of FileHold that can be purchased at any time.

7.1. WORKFLOW OVERVIEW

A workflow contains one or more activities (reviews and approvals) to be completed during the
lifecycle of a document. Workflows can be used with all of the document schema formats:
document, record and offline. Workflows are created by the library administrator.

The persons charged with reviewing or approving the documents are called participants. The
participants can be defined in the workflow or can be left up to the initiator to select. There is
no limit to the number of participants in a workflow

Once a workflow has been initiated, the first activity begins and moves along in the process
using the settings in the workflow template.

In a simple document workflow process example, the first activity is to review a document. The
participants in this activity are called reviewers. The reviewers are notified by email, and in their
task list. The task can also be seen in the calendar. The review activity is designed to facilitate
the collection of comments on a document from other users. The review activity is considered
complete once one or more of the participants (dependent upon what has been configured in
the template) have completed the task of reviewing the document.

Once all tasks in the activity are completed, the activity is considered complete and the next
activity begins — the approval activity. The participants in this activity are called approvers.
The approvers are notified by an email and in their task list and responsible for approving,
postponing approval, or not approving the document. The task can also be seen in the
calendar. The approval activity is designed to facilitate the formal collection of electronic
signatures on behalf of its participants for an individual document version in the workflow. The
approval activity is considered complete once one or all participants (dependent upon what has
been configured in the template) have approved, postponed approval, or not approved the
document. The system requires the user to enter their FileHold system password as a secure
means of verifying their identity (electronic signature).

During the course of the document workflow, observers can be designated to watch over the
workflow instance. Observers are assigned to watch the workflow but do not participate. They
usually do not submit reviews or approvals.

On completion of the last activity in the document workflow, it is considered complete. If at any
time a workflow approval is not approved, then the workflow is considered terminated and
subsequent activities are canceled.

The basic elements and roles of users involved in a simple workflow can be seen in the
diagram below.
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Simple FileHold Workflow Process

Worldlow
Notifications ——
(emails) —
-
Worklfow can be initiated Server

automatically or manually
by an Initiator

2 =

Document Reviewers
One or many reviewers or a
portion of a group of reviewers

Comments and
feedback provided by
Reviewers

@ Observers

Document Approvers
One or many approvers or a
portion of a group of approvers

Document approved. Document not approved.
Workflow complete. Workflow terminated.

7.2. INITIATING WORKFLOWS

Initiating a workflow can be done by anyone with Document Publisher or higher permissions as
long as they have access to the document(s). Once initiated, workflows are considered

complete when all activities are completed, the workflow is canceled, or the document is not
approved. Workflows can be initiated:

1. Manually on:

e A single document

e Multiple documents

2. Automatically initiated depending on how the schema was configured by the library
administrator.

. € FileHold
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Workflows can only be initiated on the latest version of a document and the file must be
checked in. Workflows can be initiated manually on documents once added to the library or
they can be automatically initiated depending on how the schema was configured by the library
administrator. See Automatically Initiating Workflows for more information.

Users can only initiate workflows from the list of workflow templates that are associated with
the document's schema. The templates are not created by the user; they are created by the
library administrator. However, the library administrator can create an “ad-hoc” template that
leaves all or some template settings to be defined by the initiator.

You can have up to 20 activities (review or approve) in a workflow template. You can create
workflow templates in both the Web Client and the FileHold Desktop Application (FDA).

The following users and roles can initiate workflows:

The document version owner — The owner of the document version who has Document
Publisher role or higher. If the user who owns the document is not the user who is initiating
the workflow, enable the permission setting “Ignore document version ownership when
initiating workflows or sending Courier transmissions” in the administration panel. See the
System Administration Guide for more information.

Cabinet owner — A cabinet administrator can initiate a workflow on any cabinets that they
have ownership of.

Senior library administrator or higher role —Can initiate a workflow on any documents in the
system.

If someone other than the document owner initiates the workflow, the document owner may be
an observer if the library administrator has configured the workflow to allow this in the template.
For more information on creating workflow templates, see the Library Administration Guide.

Workflows cannot be initiated on the following files in the document management system:

7.2.1.

A document with an existing workflow instance associated with it.
Documents with a status of “checked out”.
Shortcuts to documents located elsewhere in the document management system.

The user does not have correct permissions to initiate the workflow.

Manually Initiating a Workflow on a Single Document

Manually initiating a workflow can be done on a single selected document.

TO INITIATE A MANUAL WORKFLOW ON A SINGLE DOCUMENT

1. Right-click on a document that is associated with a schema workflow and select Workflow

April 2017

> |nitiate Workflow name.

NOTE: The if the document is not associated with a schema with a workflow template
applied to it, this option will not be available.

The workflow template opens. In the FDA, click on the coloured areas to expand and
contract the different areas of the workflow template. The Web Client does not have a
graphical view for the workflow templates.

If the library administrator created an ad-hoc workflow template, you may fill in some or all
the following fields, depending on how the administrator configured the template:
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Field Name

Description

Workflow Name

Enter a name for the workflow template.

A custom naming pattern may have been set up for the workflow
name (the name of the workflow that the user sees in notification
emails and My Tasks list). Read more about setting up the
custom naming pattern.

Description

Enter a description for the workflow. It is recommended that you
enter as many details as necessary so that users will know
exactly what this workflow template is for.

Hide the document
version until the workflow
is approved

Select the Hide the document version until the workflow is
approved check box to hide the version of the document
undergoing the workflow from all users except for the document
owner, workflow participants, workflow observers, and designated
library administrators until such time as it has gone through a
workflow instance that contains at least one Approval activity and
the result of this activity is that the document is signed off as
"Approved". The document version is hidden only during the
workflow process until the document version is approved. The
document is available at all other times whether it has been
approved or not. All other versions will be available for viewing.

NOTE: The Hide the document... check box is only enabled
when there is at least one approval activity in the workflow
template. This check box is not available for review activities.

Convert main documents
to electronic records at
completion

When the workflow activities are completed, the final version of
the electronic document will be converted into an electronic
record as a new version. This action is only taken on main
documents, not supporting documents. Supporting documents
remain untouched.

This option does not need to be enabled if the workflow is for
electronic record formats.

Email notification

Enter the number of days or hours before a task is overdue to
send a task overdue notification email.

To repeat the overdue task email notification after a specified
period of time, enter the number of hours to resend the email. For
example, if 8 hours is entered, an overdue email will be sent
every 8 hours until the task is complete. If the repeat notification
time is not set, the notification is sent only one time.

Observers

To select a list of observers, click the ... button. In the Select
Workflow Observers window, select the groups and/or users to
the Current Observers list. Click OK when done.

Allow document version
owner to observe the
workflow

Select the check box to allow the document owner to see the
workflow.
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Field Name

Description

Workflow Activity n

In the Workflow Activity n area, select if this activity is an
Approval or Review from the drop down list.

Title

Enter a title for the activity. For example, “Review step 1”. The
title is used in conjunction with the Allow Postpone Approval and
restart feature.

Description

Enter a description for the activity. For example, “This activity is to
be sent to all members of group x for review.” The description is
used in conjunction with the Allow Postpone Approval and restart
feature.

Reviewers

Click ... to select the users or groups who will be approving or
reviewing the document.

If you select an Approval activity, each participant is assigned the
task of approving and signing off on the document. Users will be
asked to enter their password when completing an approval
activity to confirm their identity. The list of possible participants is
limited to users that are able to access the document.

Select the Review activity to solicit feedback on a given document
version. As the participants in the activity (reviewers) complete
their task, the initiator can collect comments and feedback on the
document being reviewed. The list of possible participants is
limited to users that are able to access the document.

When adding groups to an activity, it will be expanded to
individual users upon initiating the workflow. Adding or removing
users from a group will not affect existing workflows.

In the Select Task Participants window, select the groups and/or
users to the Current Participants list. Click OK when done.

Include Document Version
Owner

To include the document version owner as a participant in the
activity, select the Include Document Version Owner check
box. If this option is selected, the list of participants can be left
empty.

Include Workflow Initiator

To include the workflow initiator as a participant in the activity,
select the Include Workflow Initiator check box. If this option is
selected, the list of participants can be left empty.

1of X

If only one in a group of participants is required to approve or
review the document, select the 1 of X check box. For example, if
only 1 out of the 5 patrticipants is required to approve the
document. The first person to complete the task will void and
remove the task from all other participants. Users are able to
reserve a task with this option enabled.
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Force Reservation

If a single participant in a group is to be forced to “reserve” the
task, select the Force Reservation check box. When this option
is enabled, it is not possible to submit a review or approval
without reserving the task by a single participant. While a task is
“reserved” no other participants in the activity will be able to

complete the task.

If the Force Reservation option is not enabled, a user can still
reserve the task. Note that this option is only available if the 1 of
X check box is selected. The table below describes the effect of
the 1 of X and Force Reservation settings.

Workflow Template
Settings

Effect on Workflow

1 of X enabled

Force Reservation disabled

Only one participant in a
group of participants in the
activity can complete the
task.

Participant may “reserve”
the task but is not forced
to; the task can still be
completed without the
reservation.

First participant to
complete the task voids the
task for all other
participants. The task is
removed from their task
list.

The activity is considered
complete after a single
participant completes the
task.

If a participant reserves the
task:

¢ Only the participant who

reserved the task can
complete the task.

The status of the task
changes to “Reserved” for
the participant who
reserved it.

The status of the other
participants who did not
reserve the task changes
to “Blocked”.

The participant who reserved
the task can undo the
reservation which frees the
task for the other participants
to complete.
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Field Name

Description

Force Reservation

Workflow Template
Settings

Effect on Workflow

1 of X enabled

Force Reservation enabled

e Only one participant in a
group of participants in the
activity can complete the
task.

e Participant may “reserve”
the task but is not forced
to; the task can still be
completed without the
reservation.

e First participant to
complete the task voids the
task for all other
participants. The task is
removed from their task
list.

e The activity is considered
complete after a single
participant completes the
task.

If a participant reserves the
task:

¢ Only the participant who
reserved the task can
complete the task.

e The status of the task
changes to “Reserved” for
the participant who
reserved it.

e The status of the other
participants who did not
reserve the task changes
to “Blocked”.

The participant who reserved
the task can undo the
reservation which frees the
task for the other participants
to complete.
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Field Name

Description

Allow Check Out

Select the check box to allow a document(s) to be checked out
while under the workflow process. In order for this option to be
available on the workflow template, it must be enabled in the
System Administrator > Permission Settings area. The review or
approval cannot be completed while a document in the activity is
checked out and the document must be checked in before a
review or approval can be submitted. When the document is
checked in as a new version, the version number is increased
and becomes the version associated with the workflow. If the 1 of
X option is selected on the template, then the task is
automatically reserved when it is checked out. The task remains
reserved after the document is checked in so the user can
complete the approval or review task.

Require Password

This check box is controlled by the permission setting “Enable
optional passwords in workflow templates” in the Administration
Panel > System Configuration > General > Permission Settings
area. If the permission setting is enabled, the Require Password
check box is available for use. If the permission setting is
disabled, the Require Password check box is unavailable. See
the System Administration Guide for more information.

Select the check box if the password is required on an approval
or review activity. When enabled, users will be forced to enter
their FileHold password when completing the review or approval
activity. If disabled, no password is required upon completion of
an activity.
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Field Name

Description

Allow Postpone Approval

Select the check box to allow documents to be marked as
"Approval Postponed" for an approval activity. There are
situations where a document cannot be approved because some
conditions have not been met but there is nothing wrong with the
document itself. The approval option called “Postpone Approval”
can be used in these conditions. Once the “postpone approval”
option is selected, the workflow is immediately terminated and the
status of the document will be set to “Approval Postponed”. A
workflow can be started on the same version of a document that
has been marked as "approval postponed". If this option is not
enabled then the "approval postponed" option is not available
when approving documents.

If this option is enabled, then a workflow can be restarted
automatically from a particular activity in the workflow template. In
the Select one or more steps to restart from area, click the ... to
select the step or steps to restart from. You can restart the
workflow from a previous activity or return back to the initiator. If
more than one option is selected, then the participant postponing
the workflow is required to select the activity to restart from.

If the workflow is returned back to the initiator, then the initiator
will need to manually restart or re-initiate the workflow from the
workflow status report. See the User Guide for more information.

If the workflow is automatically returned back to a previous
activity, the participants are notified that the workflow has been
restarted. If the activity is 1 of X, only the participant who
performed the previous activity is notified (or if delegated to
another user, their delegate). The notification to the participants
includes the comments made when the activity was marked as
Approval Postponed”.

Convert main documents
to PDF

Microsoft Word and PDF documents can be automatically
converted to PDF format upon completion of the activity. A
summary page can also be appended to the document which can
include workflow and document information. Click ... to set the
PDF conversion options. See Converting Documents to PDF for
more information.

Due By

In the Due By field, enter the number of days or hours after
workflow initiation that the approval or review is due.

e Due date is calculated when the workflow is launched, so this
field should be configured for the number of days or hours from
launch that the first task will be due. For example, if the task
needs to be completed in 5 hours, you would enter 0 days and 5
hours.

¢ An exact date and time (fixed) can be specified in the workflow
template once the workflow is initiated via manual initiation (if ad
hoc).

¢ In subsequent activities, you can enter the number of days or
hours after the previous activity is marked as complete for the
next activity to be completed.
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Field Name Description

Task Instructions Enter the instructions for the reviewers or approvers.

4. Repeat the above steps to add up to 20 activities to the workflow template.
5. The order of the activities can be changed using the number drop down list.

6. To remove an activity from the workflow template, click the red X.
Initiating a Workflow on Multiple Documents

In some workflow instances, multiple documents may need to be either reviewed or approved
together as a “package”. In this case, multiple document workflows can be used. Multiple
document workflows must be initiated manually. Once a group of documents are selected, a
workflow can be initiated to create a single workflow instance. In order for the workflow
initiation to be successful, all of the documents must meet all the requirements such as
belonging to a schema that uses the same workflow template and must be accessible by all
participants listed in the template.

Note that your library administrator may have configured the system so that a single workflow
is initiated when more than one document is selected (single workflow containing multiple
documents) or a separate workflow is initiated for each selected documents (multiple workflows
initiated). You may also receive a prompt asking if you'd like to initiate one workflow on multiple
documents or a separate workflow for each document.

When a workflow is initiated on multiple documents, these documents are called the “main
documents” meaning that all the documents in the package must be approved and/or reviewed
together. Main documents can have only one active workflow at a time; they cannot be in
another active workflow. Once the documents in the package have been reviewed and/or
approved, all of their statuses are changed to the same status such as “reviewed” or
“approved”.

Main documents can be added or removed from the workflow after it has been initiated.
Notifications are sent to workflow participants when documents are added or removed from the
workflow. If a document is removed, the approval status is changed to “Not submitted for
approval” and the effect of the “Hide last version...” setting (if applicable) is removed from the
document. Documents that have been checked out under the workflow cannot be removed.

Multiple document workflows can also have “supporting documents”. Supporting documents
are added to the workflow instance to assist in the review and/or approval process of the main
documents. Supporting documents do not have their status changed, the Sign Off Sheet is not
updated, and they are not affected by the “Hide last version...” setting. Supporting documents
can be added or removed from an existing workflow after the workflow has been initiated for
the “main documents”. A supporting document can participate in multiple active workflows;
however, it has to be a supporting document. It cannot be a main document in another
workflow. A supporting document cannot be checked out or deleted while under the workflow
process.

An example workflow on multiple documents and supporting documents is displayed below.
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Workflow initiator initiates a review and
approve workflow on 3 documents
simultaneously

Main documents

Main documents move together
through the workflow as a “package”

Workflow initiator adds supporting
documents to the workflow. Supporting
documents assist in the review or
approval of main documents.

Supporting
documents

g % Document reviewers review

main documents and mark as
Reviewed. Supporting

documents are viewed but not
marked as reviewed.

Document Reviewers

Observers

Supporting
documents

Document approvers approve
main documents and mark as
Approved. Supporting
documents are viewed but not
marked as approved.

Document Approvers

Main documents

All main documents statuses are
changed to “Approved”

Supporting
documents

Supporting
documents

The status for all supporting
documents remain unchanged
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TO INITIATE A WORKFLOW ON MULTIPLE DOCUMENTS

1. Select all of the documents to go through the workflow as a “package”. You can locate the
documents through a search, a virtual folder, My Favourites, document tray, etc.

e Inthe FDA, use the CTRL + click or SHIFT + click to select multiple documents.
¢ Inthe Web Client, select the check boxes next to the document names.

e Remember that all documents in the package are reviewed and approved together as a
single unit. All documents are considered “main documents”.

2. Do one of the following
e Inthe FDA, right-click and select Workflow > Initiate Workflow template name.

e Inthe Web Client, select Initiate Workflow from the menu bar and select the template
name from the list.

e Remember that all documents must have the same workflow template as a part of its
schema. If all documents do not have the same workflow template in their schemas, then
an error message appears stating that the workflow cannot be initiated.

3. If prompted, select one of the following options:
e Create a single workflow instance associated with all selected documents.

e Create a separate workflow instance for each selected documents.

[intioize workow T )
You are initializing a workflow For multiple selected documents. Do you wank ka:
' Create 3 single workFlow instance associsted with all selected documents
" Create a separate workflow instance for each selected documents
0K I Cancel |

4. The workflow template opens. In the FDA, click on the coloured areas to expand and
contract the different areas of the workflow template. The Web Client does not have a
graphical view for the workflow templates.

5. Depending on how the workflow template is configured, you may be able to modify some
or all of the template details. See the table in Manually Initiating a Workflow for information
on the template details. Click OK to start the workflow.

6. You will receive a message stating that the workflow has been successfully initiated. Click
OK.

7.2.3. Adding or Removing Main or Supporting Documents from a Workflow

Documents can be added or removed from an active workflow. Documents can be added as
“main” or “supporting” documents. Main documents are all the documents in a “package” must
be approved and/or reviewed together. Supporting documents can be added to the workflow
instance to assist in the review and/or approval process of the main documents.

Documents can be removed from the “Documents associated with workflow template name”
pane. Documents that are checked out cannot be removed from the workflow. Once the
document has been removed, the approval status changes to “Not submitted for approval” and
the effect of the “Hide all versions...” flag is removed.

The following users and roles can add and remove main and supporting documents in
workflows:
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e Workflow initiator — The workflow initiator who has Document Publisher role or higher and
has access to all existing main documents.

e Cabinet owner — A cabinet administrator that has ownership of the cabinets where all the
documents in the workflow are stored.

e Senior library administrator or higher role
When adding documents to existing workflows:

e The workflow template associated with the documents must be associated with the same
workflow template used to initiate the workflow in its schema.

e All observers and participants must have access to the document.
e Only the last version of the document can be added to a workflow.

e If adding a main document, then the document cannot be associated with another
workflow.

e When adding a supporting document, it cannot be checked out or deleted after it has been
added.

e When adding a main document to a workflow that has been marked as "approval
postponed", the workflow can be restarted from the first activity in the workflow template if
the option "Reset all activities when adding documents to a postponed workflow" is
enabled. This allows all of the main documents including the new main document to go
through the entire workflow process once again. If the option "Reset all activities when
adding documents to a postponed workflow" is not enabled on the template then the
workflow is restarted from the activity from which the approval was postponed. See
Creating Workflow Templates for more information.

TO ADD A MAIN OR SUPPORTING DOCUMENT.
1. Select one or more documents to add to the workflow.
2. Right-click on the documents and select Workflow > Add to Existing Workflow.
e Alternatively, in the Web Client select Send To > Existing Workflow from the menu bar.

3. Inthe “Add Documents to Existing Workflow" window, select the workflow that you want
to add the documents to from the list of existing workflows.

4. Select one of the following options and click OK:

e Main documents that are reviewed or approved in the workflow — The selected documents
are added to the existing workflow “package” as main documents and will be reviewed
and/or approved along with the other main documents.

e Supporting documents associated with the workflow — The selected documents are added
to the existing workflow to assist in the review and/or approval of the main documents.

5. The documents are added to the existing workflow and can be seen in the “Documents
associated with workflow template name” window as Main and/or Supporting documents.

Documents associated with review, approve (renee) workflow Select Yiew: | Default Yiew

Back To Status Report  Remove

Document Name |« Main / Supporting Location Type Linked Yer Status Last Modified On

@ T arr 165ep2013 Supparting Training and Support § FileHold 13 ] Mew Features  Application o

Checked In - 9/18/2013 1:54 PM

@ [ Board Minutes_REMEE | Main Training and Support | FleHold 13 § Mew Features  Board Minutes 0 Cherked Tn  9/18/2013 1:54 PM
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7.3.

TO REMOVE A MAIN OR SUPPORTING DOCUMENT.

1. Go to My Tasks or the Workflow Status Report and click the Show Documents link for
the workflow you want to remove documents from.

2. In the “Documents associated with workflow template name” window, select the
document to be removed and click Remove.

3. At the message prompt, “Are you sure you want to remove the selected documents from
the workflow template name?” click OK. The document is removed from the active
workflow.

Automatically Initiating Workflows

Workflows can be automatically initiated depending on the configuration of the workflow
template. This removes the manual step of initiating a workflow for a document. Since the
workflow is triggered automatically, you cannot use an ad-hoc workflow template. You will need
to create a defined workflow template to use with this feature. A workflow cannot be
automatically initiated when only metadata is edited.

See the Library Administration Guide or Knowledge Base for more information.

MY TASKS LIST — VIEWING WORKFLOW TASKS

A list of all workflow tasks assigned to a specific user is accessible to them through the
document management system by selecting Review and Approvals > My Tasks from the My
FileHold area.

[EEp AL L

=-«& Reviews & Approvals

88 My Tasks (1 new) |
Warkflow Status Report

T e

There are two types of activities supported by the FileHold: the document approval activity and
the document review activity. The My Tasks list shows all active review or approval tasks
assigned or delegated to the user. Previously completed or cancelled tasks do not appear in
the list. Once a workflow is initiated, an email will be sent to the user (if configured) notifying
them of a workflow task.

My Workflow Tasks @'

12
Task ‘Workflow On Behalf of Task Description Initiator Assigned Due Status
™ spprovet  approval, auto pleaze approve Renee Sauve  9H82013 348 PM 992013 3:48 PM InProgress  Show Documents
T Approve  Mew template Renee Sauve 9492013 5:46 AWM /2002013 S:46 Ahl InProgress  Show Documerts
[T Rewiew®  review, approve (renee) Pleaze reviewy and pass on far approval. Renee Sauve  SHER2013 322 PM 9192013 322 PM InProgress  Show Documerts:
[T Rewiew*  review, approve Crense) #1 Pleaze review and pass on for approval. Renee Sauve  9HME2013 232 PM SM92013 232 PM InProgress  Showy Documents
[T Rewiew*  review, approve (renee) #2 Pleaze review and pass on far approval. Fenee Sauve  9ME2013 232 PM 9M2013 232 PM InProgress  Show Documerts
12

From the My Tasks list, you can:

e Submit a review or approval.

e Cancel the workflow.
e Delegate a task to another user.

e Reserve or undo a reservation for a task. Tasks that can be reserved are marked with an
asterisk *.
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e See the documents that are a part of the workflow (Show Documents link).

e Get alocal copy of the document under review or approval (in the “Documents associated
with workflow name” pane).

e View the Status Report for the task (View Workflows).

e Check out a document (in the “Documents associated with workflow name” pane).

e Disable the automatic refresh of the list

Approving Documents

The approval activity is designed to facilitate the formal collection of signatures / approvals for
an individual file version. When approving documents, there are three options when completing
the task:

e Approve
e Do not approve

e Postpone approval (This option is available only if it has been enabled on the workflow
template.)

For documents to be considered “approved” it must pass through a workflow with at least one
Approval activity and must be approved by all participants in all activities in the workflow. Only
the version of the document that is going through the workflow process is marked as
“approved”.

If one of the participants of the approval activity “does not approve” the document(s), then the
workflow is automatically terminated. This can happen at any step along the way in a workflow.
For example, a file can pass through a first approval activity only to be rejected during a
second approval activity. If the participant in the second activity rejects the document the
activity is terminated, the workflow is terminated, and the document is flagged as "not
approved".

If a version of a document has been marked as “Not Approved”, the system does not allow a
workflow to be done on the same document version. Instead, a new version of file will have to
be added to the system and the workflow re-initiated. The document needs to go through the
entire workflow process before it can be considered approved and complete. Alternatively, the
workflow can be restarted on the same version by an initiator or administrator. See Restarting
Workflows for more information.

There are situations where a document cannot be approved because some conditions have
not been met but there is nothing wrong with the document itself. An option called “Postpone
Approval” can be used in these conditions. Once the “postpone approval” option is selected,
the workflow is immediately terminated and the status of the document will be set to “Approval
Postponed”. This option is available only if it has been enabled on the workflow template. If a
workflow has the option to postpone approval enabled, then the workflow may be automatically
restarted with one of the following options:

e Return to the workflow initiator. The initiator would need to manually restart or re-initiate the
workflow.

e Automatically return to a previous activity in the workflow template.

e The user postponing the activity can be given an option of selecting from a list of activities
to restart from which includes the returning to the initiator or a previous workflow activities.

This feature is useful when a later workflow activity discovers missing information or
documents and needs to return to a previous activity. Participants are notified if a workflow is
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restarted and includes the comments of the user who postponed the workflow. If the activity is
1 of X, only the participant who completed the previous task is notified.

A document under a workflow approval process can be checked out by a participant if
configured in the workflow template. The approval task cannot be completed while a document
in the activity is checked out and the document must be checked in before the approval can be
submitted. The approval postponed option is only available if it has been enabled on the
workflow template. See Creating Workflow Templates for more information.

A document under a workflow approval process can be checked out by a participant if
configured in the workflow template. The approval task cannot be completed while a document
in the activity is checked out and the document must be checked in before the approval can be
submitted.

A feedback document can be attached to any of the approval options. A feedback document is
a separate document from the document being approved. It can contain comments or
supplemental information. It can be seen in the Workflow Status Report, Review and Approval
History (by administrators), and Sign Off Sheet.

Once an approval is submitted, you may need to enter your password to confirm your selected
option. This is akin to an electronic signature.

Once a document has been marked as “approved”, it may be converted to a PDF document,
and optionally, have workflow information appended to the end of the PDF such as the sign off
sheet, approver names, approval date, workflow name, metadata, and so on, after a particular
workflow activity has been completed. The following document types can be converted to PDF:
docx, doc, dot, docm, dotx, dotm, html, rtf, txt, and pdf. Converter templates are used to define
the appended information. One or many templates can be configured, depending on the type of
information that is required to be a part of the approved document. Note that for “not approved”
or “approval postponed” documents, template information is not appended. An offline
document can be used as a part of the workflow and append workflow information. The offline
document is converted to an electronic document format and the appended workflow
information becomes the document content.

When the system converts a document to a PDF during the workflow process, a new version of
the document is added to the library. A global option,
“Convert2PdfApproveBothDocumentVersions”, in the web config file in C:\Program
Files\FileHold Systems\Application Server\LibraryManager can be configured to allow the
option of recording both the source document and the newly created PDF as approved. If this
option is not enabled, the new created PDF document will be the only document shown as
approved. If it is enabled, the source document will also be marked as approved and both
documents will be linked to the signoff sheet and workflow history.

If it is a multiple document workflow, then the approval option selected is applied to all main
documents. See Initiating a Workflow on Multiple Documents for more information.

TO APPROVE DOCUMENTS

1. GotoReviews and Approvals > My Tasks and select a workflow where the task is set to
Approve.

2. Inthe FDA, click Submit Approval from the menu bar or right-click on the task and select
Workflow > Submit Approval.

¢ Inthe Web Client, select the check box next to the task name and click Submit
Review/Approval from the menu bar.

e Alternatively in either FDA or Web Client, right-click on the task and select Workflow >
Submit Approval.

3. Inthe Submit Approval window, select one of the following options:
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e | Approve This Document — The document(s) status changes to “Approved”.

e | Do Not Approve This Document — The document status changes to “Not Approved”
and the workflow is terminated.

e | Postpone Approval of This Document — The document status changes to “Approval
Postponed” and the workflow is terminated. This option is available only if it has been
enabled on the workflow template. A window may appear where you are able to restart the
workflow from a previous activity or return back to the initiator. Select the option to restart
from in the list, if presented, and click OK.

O I Approve This Document

(2 1 Do Not Approve This Document:

(® 1Postpone Approval of This Document

Comments

Select step to restart from X

(®) Return to workflow initiator (sysadm)

) Review 1
cancel
Remove the local copy of this file after my approval feedback has been successfully sent
Description of Task to be Completed
Please approve,
Cancel

Enter any comments if desired.
If desired, attach a feedback document. Click Browse to locate the file.

To remove the local copy of the feedback document, select the Remove the local copy...
check box.

7. Click OK.

You may be required to enter your password to approve, postpone or not approve the
document. In the Please Enter Your Password window, enter your FileHold password and
click OK. This step may be optional depending on the workflow template configuration.
See your Library Administrator for details.

€ FileHold -
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Submit Approval for review, approve | X|

1 Approve This Document
" 1Do Mot Approve This Docurnent
I Postpone Appraoval of This Document

Comments | Please read feedback document, ;I
Please Enter Your Password
In order For vou ko submit wour approval or rejection
of khis document you musk provide your FileHold
password,
Password: || ;I
Attach Feedback Docur Id Dot Browse. .. |
K I Cancel |
M Rema een successfully sent

Description of Task to be Completed

please approve ;l

NOTE: If you log in to FileHold using a domain (Microsoft Active Directory), enter the same
password for logging into your network.

9. The task is removed from the My Tasks list. If the document was approved and there is
another activity in the workflow, then the task moves to the next assigned participant. If the
document was not approved or postponed, then the workflow is terminated.

10. To view the current status of the workflow, see the workflow status report.

Reviewing Documents

The review activity is designed to facilitate the collection of comments and feedback on a file(s)
from other users. The review activity can be used alongside one or more review or approval
activities. Unlike the approval activity, the review activity does not have the same rules for
activity termination. The review approval activity is considered complete once all participants
have completed the task of reviewing the document and providing comments and/or feedback
documents.

Once a review activity is initiated, the document tasks are automatically routed to the
participants and appear in their My Tasks list. Email notification can also alert users when they
are assigned a new task of reviewing a document.

As the activity progresses, participants complete their review tasks by providing comments
and/or attaching feedback to the file. All comments and feedback files are routed back to the
initiator so they can get the feedback they need to continue working on the document.

Documents that are under a workflow can be viewed and/or checked out during the review
process (if configured). .The review task cannot be completed while a document in the activity
is checked out and the document must be checked in before a review can be submitted.

When all participants complete all of the review tasks the activity is completed. The next
activity in the workflow will then begin. If this is the last activity in the workflow the workflow will
be marked as complete.
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If it is a multiple document workflow, then the review status is applied to all main documents.
See Initiating a Workflow on Multiple Documents for more information.

Once a review is submitted, you may need to enter your password to confirm your review. This
is akin to an electronic signature.

TO REVIEW DOCUMENTS

1.

Go to Reviews and Approvals > My Tasks and select a workflow where the task is set to
Review.

In the FDA, right-click and select Workflow > Submit Review.

In the Web Client, select the check box next to the task and click Submit
Approval/Review.

In the Comments field, enter your comments for the document.
To attach a document containing additional feedback, click Browse to add the file.

Select the Remove the local copy of this file after my review feedback has been
successfully sent check box if applicable.

' A
Submit Review of Purchase order - Laptop lihj
Comments  Irecommend that this PO is approved|
Attach Feedback Document

Remove the local copy of this file after my review feedback has been successfully sent

Description of Task to be Completed

Review purchase order for cost.

[ OK ] [ Cancel

" vy

Click OK.

You may be required to enter your password to review the document. In the Please Enter
Your Password window, enter your FileHold password and click OK. This step may be
optional depending on the workflow template configuration. See your Library Administrator
for details.

The task is removed from your My Tasks list. If there is another activity in the workflow,
then the task moves to the next assigned participant.

To view the current status of the workflow, see the workflow status report.
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7.3.3.

7.3.4.

Using Microsoft Office Applications for Workflow Tasks

The integration with FileHold allows users to fully interact with their files with Microsoft Office
applications. FileHold supports the completion of workflow tasks from the following Microsoft
Office applications - Word, Excel, PowerPoint, Outlook, Visio, and OneNote 2010.

The FileHold Add-Ins toolbar allows you to get a copy of the document or check out a
document that is under a workflow. You can also attach the current Microsoft Office document
as a feedback document for a workflow task and approve/review the document at the same
time.

TO GET A COPY OR CHECK OUT A DOCUMENT UNDER WORKFLOW FROM THE ADD-INS TOOLBAR

w0 DD

In a Microsoft Office application, go to the Add-Ins toolbar and click Browse ﬁﬁ' .
Go to My Tasks list.

Right-click on the workflow instance and select Show Documents.

Select the document name from the list and select click of the following options:
Get a Copy — Opens a copy of the document in the associated application.

Check Out — Checks out and opens the document in the associated application. The
document is locked down and the workflow task cannot be completed until the document is
checked back in. See Checking Out a Document for more information.

To ADD A MICROSOFT OFFICE DOCUMENT AS A FEEDBACK DOCUMENT

Create and save the feedback document locally.

Click Send to FileHold > Send Review / Approval Feedback in the FileHold Add-Ins
toolbar.

Select the document that you are reviewing or approving in the list and click OK.

If you are submitting a review, enter your comments, attach a feedback document, and
select any of the options and click OK. See more about reviewing documents.

Select the Use Active Document check box to use the file that is currently being edited to
be attached as a feedback document.

If you are approving a document, select whether you approve, not approve or postpone
approval on the document(s), enter a feedback document, and select any of the options
and click OK. See more about approving documents.

If you select the Use Active Document check box, the file that the user is currently editing
will be attached as a feedback document.

Select the “Close this document after my approval...” check box to close the document
in the associated application.

Select the “Remove the local copy...” check box to delete the local copy of the feedback
document.

Click OK. The document is attached as a feedback document and the task is marked as
complete.

Reserving a Task in a Workflow

When a library administrator creates a workflow template, they can decide if only one out of a
group of participants needs to complete a task using the 1 of X check box in the template. For
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example, a sales group consisting of four users is added as the participants in a review task
but only one person on the team needs to complete the review the document.

If only one person has to complete the task (1 of X option is selected), then the option to “force
the reservation” of a task is available. Participants may be forced to “reserve” a task in a
workflow depending on how the template was configured. If enabled, this enforces that one
user out of the group of participants must reserve the task before the task can be reviewed or
approved and the task completed.

If the “force reservation” setting is not enabled in the template, then the task can be completed
without a reservation; however a reservation can still be made for the task. The first person to
complete the task with or without reserving it automatically voids the task for all other
participants in the activity.

Once atask is reserved by a single participant, the task is removed from the My Task list for all
other participants in the activity. The status for the user who has the task reserved becomes
“Reserved” until the review or approval process is complete. The status for the remaining
participants who did not reserve and complete the task becomes “Voided”. If a task is reserved
by another participant, a notification email will be sent to all other participants.

In the workflow status report and My Tasks list, tasks that can be reserved are shown with an
asterisk. If a task needs to be or can be reserved, the Reserve/Undo Reservation button is
available from the My Tasks and Workflow Status Report. If the “force reservation” setting is
enabled in the template, then the task must be reserved before it can be approved or reviewed.

Other reservation rules include:
e A future task cannot be reserved.
e Areserved task cannot be overridden or delegated.
e An administrator can reserve or undo a reservation for another user.

A task can be reserved if you have been assigned a task, or if you are a senior library
administrator or higher. A cabinet administrator can reserve a task for a user if they have
ownership of the cabinet where all of the main workflow documents reside.

For more information on creating workflow templates, see the Library Administration Guide.

See the table below for a summary of the rules on the 1 of X and Force Reservation settings in
a workflow template.
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Workflow Template Settings

Effect on Workflow

Workflow Template

\/ lofX

Force Reservation

e Only one participant in a group of participants in
the activity can complete the task.

o Participant may “reserve” the task but is not
forced to; the task can still be completed without
the reservation.

o First participant to complete the task voids the
task for all other participants. The task is
removed from their task list.

e The activity is considered complete after a single
participant completes the task.

If the participant reserves the task even though it is
not enforced:

e Only the participant who reserved the task can
complete the task.

e The status of the task changes to “Reserved” for
the participant who reserved it.

e The status of the other participants who did not
reserve the task changes to “Blocked”.

e The participant who reserved the task can undo
the reservation which frees the task for the other
participants to complete.

Workflow Template

1ofX

Force Reservation

v
v

e Only one participant in a group of participants in
the activity can complete the task.

e A participant must reserve the task before the
task; the task cannot be completed without the
reservation.

o First participant to reserve the task voids the task
for all other participants. The task is removed
from their task list.

e The activity is considered complete after the
single participant reserves and completes the
task.

If the participant reserves the task:

e Only the participant who reserved the task can
complete the task.

e The status of the task changes to “Reserved” for
the participant who reserved it.

e The status of the other participants who did not
reserve the task changes to “Blocked”.

e The participant who reserved the task can undo
the reservation which frees the task for the other
participants to complete.

TO RESERVE A TASK

NOTE: You may be forced to reserve a task prior to being able to complete the task. Check the
workflow template to see if the “Force Reservation” setting is enabled.

1. Do one of the following:
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7.3.5.
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e From My Tasks, select task that you want to reserve and click Reserve/Undo
Reservation. Tasks that can be reserved are marked with an asterisk (*).

e From Workflow Status Report, select task that you want to reserve and click
Reserve/Undo Reservation. Tasks that can be reserved are marked with an asterisk (*).
Only current tasks can be reserved, future tasks cannot.

2. A message appears asking if you are sure that you want the reservation. Click OK. The
status for the participant who reserved the task becomes “Reserved”. The task is removed
from the My Tasks list of the other participants and their status changes to “Blocked”.

3.  After reserving the task, the task can be completed as normal (mark as
reviewed/approved). After the task is completed, the status for all other participants
changes to “Voided”.

TO UNDO A RESERVATION

1. Select the task that you have reserved from the My Tasks or the Workflow Status Report.
The status of the task should be “Reserved”.

2. Click Reserve/Undo Reservation.

3. A message appears asking if you are sure that you want to undo the reservation. Click
OK. The task is now unblocked for the other participants and reappears in their My Tasks
list. The task can now be reserved by another participant in the activity.

Checking Out a Document Under the Workflow

A document under a workflow process can be checked out by a participant in the active
workflow activity. Once a document has been checked out by a participant, it is locked down
and cannot be checked out by another participant until the document has been checked back
in.

The review or approval cannot be completed while a document in the activity is checked out
and the document must be checked in before a review or approval can be submitted. When the
document is checked in as a new version, the version number is increased and becomes the
version associated with the workflow.

If the 1 of X option is selected on the template, then the task is automatically reserved when it
is checked out. The task remains reserved after the document is checked in so the user can
complete the approval or review task.

In order to use this feature, a permission setting in the system administrator area must be
enabled. See the System Administration Guide for more information. The option “Allow Check
Out” must be enabled in the workflow template for each activity in order for a participant to
check out a document. If the option is not enabled in the template, then none of the documents
in the workflow can be checked out for that activity.

In order to see if any documents have been checked out in the activity, click the Show
Documents link from the My Tasks or Workflow Status Report. The status of the document is
“Checked out” in the documents list.

TO CHECK OUT A DOCUMENT UNDER A WORKFLOW

1. Go to My Tasks or the Workflow Status Report and click the Show Documents link for the
workflow that you want to check out a document from.

2. In the “Documents associated with workflow template name” pane, select the document to
be checked out.

3. Inthe FDA, right-click on the document and select Check Out This Document.
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¢ Inthe Web Client, select the check box next to the document name and click Check Out
or right-click on the document and select Check Out This Document.

4. Browse for the folder to check out the document to (if required) and click OK.

5. A message stating that the document is checked out opens. Click OK. The activity is now
locked down and cannot be completed (approved/reviewed) until the document is checked
back in. When the document is checked in, the workflow is associated with the new
version.

TO CHECK IN A DOCUMENT UNDER A WORKFLOW

1. Go to My Tasks or the Workflow Status Report and click the Show Documents link next
to the workflow name for which you want to check in a document.

2. Inthe “Documents associated with workflow template name” pane, select the document to
be checked in.

3. Inthe FDA, right-click on the document and select Check In This Document.

e Inthe Web Client, using the context sensitive menu, select Check In Document or right-
click on the document and select Check In This Document.

4. Select one of the following options and click Check In:
e Undo Check-out. | have not made any changes.
o Edit Metadata for this document after check-in.
e Delete the local copy of the file after it has been successfully checked in (FDA).
e Email notify all folder members that this document has been Checked-In (may not be
available).

7.3.6. Get a Local Copy of the Workflow Document

You can save a copy of the document under the workflow process to your local computer. Note
that getting a copy of the document does not check out the document. To check out the
document, complete the checkout process.

TO GET A LOCAL COPY OF THE WORKFLOW DOCUMENT
1. Do one of the following:

e Inthe FDA, from My Tasks or Workflow Status Report, click the Show Documents link.
In the “Documents associated with workflow template name” window, select the document.
Right-click on the document and select Get a Local Copy.

e Inthe Web Client, from My Tasks or Workflow Status Report, click the Show
Documents link. In the “Documents associated with workflow template name” window,
select the check box next to the document name and click Get a Copy.

2. Inthe FDA, if prompted, select the location to save the document and click OK. The
document is copied to that location.

¢ In the Web Client, the document is downloaded to the browser’s download folder.
7.3.7. Manually Restarting Workflows

Workflows can be manually restarted on:

e An active workflow from the first activity to the current one.
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e A completed workflow that has been marked as “not approved” or “approval postponed”
from the first activity to the one that was marked as not approved or postponed.

Workflows can be manually restarted by:
e Workflow initiator
e Senior library administrator or higher

e Cabinet administrator if they have ownership of the cabinet where all of the main workflow
documents reside.

If the workflow is restarted, the current workflow is cancelled (if not already completed) and
displays the Restarted status. A new, identical workflow is started and the previous workflow
details can be viewed in the Restarted Workflows Status Report by clicking the Restarted link.

If documents are added to a workflow that has been marked as “approval postponed” upon
restarting the workflow and a “main document” is added, an administrator can define on the
workflow template if all the activities should restart from the first activity. This allows all of the
main documents including the new main document to go through the entire workflow process
once again. If the "Reset all activities when adding documents to a postponed workflow" option
is not enabled on the template then the workflow is restarted from the activity from which the
approval was postponed. See your library administrator for details.

If a workflow approval is postponed and later restarted, then the restarted workflow gets
canceled, the resulting status of the canceled workflow is “approval postponed”.

Workflows are restarted in the workflow status report.

NOTE: Workflows may be restarted automatically from an activity marked as “approval
postponed” if enabled in a workflow template. See your library administrator for details.

TOMANUALLY RESTART A WORKFLOW

1. Inthe workflow status report, select the activity to be restarted. It can be an active or a
completed workflow that was marked as not approved or approval postponed.

Click Restart Workflow.

Click OK at the alert message. A new workflow is started with notifications being sent to
the participants.

4.  The old workflow instance status changes to “Restarted” and a new workflow instance is
created. The previous workflow details can be viewed by clicking the Restarted link. The
Restarted workflows status report show any restarted workflows. From here you can view
the documents (click Show documents) and workflow template details (click View
details).

Reviews & Approvals Status Report

Restart Workflow Rename Workflow Cancel Workflow Clear Cancelled Clear Completed Override Task Reserve [ Undo Reservation Delegate Task Print Export
Workflow Main [ Supporting Initiator Started Due Completed Status
H Show documents
i _approve approve approve_B... 1/0 Show documents  sysadm sysadm 9/2/2016 3:20PM  9/3/2016 ::20 PM 86% Pending Approval View details
Restarted workflows status report
‘Back To Status Repart : @
Workflow Main / Supporting Initiator Started Due Completed Status
=] Show documents View details
' _approve approve approve_Ba... 1/o Show documents  sysadm sysadm 59/2/2016 3:20PM 9/3/2016 3:20 PM Restarted Restarted View details
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7.3.8. Delegating Tasks to Another User
Task delegation is a critical component of any workflow system as it allows work to continue to
flow if a participant is either too busy or unavailable. Once delegated, the user will be notified of
their new tasks. You can delegate tasks when you are the task owner, the cabinet owner, or a
system administrator.
A task cannot be delegated when:
e The task has been reserved. A future task can be delegated.
e The user is already a participant in the activity.
You can automatically delegate all tasks assigned in the event of vacation or extended
unavailability. Learn more about setting up automatic task delegation in the workflow
preferences.
TO DELEGATE A TASK TO ANOTHER USER
1. Goto Reviews and Approvals > My Tasks or Workflow Status Report. You can
delegate tasks from either location.
Select the task that you wish to delegate and click Delegate Task.
3. Enter the first or last name or email address of the person you want to delegate the task to
and click Find.
4. Inthe Search Results, select the user and click Select User(s).
The task is now updated for the delegated task. In the Workflow Status Report, you can
see who the task has been delegated to and who it is on behalf of.
Document Hame Ver Workflow Initiator Started Due Completed Approved
=] i?‘i] View details
Activity Type Task Participant On Behalf of Comments Attachments Started Due Completed Approved
1 Review 1 Marvin Mallett This document needs to be revised. See attached. A 16/03/2011 17/03/2011 17/03/2011 Reviewed
2 approval 1 17/03/2011 15/03/2011
7.3.9. Cancelling Workflows

A workflow can be cancelled by the person who initiated it or by a Library or system
administrator. Cancelling a workflow terminates the workflow immediately and notification
emails are sent to all participants. See Workflow Notifications for more information.

If a workflow approval is postponed and later restarted, then the restarted workflow gets
cancelled, the resulting status of the cancelled workflow is “approval postponed”.

TIP: Workflow approvals are automatically terminated if a workflow is marked as not approved
or approval postponed by a single participant.

TO CANCEL A WORKFLOW INSTANCE
1. Do one of the following:
e Inthe FDA, select the workflow name from My Tasks or Workflow Status Report.

e Inthe Web Client, select the check box next to the workflow name from My Tasks or
Workflow Status Report.

2. Click Cancel Workflow. All participants in the workflow that had tasks assigned to them
will have the tasks automatically removed from their Task List. If they have set preferences
to alert them of cancelled tasks by email, an email will be sent.
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7.3.10. Viewing the Workflow Status Report for a Single Task

You can view the workflow status report for a single task from the My Tasks List.

TO VIEW THE STATUS REPORT FOR THE TASK
1. From the My Tasks list, select a task from the list and click View Workflows.

2. The workflow status report is shown. Click Back to My Tasks to return to the task list.
7.3.11. Disabling Automatic Refresh for My Tasks List

The automatic refresh of the My Tasks list can be disabled in the FileHold Desktop Application.
If disabled, the selected task will now remain highlighted until the task is removed or the focus
is moved to another task in the list.

If left enabled, the My Tasks list is refreshed every 15 seconds. The task selection and scroll
position is restored after the refresh and the previous selected task will be lost. This can cause
problems if the user has a large number of tasks assigned to them

TO DISABLE THE AUTOMATIC REFRESH FOR THE MY TASKS LIST
1. From the My Tasks list, to disable refresh, click Automatic refresh of tasks is enabled.

2. To disable automatic refresh, click Automatic refresh of tasks is disabled.

7.4. VIEWING THE SIGN OFF SHEET

In the Sign-Off Sheet, you are able to view the list of participants that have either approved, not
approved or postponed approval of the workflow document, when it was signed off, and if they
have signed it off on behalf of someone else. If the status is “Voided” this means that the task
was reserved and completed by another participant.

The sign off sheet can be viewed from the:
e Folder list
e Search results
e  Workflow status report > Show Documents link
e Version History

e My Tasks > Show Documents link

TO VIEW THE SIGN OFF SHEET
1. Inthe FDA, right-click on the document and select Workflow > View Sign-Off Sheet.
e Inthe Web Client, click the down arrow on the document name and select Sign Off Sheet.

2. The Sign-Off Sheet pane appears below. Click X to close the pane.

7.5. WORKFLOW STATUS REPORT

The Workflow Status Report shows the status of all workflows that are occurring in the system
that the user is the initiator of, a participant in, or an observer. The report shows the tasks from
all activities, including those that have not yet started (future tasks). Users can access the
Workflow Status Report by clicking on the Reviews and Approvals > Status Report.
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El\g Reviews & Approvals
. -d@ My Tasks

-

= M

The workflow status report can also be accessed in the Administration Panel of the Web Client.
This workflow status report contains filters that can be used to narrow down those workflows
that the end users have participated in or observed. See Administration Panel Workflow Status
Report for details on how to use the filter.

In Reviews and Approvals Status Report pane, all of the workflows that you are involved in are
shown. The workflow name, the number of main documents and supporting documents
involved with the workflow, the initiator, the start and due dates, the percent completed, and
the status of the workflow. The possible statuses of a workflow are:

e Pending Approval (In progress) — When the workflow is in progress.

e Completed — If the workflow is completed the final approval or review status is shown.
(Approved, Not Approved, Approval Postponed, or Reviewed).

e Cancelled — If the workflow has been cancelled, the status of Cancelled is shown.

e Restarted — The workflow has been restarted manually or automatically.

The number of main and supporting documents in the workflow is shown in the workflow
summary line. To view all of the documents that are involved in the workflow, click the Show
Documents link. The documents appear in the “Documents associated with <workflow
template name>" window. The documents are listed by main or supporting document types.
See Multiple Document Workflows for more information. From here, documents can be

checked out, emailed, viewed, downloaded, or deleted.

Documents associated with review, approve workflow Select Wiew: | Defaulk View
&y of € (1 5 | Back To Status Report
Document Nanme 4 Main / Supporting Location Type Linked Yer Status Last Modified Dn
a2

3
2

L s) 'f'_~ ALLISON MUNDY 00114429 Main Training and Support | FileHold 12 [ test  Board Minutes 1] Checked In~ 7/11/2013 3:19 PM

Under each workflow name, click on the + or > symbol to view all the activities in the workflow.
The activity order, type (review or approval), the participant, on behalf of (if the task was
delegated), comments, attachments, start date, due date, and completion date, the percent (%)
completed, and if the task status. The possible statuses of a task are:

e In Progress (Blank) — If the task is in progress, then the status is blank (empty).
e Future (Blank) — If the task is in the future, then the status is blank (empty).
e Cancelled — The workflow has been cancelled.

e Overridden — The workflow task has been ignored and no action is taken. The workflow
completed or moved on to the next activity in the workflow.

e Voided — The task was reserved and completed by another participant. The task was
removed and voided from all other participants.

e Reserved — The task is currently reserved by a participant.

e Blocked — The task is currently reserved by another participant thereby blocking all other
participants from the task.

An asterisk (*) appears next to the participant’'s names’ for all tasks that are available to be
reserved in the Workflow Status report.
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Workflow M curnerts Initiator Started Due Cornpleted Status
> W, APProve 2 Show Documents farvin Muffins 771572013 10:56 &k TAATS2013 10:55 Ak 0% Wiew Details
w [ review, apprave 2 Show Docurments Marein Muffins 71272013 146 PM Tr16/2013 11:52 Ak S0% Wiews Details
Activity  Type Task  Participant On Behalf of  Comments Attachments  Started Due Completed Status
r 1 Fewiewn 1 sysadrm® T/L3/2013 1dd Pra 7/13/2013 146 PA 7/15/2013 1152 Ak Woided
r 1 Rewiew 2 Marvin Muffins™ see feedback 741272013 1:46 PR 7/13/2013 1:46 PA 7/15/2013 11:52 AW Reviewed
-z Sfpproval 1 Basie Pie* TAL5F2013 1152 AR T/16/2013 1152 A
02 Approval 2 Marvin Muffins® T/15/2013 152 Ak T/16/2013 11:52 Ak
y [ review, approve 2 Show Dacuments Basie Pie TA11/2013 2:16 PR TA12/2013 3:31 PR T1L2013 2:40 Pra Approved  Miew Details
» [ review, approve 2 Show Dacurments Basie Pie 771072013 3:16 PRA T712/2013 3:16 PR 0% Wiews Details
> [ review, approve 2z Show Documents sysadrn 71072013 2:34 PR TA11/2013 2:40 PRA 71242013 1:25 P Approved  Wiew Details
KM 4 m boM Page size: |10 = | Displaying page 1 of 1, iterns 1to 10 of 10,

To view comments that a participant has left for a document, double-click on Comments link.
The Comment Details window displays the comments from that participant and task.

Comment Details @
T N arvin Mallett|
Completed  17/03/2011
Comments I recommend that this PO is approved -

To download a copy of the feedback document, click the Save icon = in the Attachments
column. In the FDA, select the location to save the feedback document and click Save. The
document is downloaded to that location. In the Web Client, the feedback document is saved to
the browser’s default download location.

The selected workflow in the Status Report list remains selected until the list is refreshed and
the selected workflow is no longer in the list.

TO TAKE ACTION ON WORKFLOW STATUS REPORT RESULTS

1. You can take the following actions on a workflow in the list by selecting the check box next
the workflow:

e Show Documents (link) — Opens the documents associated with the workflow (main
documents and supporting documents) in a separate window.

e View Details (link) — Displays the workflow template.

e Restart a Workflow — Select the completed activity from where to restart the workflow from.

Workflows can be restarted on not approved, approval postponed, or an active workflow.
Workflows marked as completed and approved cannot have their workflows restarted.
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o Rename Workflow — To rename the workflow instance, select the workflow from the list
and click Rename Workflow. Enter the new workflow instance name and click OK.
Workflows can only be renamed by the initiator or senior administrator if the “allow initiator
to define” option has been enabled in the workflow template.

e Cancel a Workflow — Allows you to cancel the workflow. Confirm the cancellation by
clicking OK at the message prompt.

e Clear Completed — Clears completed workflows with a status of approved, not approved,
approval postponed or reviewed from the list. When clicked the message “Completed
workflows will no longer be visible on your personal workflow status report. Check the box
below to include postponed workflows”. To remove any postponed workflows from the
status report, select the Clear Postponed Workflows check box. To retain any postponed
workflows, clear the check box. Users may want to keep workflows with a status of
approval postponed because the workflow isn’t truly completed.

e Clear Cancelled — Removes the completed workflows from the list.

e Reserve/Undo Reservation — Allows you to “reserve” or undo the reservation for the
selected task. Once a task is reserved by a participant, it prevents all other participants
from completing the task and is removed from their task list. The status of the user who
reserved the task is “Reserved”. The status of the other users is “Blocked”. Once the task
is completed by the participant that reserved the task, the statues changes to “Reviewed”
or “Approved” and the status for all other participants is “Voided”. If the reservation for the
task is undone, then the task is available to all participants again. This function is available
only if the option Force Reservation is enabled in the workflow template. See Creating
Workflow Templates for more information. An asterisk (*) appears next to the participant’s
names’ for all tasks that are available to be reserved in the Workflow Status report.

e Override Task— Overrides a task or activity by moving it to the completed state without
affecting the rest of the workflow. Use this feature when a workflow member is absent and
the workflow needs to be completed. See Overriding Workflow Tasks for more information.

¢ Delegate Task — Delegates a task to another user. Expand the workflow by clicking > next
to the workflow name to select a task to delegate and click Delegate Task. In the Find
People window, enter a name or email address and click Find Now. In the Search Results,
select the user and click Select Users. A message stating the task delegation was
successful appears. Click OK. A task that is marked as “Reserved” cannot be delegated.
Future tasks can be delegated.

e Print (FDA Only) — Prints an exact match of what is displayed on the screen.

e Export (FDA Only) — When exporting the report, you can choose to export only the
workflow or you can include both the workflows and the tasks. The report can be exported
to CSV or HTML. Note that for the HTML report, the workflow must be expanded in the
Workflow Status Report results to print the tasks. In other words, the HTML report will be
exported to look exactly how it appears on the screen.

e Changes link (Web Client only) — View the workflow change log.

e View Details link — Review the workflow template details. If you are using the FDA, click
on the coloured areas to expand and contract the different areas of the workflow template.

To scroll through the workflows or to increase the number of workflows shown on the screen in
the Web Client, use the controls at the bottom of the report.
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Administration Panel Workflow Status Report

In the Administration Panel Workflow Status Report, you can search for workflows and perform
certain actions such as cancel a workflow, get a copy, clear completed and cancelled
workflows, override tasks and activities and delegate tasks. The report shows the tasks from all
activities, including those that have not yet started (future tasks). The administration panel
workflow status report has a number of filters that can be used to narrow down your workflow
search results.

TOFILTER THE WORKFLOW STATUS REPORT

In the Web Client, go to Administration Panel > Workflow Management > Status
Report.

Select from the following filter options. Alternatively, to return a list of all workflow events,
leave the check boxes clear.

Workflow Status Equals — Select one of the following: In Progress, Completed, Cancelled,
Approval Postponed, Pending Approval, Approved, or Not Approved.

Completed Between — Enter a minimum and maximum percentage for the amount of
workflow completed.

Date Started — Enter a minimum and maximum date for when the workflow was started.
Due Date — Enter a minimum and maximum due date for the workflow.

Document Name Contains — Enter a text string for the name of the document in the
workflow.

Workflow Name Contains — Enter a text string for the name of the workflow.

Initiator is — Select a user name from the list.

Click Apply Filter. The search results are displayed below. You can now take actions upon
the workflow results.
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7.5.2. Workflow Change Log

The workflow change log is accessed through the workflow status report and tracks the
changes made to the workflow process such as delegating, restoring, restarting, overriding,
and cancelling. The workflow change log is specific to each workflow and is access only
through the workflow status reports in the Web client.

The workflow change logged can be viewed using the Changes link in the workflow status
report. If no changes for the workflow has been logged, the Changes link is not available.

TO VIEW THE WORKFLOW CHANGE LOG

1. From the Web Client, go to Administration Panel > Workflow management > Workflow
status report.

e Alternatively, in the Web Client, go to Reviews and Approvals > Workflow status report
in the library tree.

2. Locate a workflow and click the Changes link.

3. The following information is displayed in the workflow change log:

Column Description

Action type Describes the action taken on the workflow.

The following information is recorded in the
workflow change log:

e Manual delegation of a participant

e Automatic delegation of a participant
e Restoration of an original participant
¢ Delegation of an initiator

¢ Restoration of an original initiator

e User overrides a task

e User cancels a workflow

o User restarts a workflow

Action performer The user who performed the action. This
could be an administrator, initiator, or
participant.

Action date/time The date and time the action occurred.

Activity number The activity number in the workflow that the

action occurred.

Task number The task number in the workflow activity that
the action occurred.

Delegated user The name of the delegated user (initiator or
participant) if applicable.

4. Click Back to return to the workflow status report.

7.6. WORKFLOW DASHBOARD

The Workflow dashboard gives a high level overview of the all the active, completed,
cancelled, overdue, and total workflows for all workflow templates in the system. This
information is displayed in table and pie chart formats.
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The workflow dashboard is only available in the Web Client. Users with read-only and above
roles can view the workflow dashboard.

Workflow Dashboard 7
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TO USE THE WORKFLOW DASHBOARD

1. Inthe Web Client, go to Administration Panel > Workflow Management >
Dashboard.

2. To select the date range to display select or enter a date in the From and To fields. By
default, data from the last 3 months is shown.

3. To determine which workflows are displayed in the pie chart, select one of the
following options from the drop down list:

o Active workflows

o Completed workflows
e Cancelled workflows
e Overdue workflows

o Total workflows

4. Click Refresh to update the information.

7.7. VIEWING THE REVIEW AND APPROVAL HISTORY OF A DOCUMENT

The document review and approval history is essentially a snapshot of the workflow status
report but only for the selected document. You can view the workflow name, initiator, number
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of main documents, completion status plus all the activity information such as participant name,
comments, attachments, status and so on.

The document review and approval history can also be exported (CSV or HTML) or printed
from the FDA.

TO VIEW THE WORKFLOW HISTORY

1. From the My Tasks or Workflow Status Report, click Show Documents. The “Documents
associated with <workflow template name>" pane opens.

Right-click on a document and select Workflow > View Review and Approval History.

3. The Document Review and Approval History is displayed. To print (FDA Only) an exact
match of what is displayed on the screen, click Print.

4. To export the history, click Export and select an option. When exporting the report, you
can choose to export only the workflow or you can include both the workflows and the
tasks. The report can be exported to CSV or HTML. Note that for the HTML report, the
workflow must be expanded in the Workflow Status Report results to print the tasks. In
other words, the HTML report will be exported to look exactly how it appears on the
screen.

5. To return to the previous screen, click Back to Folder.

Document Review & Approval History

Back to Folder Print  Export
Workflow Documents Initiator Started + Due Completed Status
= Show documents Wiew details
Activity Type Task Participant  On Behalf of Comments Attachments Started Due Completed Status
1 Review 1 sysadn® FIE2013 10:56 &M 7/16/2013 10:56 AM
1 Review 2 Marwin MuUFFins® FISZ013 10:56 AM 7(16/2013 10056 AM
z Approval 1 EBasie Pie*
z

Approval 2 Marwin MuFfins®

7.8. DELEGATING INITIATORS AND PARTICIPANTS

Task delegation is a critical component of any workflow system as it allows work to continue to
flow if a participant is either too busy or unavailable. Once delegated, the user will be notified of
their new tasks. Task delegation can be accomplished in different areas of the software:

e  Workflow status report
e  Workflow delegation in the Administration panel

If an employee goes on leave or exits the company, several workflow tasks may need to be
delegated en masse. This can be accomplished from the Workflow Delegation menu in the
Administration panel. You can delegate both workflow participants and workflow initiators.

e  Workflow participants can be delegated by the system administrator, senior library
administrators, cabinet owners, workflow initiators and task participants.

e  Workflow initiators can be delegated by system administrator, senior library administrators,
cabinet owners, and workflow initiators.

If the user is not an administrator, they will only see the tasks which they have initiated or are
participating in. Cabinet owners (cabinet administrator and library administrator roles) will only
see the workflows for the cabinets they own.

Both participants and initiators can be restored to their original owners in the event that the
user comes back, such as from holidays, and needs to resume their duties.
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TO DELEGATE A PARTICIPANT TO A TASK

1. In the Web Client > Administration panel, go to Workflow management > Workflow
delegation > Participants.
2. Use the following filter criteria and click Apply Filter. To show all workflows, leave filter
criteria blank and click Apply Filter.
Filter Description
Participant Select the participant name from the list.
This can be the original participant or a
delegate.
On behalf of Select the original participant name from the
list.
Workflow template name contains Enter a full or partial workflow template
name.
Workflow name contains Enter a full or partial workflow name. This

can be the workflow template name or the
name that was set up in the custom naming
pattern for the workflow template.

Due date When the task is due. You can enter a From
and/or To date or the number of days from
now.

3. The following information is displayed in the Search results. Any workflows that are
considered complete (approved, not approved, reviewed, or cancelled) are not
displayed.

Column Description

Workflow template name The name of the workflow template.

Workflow name This can be the workflow template name or

the name that was set up in the custom
naming pattern for the workflow template.

Task description The task description in the workflow
template. This gives the participant any task
instructions.

Participant This can be the original participant or a
delegate.

On behalf of The name of the original participant.

Due date The due date of the task

Workflow task status The status of the task: Pending Approval or

Pending Review

Select the check boxes next to the workflow tasks and click Delegate participant.
Enter the name of the user and click Find Now.

Select the check box next to the user name and click Select User. The participant is
changed to the user to which the tasks have been delegated. The On behalf of is the
original participant name.

7. To export the search results, click Export as CSV.
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8. To view the workflow status report for the task, click the <workflow name hyperlink> in
the Workflow name column.

TO RESTORE A PARTICIPANT

1. In the Web Client > Administration panel, go to Workflow management > Workflow
delegation > Participants.

2. Use the filter criteria from above and click Apply Filter. To show all workflows, leave
filter criteria blank and click Apply Filter.

3. In the Search results, select one or more workflow tasks that have been assigned to
another participant. In other words, there is a user name in the On behalf of column.

4, Click Restore participant. The participant is assigned to the original participant owner.

TO DELEGATE AN INITIATOR

An initiator of a workflow has the ability to control certain aspects of a workflow from the
workflow status report. It is important that the correct initiator is set in order to manage the

workflows.
1. In the Web Client > Administration panel, go to Workflow management > Workflow
delegation > Initiators.
2. Use the following filter criteria and click Apply Filter. To show all workflows, leave filter
criteria blank and click Apply Filter.
Filter Description
Initiator Select the initiator name from the list. This
can be the original initiator or a delegate.
On behalf of Select the original initiator name from the list.
Workflow template name contains Enter a full or partial workflow template
name.
Workflow name contains Enter a full or partial workflow name. This

can be the workflow template name or the
name that was set up in the custom naming
pattern for the workflow template.

3. The following information is displayed in the Search results. Any workflows that are
considered complete (approved, not approved, reviewed, or cancelled) are not
displayed.

Column Description
Workflow template name The name of the workflow template.
Workflow name This can be the workflow template name or

the name that was set up in the custom
naming pattern for the workflow template.

Initiator The name of the person who started the
workflow. This can be the original initiator or
a delegate.

On behalf of The name of the original initiator.

Due date The due date of the task
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Status The status of the workflow: Pending
Approval or Pending Review

Select the check boxes next to the workflow tasks and click Delegate initiator.
Enter the name of the user and click Find Now.

Select the check box next to the user name and click Select User. The initiator is
changed to the user to which the tasks have been delegated. The On behalf of is the
original initiator name.

To export the search results, click Export as CSV.

To view the workflow status report for the workflow, click the <workflow name
hyperlink> in the Workflow name column.

TO RESTORE AN INITIATOR

1. In the Web Client > Administration panel, go to Workflow management > Workflow
delegation > Initiators.

2. Use the filter criteria from above and click Apply Filter. To show all workflows, leave
filter criteria blank and click Apply Filter.

3. In the Search results, select one or more workflows that have been assigned to another
initiator. In other words, there is a user name in the On behalf of column.

4, Click Restore initiator. The participant is assigned to the original initiator owner.

OVERRIDING WORKFLOW TASKS

In some situations, tasks in a workflow need to be removed from the workflow in progress.
Overriding a task removes the task from the workflow instance without affecting the remaining
workflow tasks. When a task is overridden for a participant, the status of the task changes to
“overridden”. In the case where a document is being approved by other participants, the
remaining approvers determine if the document is “approved”.

Overriding a task or activity is only available to the workflow initiator or administrators. A task
cannot be overridden if it has been reserved. Completed tasks and activities cannot be
overridden. A future task can be overridden.

TO OVERRIDE A TASK

1. GotoReviews and Approvals > Workflow Status Report and select the workflow that
you want to override.

2. Click the + sign to view the workflow activities/tasks in the workflow. Select the task you
want to override and click Override Task.

3. The Override Workflow Tasks message opens stating that the task will be pushed to
completion without affecting the rest of the workflow. Click OK. The status is updated to
“Overridden”.

7.10. WORKFLOW NOTIFICATIONS

You can receive workflow notifications to your email. These are set in the Workflow
Preferences. See Workflow Preferences for more information.
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8. SEARCHING

You can find a document in FileHold using the powerful and robust search capabilities. There
are three methods of searching for documents in FileHold:

e FastFind — Use predefined hot keys to search within FileHold from third party applications.

e Simple Search —The Simple Search feature is a “Google-like” toolbar that uses a full-text
search. FileHold has the ability to recognize, index text and allows users to search content
of all your favorite document types including PDF, Microsoft Office, Zip and many more.
When searching using the full text search, the system searches both the metadata
associated and the content of the document for matches. Full text search is particularly
useful for general searches of files stored in a records management system. For example,
searching the system for all files that make reference to Sarbanes Oxley.

TIP: In order to do partial word searches, you need to use a wildcard (*) before or after the
word you are searching for.

& FDA

I I = IWeb Client

e Advanced Search — The Advanced Search allows users to use the metadata associated
with a document to help locate the file. This is particularly useful when users have a
specific piece of information they would like to search for. Up to ten search parameters can
be used in an advanced search.

Hide Adwvanced '_ﬂ}_"

Advanced Search
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8.1. HOW TO ACCESS SEARCH

There are several methods in accessing the Search function.

e Click Search, My Saved Searches, or Public Saved Searches in the Library Tree. Using
Search will search all documents in the Library tree.

= p Search
& My Saved Searches
p Public Saved Searches

e Using the “Google”-like search toolbar located in the top right of the window. Click the
down arrow next to the search toolbar to access the Advanced Search screen.
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A
In Web Client in a Folder View

Right-click on any area of the library and select Search. This restricts the search to that
location in the Library.

E| Library |
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From the simple search screen, click Advanced to access the Advanced Search screen.

Advanced @

8.2, HOW FILEHOLD SEARCHES FOR DOCUMENTS

Users can only retrieve documents to which they have access. Access is based on user rights
and permissions. Therefore, in order for a user to see a document in their search results they
would have to be a member of the cabinet, folder, and schema that the document belongs to.

The following are how the document management system conducts searches for documents:

When using the operator “Contains in FTS” or “Does not contain in FTS”, it searches all
metadata, file properties, document name, and content (full text indexing) of the
documents.

When using the operator “Contains in DB” or “Does not contain in DB”, it searches the
metadata (databases) only. The content of the documents (full text indexing) is ignored.

FileHold searches for whole words only. Partial words need wildcards (*, ?,) (think of
“Google").

Metadata searches will return the most relevant of results. Metadata searches also return
faster search results as it searches the Microsoft SQL database only.

When the user invokes search functionality on a cabinet, drawer, folder group, or folder,
the search will be restricted to the portion of the file structure from which the search was
invoked.

The contents of the Library Archive are NOT included in the search. To expand the search
to include the Library Archive, select the Include in Archive check box in the Advanced
Search options.

Documents that have been deleted from the system are not included in the search.

Only the latest version of a document is searched. The document usage history and
document version history are not included in the search scope. To expand the search to
include all document versions, select the Include All Document Versions check box in the
Advanced Search options.

My FileHold, Search, Saved Searches and Virtual Folders contents are not searched
because these are links to documents and not where the documents reside.
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8.2.2.
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Metadata field names that have been edited or deleted are not searched. To search using
old metadata field names, select the Search Using Historical Metadata Fields check box in
the Advanced Search options.

General Usage

Avoid searching for two (2) letter words alone; instead use three (3) letter words or simply
use a wild card * before or after the 2 letters. Two letter word searches are not searchable
for several technical reasons:

The two letters you are searching for can appear in a portion of a word, or very commonly
on their own, these if used in the search engine criteria, would greatly slow down and
impede the performance of the FileHold search system.

In addition, they can also affect the quality of search results because they can appear
inside a larger word or on their own with great frequency. This throws off search quality to
unacceptable levels. The document management system is designed to ignore common
words or characters as they tend to slow searches without improving the quality of the
results. See the table below on Noise Words.

Use whole words when searching for words inside of documents. Simple search acts like a
"Google" search and partial words may not return the results you are looking for or may not
return any results. If you need to use partial words, use a wildcard (*, ?,) with the search.

If you use a very generic search term, then the search engine may time out. Try to look for
unique words or terms or limit the search to a specific area in the Library. See Full Text
Search — Wildcard Search Limitation Setting for more information.

Noise Words

A noise word is a word such as "the" or "if* that is so common that it is not useful in searches.
To save time, noise words are not indexed and are ignored in index searches. All single letters
are ignored and include the list of words in the table below.

Letter Noise Words

A a, about, after, all, also, an, and, another, any, are, as, at

B be, because, been. before, being, between, both, but, by

C came, can, come, could

D did, do

E each, even

F for, from, further, furthermore

G get, got

H had, has, have, he, her, here, hi, him, himself, how, however

i, if, in, indeed, into, is, it, its

just

like

made, many, me, might, more, moreover, most, much, must, my

never, not, now

ol z g | «

of, on, only, or, other, our, out, over
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Letter Noise Words

S said, same, see, she, should, since, some, still, such

T take, than, that, the, their, them, then, there, therefore, these, they, this, those,
through, thus, to, too

U under, up

Vv very

W was, way, we, well, were, what, when, where, which, while, who, will, with,
would

Y you, your

Full Text Search - Wildcard Search Limitation Setting

When a wildcard search (*) is performed or is used in conjunction with the “contains” or ‘does
not contain” operators in an Advanced search, using a common term in the repository may
return a very large number of intermediate search results that must be processed. A parameter
limitation can be set on the number of results returned when a search like this has been
performed. Care should be taken not to set a value that makes any typical searches
impractical. For most users this value does not need to be changed from the default which
returns all specified results that can be found before the full text search timeout expires.

The new entry in the web config file in C:\Program Files\FileHold Systems\Application
Server\FullTextSearch is under <appSettings>:

<add key="LimitNumberOfEntriesToReturn" value="0" />
If the value is set to 0, then the limitation is disabled. It is disabled by default.

If a wildcard full text search exceeds the limit set in the web config file then a message is
displayed:

“Your search with the CONTAINS operator would consume more server resources than
allowed by your system administrator. Consider narrowing your search conditions to reduce the
possible results. Your search would have returned {x} documents and your system
administrator has set a limit of {x} documents.”

SEARCH REQUEST TYPES

FileHold supports different types of search requests:

e An"any words" search is any sequence of text, like a sentence or a question. In an "any
words" search, use quotation marks around phrases, put AND in front of any word or
phrase that is required, and NOT in front of a word or phrase to exclude it. Note that the
operators + and — are not supported. Examples include:

e banana pear "apple pie"
e "apple pie" NOT salad AND "ice cream"

e An "all words" search request is like an "any words" search except that all of the words in
the search request must be present for a document to be retrieved. Example:

e FileHold Systems will find all documents with the words FileHold and systems

e A "boolean" search request consists of a group of words, phrases, or macros linked by
connectors such as AND and OR that indicate the relationship between them. Examples
include:
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Search Request Meaning
apple AND pear Both words must be present.
apple OR pear Either word can be present
apple w/5 pear Apple must occur within 5 words of pear
apple NOT w/12 pear Apple must occur, but not within 12 words of
pear
apple AND NOT pear Only apple must be present
apple w/5 xfirstword Apple must occur in the first five words

Noise words, such as “if”: and “the”, are ignored in searches.

Such operators and logics including: stemming, fuzzy, synonym and phonic can be used with
“contains” or ‘does not contain” type searches. Because the stemming, fuzzy, synonym and
phonic search methods can impact search performance the ability to search using Fuzzy,
Synonym and Phonic searching is a global setting configured by the library administrators. See
the Library Administration Guide or the Knowledge Base for more information. However,
individuals can search using these logics for individual full text searches. Search terms may
include the following special characters:

Character Meaning Examples

? Matches any character. appl? would match apply and apple
but not apples

= Matches any single digit. === would match N123 but not
N1234 or Nabc

* Matches any number of characters. appl* would match apple, application,
Use to search for a term where the etc.
spelling is in question or there are

multiple possible spellings. "eipl* would match principle,

participle, etc.
Note: Use of the * wildcard character
near the beginning of a word will
slow searches somewhat.

ap*ed would match applied,
approved, etc.

% Fuzzy search. The number of % ba%nana:
characters you add determines the
number of differences the search
engine will ignore when searching
for a word. The position of the %
characters determines how many b%%anana:
letters at the start of the word have
to match exactly.

Word must begin with ba and have at
most one difference between it and
banana.

Word must begin with b and have at
most two differences between it and

banana.
# Phonic search. Phonic searching Put a # in front of the word in your
looks for a word that sounds like the | search request. Example: #smith will
word you are searching for and also find Smithe and Smythe.

begins with the same letter.
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Character Meaning Examples
~ Stemming. Stemming extends a Add a ~ at the end of words that you
search to cover grammatical want stemmed in a search.

variations on a word. ] . .
Example: apply~ also finds applying,

applies, and applied.

A search for fish would also find
fishing.

& Synonym search. Synonym Put a & at the end of the words you
searching finds synonyms of a word | want to use in your search request.

that you include in a search request. A search for fast& would also find

quickly.

8.3.1. Words and Phrases

To search for a phrase, use quotation marks around it, like this: "fruit salad"

If a phrase contains a noise word, the search engine will skip over the noise word when
searching for it. For example, a search for statue of liberty would retrieve any document
containing the word statue, any intervening word, and the word liberty.

Punctuation inside of a search word is treated as a space. For example:
e can't would be treated as a phrase consisting of two words: can and t.
e 1843(c)(8)(ii) would become 1843 c 8 ii (four words).

8.3.2. AND connector

Use the AND connector in a search request to connect two expressions, both of which must be
found in any document retrieved. For example, apple pie and poached pear would retrieve any
document that contains both phrases.

A search for banana and pear w/5 grape would retrieve any document that (1) contains
banana, AND (2) contains pear within 5 words of grape.

8.3.3. OR Connector

Use the OR connector in a search request to connect two expressions, at least one of which
must be found in any document retrieved. For example, apple pie or poached pear would
retrieve any document that contained apple pie, poached pear, or both.

8.3.4. W/N Connector (Proximity Search)

Use the W/N connector in a search request to specify that one word or phrase must occur
within N words of the other. For example, apple w/5 pear would retrieve any document that
contained apple within 5 words of pear.

The following are examples of search requests using W/N:
e apple or pear w/5 banana
e apple w/5 banana w/10 pear

e apple and banana w/10 pear
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The xfirstword term is useful if you want to limit a search to the beginning of a file. For
example, apple w/10 xfirstword would search for apple within 10 words of the beginning of a
document.

8.3.5. NOT and NOT W/Number (Proximity Search)

NOT allows you to exclude documents from a search. For example: apple sauce AND NOT
pear would return all documents with term apple sauce but exclude any that had pear.

NOT standing alone can be the start of a search request. For example, NOT pear would
retrieve all documents that did not contain pear.

If NOT is not the first connector in a request, you need to use either AND or OR with NOT such
as apple OR NOT pear or NOT apple w/5 pear.

The NOT W/ ("not within") operator allows you to search for a word or phrase not in association
with another word or phrase. For example: apple NOT w/20 pear.

Unlike the W/ operator, NOT W/ is not symmetrical. That is, apple NOT w/20 pear is not the
same as pear NOT w/20 apple. In the apple NOT w/20 pear request, it searches for apple and
excludes cases where apple is too close to pear. In the pear NOT w/20 apple request, it
searches for pear and excludes cases where pear is too close to apple.

CAUTION: “NOT” cannot be used in conjunction with the search parameter “Folder name”. For
example, Folder name contains “not procedures” is not a valid search string.

8.4. SIMPLE SEARCHES (FULL TEXT SEARCH)

Simple Search (also called full text searches) in FileHold uses a “Google-like” toolbar to return
full-text search results. FileHold has the ability to recognize, index text and allows users to
search content of all your favorite document types including PDF, Microsoft Office, Zip and
many more. When searching using the full text search, the system searches both the metadata
associated and the content of the document for matches. Full text search is particularly useful
for general searches of files stored in a records management system. For example, searching
the system for all files that make reference to Sarbanes Oxley.

There are three locations where you will find the Simple Search screen:

e Click Search in the Library hierarchy. The simple search form that appears allows users to
search the contents of the entire documents management system using the full text search
engine.

e The Search field located in the top right hand corner of the FileHold Desktop Application
user interface.

I Help User: Reree Sauwe }-:

Search Advanced @

e In afolder view of the Web Client.

I - -

The search results returned have a relevance ranking. The relevance value (expressed as a
percentage) is an approximation of how close the document is to the search criteria.
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TO DO A SIMPLE (FULL TEXT) SEARCH

1. Inthe simple search bar, enter the search term and click Search. The search results are
displayed.

8.5. ADVANCED SEARCHES

Advanced Search allows you to search by specific metadata fields and other system recorded
information about the document.

Users can combine searches in order to filter results. Users can also choose to search by
metadata only, search the archive, include all versions and search using historical metadata
fields by checking the boxes at the bottom of the advanced search form.

The parts of an advanced search include:

e Metadata Field Selector — Allows users to select the metadata field they want to search the
document management system with.

e Search Operator Selector — Allows users to select an operator to accompany a selected
metadata field. The list of operators are Equal to, Between, Greater than >, Less than <,
Greater than or equal to >/=, Less than or equal to </=, In the list, or Is Blank. The list of
available operators is dependent on the type of Metadata field selected. See Search
Operator Selectors for more information.

e Search Criteria Value Select — Allows users to enter a specific search criteria based on the
metadata field and operator selected. The value field is based on the type of metadata field
selected. By default there is only one value field for each operator. The only exception is
the “between” operator that allows users to search between two values such as dates or
numbers.

e Add or Remove Search Rows — The [ - ] and [ + ] buttons to the right of each row allow
users to remove or add (respectively) rows from the search criteria. Multiple search rows
are joined automatically joined using the AND operator. Up to 10 rows can be used.

Metadata field Search Search criteria Adds or
selector operator value removes Advanced search
selector I search rows options

| Z

Advanced Shlfch * * Saves advanced
m$| B search search options

" Search Metadata Only [ Include archive in Search [ Include All Document Yersions | Search Using Historical Metadata Fislds (5] ?

TO ACCESS THE ADVANCED SEARCH FORM

e From the 'Search and Saved searches' simple search, click the Advanced link to the right
of the search button.

e To access the advanced search from the folder of the document management system
view, click on the gray down arrow to the right of the search field icon in the top right corner
of the folder view.

Advanced Search

e Clicking on a Saved Search.
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e Right-clicking on the file structure and selecting Search. Remember that the search will
automatically be set to start at the library, cabinet, drawer, folder group of folder level
depending on where the user right clicks.

TO DO AN ADVANCED SEARCH

1. Inthe Advanced Search screen, use the following table to build search queries. You can
use up to 10 search filters to build the search query.

Search Description Available search
option operator selectors
File Or Allows users to add a full text search value to Contains in FTS
Metadata their metadata search criteria. This hybrid Does not contain in ETS
approach can be used to combine the best
aspects of full text and metadata only
searching. The same full text search operators
apply to this field as in Full Text Searching.
Document Searches the system for a file by the name in Contains in FTS
Name the search criteria.

Does not contain in FTS
Contains in DB

Does not contain in DB
Equals

Does not equal

e Approval Date (for workflow)

Checked Out Search by the checked out status of: Equals
Status e Checked In
e Checked Out
Person Allows users to search by: Equals
¢ Owned By Me Does not equal
¢ Owned By Someone Else In the list
e Checked Out By Me . _
« Checked Out Be Someone Else Not in the list
File Date File Data menu allows users to search by: Equals
e Date Last Modified Not Equals
e Creation Date In the List

Not In the List
Between

> (greater than)
< (less than)

>= (greater than or equal
to)

<= (less than or equal to)
At least

No older than
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Search Description Available search
option operator selectors
Workflow Search by the workflow status of: Equals
Status >
Approval e Approved Does not equal
Status * Pending Approval In the list
e Not Approved _ _
 Not Submitted for Approval Not in the list
Workflow e Approval Postponed
Status > Search by the workflow review status of:
Review Status
¢ Reviewed
e Pending review
e Not submitted for review
Library Allows users to restrict searching to a specific Equals
Location cabinet, drawer, folder group or folder in the

document management system.

Does not equal

Document Log
Action

Search for documents that have been checked
out, downloaded, checked in, copied, moved,
archived, viewed, printed, published, added,

Equals

Does not equal

linked, emailed, etc. In the list
Not in the list
Document Log | Search for documents that have had actions Equals

Date

performed on them within a date or date range.

Does not Equal
In the List

Not In the List
Between

> (greater than)

< (less than)

>= (greater than or equal

to)

<= (less than or equal to)

At least

No older than

Special Fields

Folder name — Search using part of a folder
name when the “Contains” operator is
selected. Note that no wildcards or dtSearch
keywords can be used for this option.

Contains in DB

Does not contain in DB

Equals

Does not Equal
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Search
option

Description

Available search
operator selectors

File Type — The File Type extension list is

dynamically updated and sorted alphabetically.

A new file extension entry is dynamically
added to the initial standard list upon adding a
document with a new file extension for the first
time. The list is not updated in FDA until the
user logs in and out. Multiple file extensions
can be selected when the qualifier is set to “In
the list”.

Equals

Does not equal
In the list

Not in the list

FileHold ID — The unique ID number given to
every version of a document. See Entering
Metadata.

Equals

Does not Equal
In the List

Not In the List
Between

> (greater than)
< (less than)

>= (greater than or equal
to)

<= (less than or equal to)

Document Control No. — Specialized metadata
field used to track specific document
numbering requirements.

Contains in FTS

Does not contain in FTS
Contains in DB

Does not contain in DB
Equals

Does not equal

Version Control No. — Like document control
numbers, used to track specific document
numbering requirements.

Contains in FTS

Does not contain in FTS
Contains in DB

Does not contain in DB
Equals

Does not equal

Has Markup — User can find documents that Equals
have been "Marked Up" using the Brava

Viewer Markup Tool.

Has Link — Users can find all documents that Equals
have been linked with other documents.

Is Favorite — Provides a list of documents that | Equals

are marked as favourites.
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Search Description Available search
option operator selectors
Document Format — Select Electronic Equals
Document, Electronic Record, or Offline Does not equal
Document type. q
Common MD | Allows users to search by common metadata Depends on metadata
(metadata) fields —i.e. “Customer Name”. The list of field type. See Search
Fields possible metadata field options is customized Operator Selectors for
based on how the library administrator has more information.
defined the document classification standards
for the FileHold server.
Search by Allows users to restrict their search by Equals
Document document schemas and the associated Does not equal
Schema metadata. The list of possible document q
schemas and associated metadata fields is In the list
customized based on how the library . .
administrator. Not in the list
Search by Depending on the document schemas Depends on metadata
Metadata Field | selected, the associated metadata fields are field type. See Search
Name available to search by. Operator Selectors for
more information.
2. Select any of the following advanced search options:

Search Metadata Only — Searches the metadata only and not the contents of a document
(full-text search).

Include Archive in Search- Searches the documents in the Library archive and includes any
matches in the results. FileHold will search only the Library (current documents) if this
option is not selected.

Include All Document Versions - Searches all versions of the document. FileHold will only
search the latest version if this option is not selected.

Search Using Historical Metadata Fields - If metadata field names and values have been
changed over time, you can still search these "historical" items as FileHold keeps track of
any changes that have been made.

3. The above options can be saved by clicking the Save =l icon so they are kept for every
advanced search performed.
4. Click Search. The search results are returned. You can continue to add or modify the

8.6.

advanced search criteria, save the search, or export the results to a CSV file.

SEARCH OPERATOR SELECTORS

The available search operator selectors are:

April 2017

Contains in FTS— Searches the full text search index which includes the metadata,
document name, file properties, and contents of the document and contains an exact
match of the value.

Does not contain in FTS— Searches the full text search index which includes the metadata,
document name, file properties, and contents of the document and the value is not present.

Hold .



FileHold 15.2 End User Guide

e Contains in DB — Searches only the metadata and contains an exact match of the value.
The contents of a document are ignored (full text search index).

e Does not contain in DB — Searches only the metadata and the value is not present. The
contents of a document are ignored (full text search index).

e Equals — Matches the specified value.

e Not equal — Does not equal the value specified.

e Is Blank — The value has been left empty (blank).

e Below — Matches anything below a certain level in a drill down menu type field
e > (greater than) — Is larger than the specified value.

e < (less than) — Is less than the specified value.

e >=(greater than or equal to) — Is larger than or equal to the specified value.

e <= (less than or equal to) — Is less than or equal to the specified value.

e Inthe list — Matches all values entered in the list. Multiple values are separated by
commas.

e Not in list — Show all documents that do not match the values entered in the list. Multiple
values are separated by commas.

e No older than x number of days before now — The document is not older than x days before
today. In other words, 5 days old or less.

e Atleast x number of days older than now — The document is x many days older than the
specified date. In other words, show everything prior to the last 5 days.

e Between - Search for values that are within a set of values, given the minimum and
maximum values.

The following table describes the type of search operator selectors that are available for each
metadata field type:

Metadata Field Type Available search operator selectors

Text Contains in FTS, Does Not Contain in FTS,
Contains in DB, Does not Contain in DB,
Equals, Not Equals, Is Blank

Drill down menu Contains in FTS, Does Not Contain in FTS,
Contains in DB, Does not Contain in DB,
Equals, Not Equals, Below, Is Blank

Drop down menu (FileHold managed and Contains in FTS, Does Not Contain in FTS,

database lookup) Contains in DB, Does not Contain in DB,
Equals, Not Equals, In the List, Not in the
List, Is Blank

Date Equals, Not Equals, In the List, Not In the

List, Between, > (greater than), < (less than),
>= (greater than or equal to), <= (less than
or equal to), At least, No older than

Number / Currency Equals, Not Equals, In the List, Not In the
List, Between, > (greater than), < (less than),
>= (greater than or equal to), <= (less than
or equal to), Is Blank
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Metadata Field Type Available search operator selectors
Checkbox Equals
URL Contains in FTS, Does Not Contain in FTS,

Contains in DB, Does not Contain in DB,
Equals, Not Equals, Is Blank

TIP: For multiple selections in lists, select the check box next the value name.

8.7. SAVED SEARCHES

You can save your advanced search templates as a Saved Search. Every time the search is
invoked any new documents that meet the query are brought into the results view.

Saved searches can be made personal or public. An Administrator can create "Public Saved
Searches". Public saved searches can be made available to all users or can be assigned
security rights so that only certain groups and users can use the public saved search.

Personal searches saved by the user are called My Saved Searches. These personal saved
searches can only be used by the user that created them.

There are three types of saved searches:

Reqular saved search — The search template is saved with all of the search criteria
including operators and values for the selected criteria.

Quick search — The search template is saved with only one empty variable in the template.
When a user runs a quick search, they are required to enter the search term for the empty
variable while all other search criteria remain fixed.

Empty search — The search template is saved with empty values for all the search criteria.
The user is forced to enter the values prior to running the search.

A default view can be set for each type of saved search so that the search results appear with
the correct columns and metadata information.

8.7.1.

Regular Saved Searches

A regular saved search repeats a pre-defined search when invoked. All of the set values and
operators in the template are used in the search.

TO SAVE A REGULAR SAVED SEARCH

1
2.
3.

April 2017

After performing an advanced search, click Save as Saved Search.
In the My Saved Searches window, enter a Name for the search.

If you want to make the search accessible to other users, select the Make this saved
search public check box (available to administrators only).

If this is a public saved search, click Next. Select the groups and/or users that can use this
public Saved Search and click Add. Public saved searches can only be created by library
administrators or higher roles.

Click OK. The Saved Search name is now in the Library hierarchy under Search > My
Saved Searches or My Public Saved Searches with an icon gl
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8.7.2.
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TO USE A REGULAR SAVED SEARCH

1. Click on the named of the saved search in the My Saved Search or My Public Saved
Searches area.

2. The results of the search are displayed. You can modify the search query by adding,
changing, or removing any of the filters.

Quick Searches

Quick searches are a type of saved search that allows you to leave a single variable in the
advanced search template empty while all other variables remain fixed. When a user runs a
quick search, they are required to enter the search term for the empty variable that was set up
in the template. The search results that are returned meet all advanced search criteria plus the
quick search term the user entered.

Quick searches are useful for conducting searches in Mobile FileHold since search terms
cannot be entered for regular saved searches (non-quick type saved searches). Quick
searches can be made private or public by administrators just like regular saved searches.
Public saved searches can be made available to other users while personal saved searches
are only available to the individual that created them.

If a quick search has been set up and configured to be used in conjunction with a FastFind
search, then this search cannot be deleted. See FastFind for more information.

A quick search can be integrated for use with external applications. See Integrating FileHold
Search with External Applications for more information.

CAUTION: Search variables with an operand of Owned by Me, Checked out by Me, and the
operator “Is Blank” cannot be used in quick searches.

TO CREATE A QUICK SEARCH
1. After performing an advanced search, click Save as Saved Search.

2. Inthe Save this Search window, enter a Name for the quick search or overwrite an existing
search.

3. If you want to make the search accessible to other users, select the Make this saved
search public check box (available to administrators only).

4. Select the Quick Search Condition check box and select the search variable that you
want a user to be able to enter a search term for.

5. If thisis a public saved search, click Next. Select the groups and/or users that can use this
public Saved Search and click Add. Public saved searches can only be created by library
administrators or higher roles.

6. Click OK. The Quick Search name is now in the Library hierarchy under Search > My

Saved Searches or My Public Saved Searches with an icon I;:]

TO USE A QUICK SEARCH

1. Click on the name of the quick search in the My Saved Search or My Public Saved
Searches area.

Enter a value for the single search term and click Search.

The results of the search are displayed. You can view or modify the advanced search
query by clicking on the Advanced link in the header.
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8.7.3. Empty Search Templates

When an advanced search is saved, all of the search criteria values can be left empty. This will
force the user to enter the search values and click Search once the saved search is selected.
This differs from regular saved searches which stores the search values in the template and
runs the query automatically.

TO CREATE AN EMPTY SAVED SEARCH
1. After performing an advanced search, click Save as Saved Search.

2. Inthe Save this Search window, enter a Name for the quick search or overwrite an
existing search.

Select the Make this saved search empty check box.

If you want to make the search accessible to other users, select the Make this saved
search public check box.

5. If thisis a public saved search, click Next. Select the groups and/or users that can use
this public Saved Search and click Add. Public saved searches can only be created by
library administrators or higher roles.

6. Click OK. The Empty Saved Search name is now in the Library hierarchy under Search >
My Saved Searches or My Public Saved Searches with an icon gl

TO USE AN EMPTY SEARCH

1. Click on the name of the empty saved search in the My Saved Search or My Public Saved
Searches area.

2. Enter the values for the search terms and click Search. The results of the search are
displayed.

8.8. USING FASTFIND

FastFind is an optional feature that can search third party applications using hotkeys and return
the search results in FileHold. Users can use keyboard shortcut shortcuts that perform
searches directly from the chosen application in the document management system to find
relevant data instantly.

Once FastFind is enabled you can use the hotkeys in any third party application. The pre-
defined hotkeys are:

e Mouse search (Alt+S) — Activates an on-the-fly screen scraper. When this is done a green
bar appears in the bottom-left corner of the user’s desktop screen. Users can now start
moving their mouse over screen form objects such as data fields or field labels. The text
under the current mouse position is captured and displayed in the green bar. If a user
wishes to search with the captured text they may left click to invoke the FileHold search.
This initiates the Full Text Search and Metadata search in FileHold and the search results
are displayed within the standard search results screen. Pressing the ESC button at any
time will stop the mouse search mode.

e Selection search (Ctrl+D) - Selection Search is similar to the Clipboard Search (and in fact
is using Clipboard Search as its internal mechanism), however, it uses a one step process
to initiate the search after a user highlights their selection on a business application form or
as a part of the content of a document opened in a 3rd part application. Invoking Ctrl+D is
all that is needed to initiate search and display results within FileHold application.
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e Clipboard search (Alt+C) — Users can copy any text from the screen to the Windows
clipboard using traditional “Copy” menu option or the Alt+C shortcut available in most
Windows applications and then by pressing the Alt+C combination they can activate the
Full Text Search and Metadata search in FileHold and the search results are displayed
within FileHold on the standard search results screen.

e Enable screen OCR search (Alt + F) — Allows you to do a search based on the Click to Tag
functionality. Once the shortcut key is invoked, you can click on the text on the screen or
draw a bounding box around the text. Then a search is performed in FileHold to meet the
selected criteria from the screen.

Since FastFind uses the contents of the clipboard any string displayed on the screen which can
be copied to the clipboard (similarly to when using the well-known Cut/Paste sequence in
Windows), it can be used as the search criteria including partial highlights of the text strings.

FastFind searches can be based on a full text search (file and metadata search) or a quick
search. If based on a quick search, it will only search on that specific search parameter and
nothing else in the system (unlike a full text search which will search through everything).
Advantages of using up a quick search with FastFind would be to be able to limit the search
results. For example, if FastFind was only used to locate an invoice in FileHold from your
accounting software, the search results would be limited to what documents would be found
using “Invoice Number” quick search. See Quick Searches for more information on configuring
quick searches.

FastFind must be a purchased option and enabled before the feature will work. You can also
create your own FastFind templates that work with the system. See the Knowledge Base for
more information.

TO ENABLE FASTFIND

1. Goto File > Preferences and Settings > FastFind Preferences and select the Enable
FastFind check box. See more information about FastFind preferences.

2. Click Apply and then OK.

8.9. SEARCHING FOR PREVIOUS VERSIONS OF A DOCUMENT

For system performance reasons, only the most recent version of the document is included in
the search scope. However, users can use the advanced search setting to include all versions
of documents (most recent and all previous) stored in the document management.

TO SEARCH FOR A PREVIOUS VERSION OF A DOCUMENT

1. Inthe Advanced Search, select the Include All Document Versions check box.

Advanced Search

File or Metadata b E Search

[7] search Metadata Only  [] Indude Archive in Search | Incude All Document Versions ||:| Search Using Historical Metadata Fields

8.10. SEARCHING FOR DOCUMENTS IN A WORKFLOW

You can refine your search criteria to search for documents based on their approval status.
Using Advanced Search, the user can select the Approval Status metadata field for any
document schemas as long as that schema has at least one workflow template associated with
it that contains at least one approval activity. Use the Approval Status select box to choose

. € FileHold

April 2017


http://www.filehold.com/help/home

End User Guide FileHold 15.2

whether or not the file being searched for is approved or rejected. The Approval Status field
can be used in combination with any other metadata field criteria for searching.

NOTE: If the workflow has NOT been set to hide the file until approval is complete, the file will
be able to be seen by all users with access to the document. If the workflow is set to hide the
document until approval then it will not be able to be seen by users who are not participants in
the workflow instance. All users will be able to see the file once it is approved and the workflow
completed.

TO SEARCH FOR A DOCUMENT BASED ON APPROVAL OR REVIEW STATUS
1. Goto Advanced Search.

2. Click File or Metadata and select Workflow Status and select either Approval Status or
Review Status.

3. Inthe search operator selector, select one of the following: Equals, Does not equal, In the
List, Not in the list

4. In the search criteria value field, select an option from the drop down list. For "in the list" or
"not in the list" search operator selectors, use the check boxes to select multiple values.
For approval status searches, the following options are available: Approved, Pending
Approval, Not Approved, Not Submitted for Approval, or Approval Postponed. For review
status searches, the following options are available: Reviewed, Pending Review, or Not
Submitted for Review.

5. Add any other search criteria to the advanced search and click Search.

8.11. INTEGRATE FILEHOLD SEARCH WITH AN EXTERNAL APPLICATION

A saved quick search can be invoked through an URL address from an external application.
Once the URL is clicked, the search results are displayed in the Web Client. A quick search is
a type of saved search where the search template is saved with only one empty variable in the
template. When a user runs a quick search, they are required to enter the search term for the
empty variable while all other search criteria remain fixed.

A simple tool has been provided for users that do not want to build the URL manually. When a
quick search has been created and saved, the URL for the quick search can be created with
the URL Builder in the Web Client. In the URL Builder, the server address, the client type (Web
Client or Portal Web Client), log in type (local or Active Directory user), Ul type (normal, locked
or XML), and the quick search value are specified and a URL is generated.

The Ul type options determine how the search results are displayed:
¢ Normal means that the results are displayed in the normal Web Client UL.

e Locked means that the search results are displayed in an embeddable locked view of the
web client where only the heading and the document list is found. There would be no
processing options, though one of the columns in the search results could be a link to the
document for web viewing or downloading. Additional settings are available for modifying
the title bar and page numbering in the search results screen when using this option.

e XML means that the search results are returned as an XML document. This can be
combined with an XSL style sheet or some other XML processing method to render the
precise output the caller desires. The column heading names and column values would be
included in the XML as defined in the search view. The XML output include the document
ID which can be used to build links for viewing or downloading the documents.

Once the settings for the URL are defined, the URL can be generated. The URL defines the
quick saved search name and value(s) for the quick search. For example:
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http://<servername>/fh/filehold/webclient/gsearch.aspx?name=<quick sea
rch name>&value=<search value>

Where:
e <servername> is the name of the server where FileHold is installed
e <quick_search_name> is the name of the quick saved search

e <search_value> is the operand value that is used for the search. If more than one value is
needed, values can be delimited with a ; (semicolon).

Once the URL for the quick search is clicked from an external application, the saved quick
search runs and displays the search results in the selected Ul type option. If the user is not
logged in, the login screen appears first or the user will be logged in using Windows
Authentication (single sign on).

The quick saved search can have the default view defined so that the desired information is
displayed in the search results every time the URL is clicked.

Here is a basic example of how it might look on company’s web site. For this example, the URL
is specified in an iframe with the Ul type in locked mode.

<iframe
src="http://yourservername/FH/FileHold/WebClient/gSearch.aspx?name=Doc
+Name&value=fh*&ui=lock" width=600 height=400>

) FileHold ; x [ testSearchUrl htmil »
FileHold [ . .
O //Co/Projects/testSearchUrlhtml

This example uses an iframe to msert the search results mto another web page

Search Results 1-5 of 5

Docurment

Document name Location Linked

schema

This 15 my web page!

Using the Ul Type option that returns XML, the page can be formatted how you want if XML
can be interpreted on your website.

The return page for the Web Client can be manually entered to include a returnPath parameter.
For example, the user can be returned to the Add Document Wizard:

http://yourservername/FH/FileHold/WebClient/gSearch.aspx?name=d dlm eq
t&value=2014-09-05&ui=lock&returnPath=AddDocumentWizardForm.aspx
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If you are using the Ul in Lock mode, the returnpath can also be entered in the web.config file
in C:\Program Files\FileHold Systems\Application Server\WebClient under the <appSettings>

area:

<add key="gSearch ReturnPage" value="Search ReturnPage PLACEHOLDER" />

If a value is entered, it is the default place the return button will take the user. If the path is not
fully qualified, it is relative to the FileHold server.

» Hi| 1300 TISATH

Detaimai Dt

Lasl Modificd On
10 B30 & 13100 P

Linked Vor Seius

Baard Marwlos o
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L

@ % scanned_pde_bel Bucesrd Mlrsubes- 20 4 1 Oxchobesr § D186 Board bnaifes L 1 Creckedin 10620 8 74533 PM
L : margement meetng W 114 Morearnber § D A b e 1 Creched 18 173505 aM
@ TE everiy ipiw- 201 4 | Mervamber | D=3 Apphe alion i Crached i

To make the Return button invisible, set the value for gSearch_ReturnPage key in web.config
to empty. For example:

<add key="gSearch ReturnPage" value="" />

To cREATE AN URL TO RUN A SEARCH FROM AN EXTERNAL APPLICATION

Create a quick search and save it as public saved search. Ensure you assign the correct
permissions to the saved quick search.

In the Web Client > Public Saved Searches area, right-click on the quick search name and
select URL Builder.

In the URL Server Part field, enter the path to the FileHold server.

In the Client Type area, select if the link is accessed through the Web Client or the Portal
Web Client (guest portal).

In the Login Type area, select if the user is logging in using a username and password, or
using single sign on (Active Directory integration). Note that if you are not using Active
Directory integration, the single sign on option will not be available.

In the Ul Type area, select if the results are displayed in normal (Web Client), locked
(embedded locked mode) or XML (highly customizable mode).

If Locked Ul mode was selected, fill out the following information:

e Select the Disable title bar check box if you do not want the Search by URL title bar
displayed in the search results.

e Enter a Custom Title bar if needed such as "Documents to be approved". The default title
is "Search by URL".

e Select the Disable summary bar if you don’t not want the number of search results
displayed. For example, "Search Results 1-10 of 52",

e Select the vertical position of the page numbers in the Page Bars Vertical Position drop
down: Top, Bottom, or Top and Bottom.

e Select the horizontal alignment of the page numbers in the Page Bars Horizontal Alignment
drop down: Right, Left or Center.
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8. In the quick search parameter area, enter the value to be searched on Click Generate
URL.

9. Inthe URL Builder Result area, the URL address is displayed. Click Go To Link to test the
link.

10. Once the link is verified and working, copy and paste the link into the external application.
Note that there is no way to save this link so you will need to copy and paste it into a
Notepad file or similar to retain the link address.

In the example below, a quick search on Approval Status was created with the search value
set to Approved. The resulting URL is:

http://QA-
STD2008X64:7077/FH/FileHold/WebClient/gSearch.aspx?name=quick+approval
+statusé&value=Approved

e

URL Builder Properties '@'

URL Server Part ittp: (G- S TOR2008 K E4: 707 7/FHIFileHold!
Clierit Type ® ek Cliert O Portal Wb Cliert
Login Type = Normal Single Sign On

Ui Typs ® pormal O Locked O WML

Guick Search - quick approval status

Approved Generate LIRL

URL Builder Result

URL Address [ Fttp: 42 -STD200BXE4: 7077 FHFileHoldiebCliertigSearch.aspx ?name=guick+apy | Gato Link |

Note: The number of search results displayed on a page is set in the View Preferences for the
Search Results view.
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9. VIRTUAL FOLDERS

A virtual folder does not contain the actual document; it only holds a pointer back to the
document. All virtual folders are private (i.e. unique to the user) unless they are made public.
Public virtual folders can be seen by users with the correct permissions to the documents.

e Regular Users can create virtual folders for their own use. They cannot be made public.

e Library administrators or higher roles can create virtual folders and make them private or
public. Public virtual folders are seen by all users that are given access. Users with access
to a virtual folder will still need the proper permissions to access any documents that are
listed.

e Users have access to Public (or shared) Virtual Folders in both the Web Client and
FileHold Desktop Application. These folders are created and populated by library
administrators to collect and disseminate documents to multiple users. Public Virtual
Folders are a perfect way for documents located throughout the FileHold library to be
displayed in one place for access by all users that are given access to by library
administrators who assign the membership when creating virtual folders. Library
administrators can change their personal virtual folders to public and back again.

Virtual folders can be deleted at any time. The documents contained in a virtual folder are not
deleted from the system. They will still be located in their original folder.

TO CREATE A VIRTUAL FOLDER

1. Right click on the Virtual folder section in the FileHold Desktop Application and select Add
Virtual Folder.

Enter the name for the Virtual Folder.
If you are a library administrator, you can set the folder as public or private.
Do one of the following:

e Click OK if a private folder.

e Click Next if a public folder.

5. If the Virtual Folder is a public folder, set the security to allow user access and click OK.

TODELETE A VIRTUAL FOLDER
1. Right-click the Virtual Folder name from the list and select Delete.

2. Click OK on the warning message to proceed with the deletion process.

TO ADD A DOCUMENT TO A VIRTUAL FOLDER

1. Select one or more documents that you want to add to a virtual folder. You can use the
SHIFT or CTRL keys to select multiple documents in the FDA. Check the box next to the
document name to select documents in the Web Client.

Right and select Send To > Virtual Folder.

3. Select the virtual folder to which you want to add the documents or create a new virtual
folder.

4, Click OK. The shortcuts to the documents will now be in the virtual folder.

e ALTERNATIVELY, you can drag and drop one or more documents into the virtual folder.

€ FileHold .
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TO REMOVE A DOCUMENT FROM A VIRTUAL FOLDER

1. Select one or more documents in the virtual folder that you would like to remove. You can
use the SHIFT or CTRL keys to select multiple documents in the FDA. Check the box next
to the document name to select documents in the web client.

2. Pressthe CLEAR button at the top of the file list to remove the documents from the virtual
folder. This will not delete the documents from the document repository.
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10.THE LIBRARY STRUCTURE

All files in FileHold software are stored under the library icon (root folder) shown in the file
structure located on the left hand side of interface.

Taking a closer look at the file structure you can see that the document management software
uses a real world metaphor for filing. The Library is filled with cabinets that contain drawers that
contain folder groups (optional) that contain folders. Only folders can contain documents.

= Library
-1 Cabinet
= (o) Drawer

==l FolderGroup
[ Folder1
|| Folderz
= (o DrawerZ
| Folder

NOTE: Documents are displayed as a list in the display pane to the right of the file structure.
Documents can be displayed by selecting the folder they reside in or by searching to gather
files from multiple folder locations.

Documents can only be stored in folders in the document management system. Folders can be
located directly within drawers or within folder groups.

Access to specific areas of the document management software is controlled by group and
user memberships at the cabinet and folder levels. Only users that are members of a cabinet
can see the cabinet to access its contents. Once inside the cabinet a user must also be a
member of the folders it contains in order to access files contained within the folder. If the user
is not a folder member they will not be able to see the folder. Users can see the membership
associated with a particular cabinet or folder by right clicking on the cabinet or folder and
selecting Properties. Once authenticated to access files inside a folder access to individual
document schemas is by schema membership. Users must be a member of schema in order to
view files associated with this document schema in the document management system.

NOTE: Users who are not members of a folder will not see the folder. To get access a user will
have to be added by the owner of the folder or a library or systems administrator.

Along with memberships at the cabinet and folder level, the document management software
system, maintains membership permissions by document schema. For example users in the
sales department can be restricted to only add, search for and access sales document
schemas (invoices, purchase orders and contracts) while users in the HR department can be
restricted to only add, search for and access only HR document schemas (expense reports,
vacation requests and performance reviews) even if they are located in the same folder. Only a
designated library administrator can change the membership associated with a document
schema. See setting up and managing document schemas for more information.

In addition to the membership in cabinets, drawers, folders and document schemas, access to
documents is controlled by roles that individual users are assigned to. All roles and their
related permissions are described on the user role page.

The document level permission icons indicate operations allowed for a given role or provide
some additional information regarding the statuses of the documents visible in the folder view.
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10.1. CABINETS

10.2.

10.3.

88

Only library administrators, senior library administrators, and system administrators can create
cabinets.

In order for a user to see a cabinet they must be a member of the cabinet. Only members of
cabinets can see and access its content. In order to manage the access to a particular cabinet,
the owner of the cabinet can add and remove member access and permissions. For more
information on cabinets, see the Library Administration Guide.

DRAWERS

Only cabinet administrators, library administrators, senior library administrators, and system
administrators can create drawers.

In order for a user to see a drawer they must be a member of the cabinet in which the drawer
resides. The availability of actions is dependent on the rights that users have to the cabinet that
the drawer resides unless further restrictions have been placed on the drawer by its owner, the
library administrator or the Systems Administrator. For more information on drawers, see the
Library Administration Guide.

FOLDER GROUPS

Folder groups are intended to be used as an extra layer of division in the Library structure but
their use is optional. Like drawers that divide cabinets into more manageable size; folder
groups divide drawers into more suitably sized portions. Folder groups contain only folders.

In order for a user to see a folder group they must be a member of the cabinet in which the
folder group resides. The availability of actions is dependent on the rights that users have to
the cabinet that the folder group resides unless further restrictions have been placed on the
folder group by its owner, the library administrator or the Systems Administrator.

The following actions can be performed on folder groups:

Action / Function What the Function Does Who Can Access the
Function
Open Folder Group Expands the folder group All users with access to the
revealing its contents. cabinet that the folder group
belongs to.
Search Allows users to restrict their All users with access to the
search to files located in the folder group.
selected folder group.
Properties Displays the folder group All users with access to the
Properties. folder group.
Set Default View Allows user to select a default | All users with access to the

view that has been created in | folder group.
the View Preferences.

Add Folder Allows user to add a folder to Users with Publisher or
the folder group. higher access.

Move Folder Group Moves the folder group to a Users with Organizer or
different drawer. higher access.

’ HOld April 2017



End User Guide FileHold 15.2

Action / Function What the Function Does Who Can Access the
Function
Copy Folder Group Makes a copy of the folder Users with Organizer or

group including all folders and | higher access.
files it contains.

Clone Folder Group Makes a copy of the folder Users with Publisher or
Structure group and the folders it higher access.
contains. Does not copy
documents in folders.

Delete Folder Group Deletes the folder group and Users with Organizer +
all items it contains. Delete or higher access.
Archive Folder Group Manually sends the contents Library administrator or
of the folder group to the system administrators only.
Library Archive.
Export Exports all documents in the Users with Organizer or
folders contained in the folder | higher access.
group.

TO MANAGE FOLDER GROUPS

1. Right-click on a cabinet and select Manage Folder Groups. The folder group list window
opens with a list of existing folder groups.

2. To add a folder group, click Add Folder Group.
3. Enter a folder group Name.

4. Select a weight for this folder group from -10 to 10. The lower the weight (such as -10), the
higher the folder group name appears in the Library. The higher the weight (such as 10), the
lower the folder group name appears in the list. Leave the weight at 0 if you want the folder
groups sorted alphabetically.

Folder Group List =
Add Folder Group
Folder Group Name Weight
Markesting
Support - Materials [v]
Support - Screenshots 0
Support - Training [}
5
Add Folder Group &J
Folder Group Name Support - Guides|

5. Click Save. The folder group name is added to the list.

TO ASSIGN A FOLDER GROUP TO A DOCUMENT FOLDER
1. Right-click on a folder in the Library and select Properties.

2. In the Folder Group field, do one of the following:

€ FileHold .
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e Select the folder group to which you want this folder to belong from the list.

e To create a new folder group, select Add a New Folder Group and enter the name in the
New Folder Group Name field.

3. Click OK. The folder is moved into the selected folder group.

TOEDIT OR DELETE A FOLDER GROUP NAME

1. Right-click on a folder group in the Library and select Properties.
2. Click Edit Folder Groups.

3. To edit a folder group name, double-click on a folder group.

4

. In the Edit Folder Group window, enter a new name for the folder group and a weight
(optional). The lower the weight (such as -10), the higher the folder group name appears in
the Library. The higher the weight (such as 10), the lower the folder group name appears in
the list. Leave the weight at O if you want the folder groups sorted alphabetically.

5. Click Save.
6. To delete the folder group, click Delete.

10.3.1. Calculating the Folder Group Statistics

10.4.

90

You are able to see how many folders, documents, humber of files and size of the repository
that are contained within a folder group by looking at the statistics.

TO CALCULATE THE FOLDER GROUP LEVEL STATISTICS
1. Right-click on a folder group in the tree structure and select Properties.

2. Inthe folder group properties window, click Calculate. The number of folders, files (latest
version), size (in MB), files (all versions) and size of all versions (in MB) is shown. Click
Cancel to close the properties.

FOLDERS

Folders are the level in the library structure where documents reside. Documents can only
reside at the folder level. Only users that are members of a particular folder can access the
files that reside in that folder.

When a user with a role of Publisher or higher creates a new folder they must associate groups
(or users) with the folder in order to protect the contents of the folder from unauthorized users.
ONLY groups (or users) associated with a folder will see and have access to the folder.
Permissions can be further restricted once the groups or users are assigned as members.

The groups that are available to be members of the folder are inherited from the cabinet in
which the folder resides. If you wish to add groups other than the ones that appear in the folder
properties, the group must first be added at the cabinet level of the document management
system. After the group is added at the cabinet level, the new group will appear in the Available
FileHold Group listing in the folder properties security section.

Security on the folder can be modified using the advanced security option. You are able to give
a user or group a role that is less than what is already designated to them. For example, you
can modify a cabinet administrator’s role to reduce it to document publisher. If a group or
user’s permissions are modified using the advanced security option, a red dot appears on the
folder that has been modified when the user logs in.
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The availability of actions is dependent on the rights that users have to the cabinet that the
folder resides unless further restrictions have been placed on the folder by its owner, the library
administrator or the Systems Administrator. The following actions can be performed on folders:

Action / Function What the Function Does Who can Access the
Function
Open Folder Opens the folders and shows | All users with access to the
the files it contains. folder based on the folder
membership.
Search Allows users to restrict their All users with access to the

search to files located in the | folder.
selected folder.

Properties Displays the folder All users with access to the
properties. folder.

Set Default View Allows user to select a All users with access to the
default view that has been folder.
created in the View
Preferences.

Alert Me of Changes Subscribes the user to be All users with access to the

alerted when certain actions | folder.
are performed on the folder
by other users. The types of
actions that trigger alerts are
managed by the users Alert
Preferences. Users can
remove folder alerts from the
My FileHold; Document
alerts page OR select the
'Disable This Alert' option
from the folder menu.
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Action / Function

What the Function Does

Who can Access the

Function

Disable This Alert Disable the alert for the All users with access to the
folder. The user will no folder.
longer be alerted when
certain actions are
performed on this folder. Re-
activate the alert by clicking
on the 'Alert Me of Changes'
option in the folder menu.

Move Folder Moves the folder to a Users with Publisher or
different drawer or folder higher access that are the
group. folder owner.

Copy Folder Makes a copy of the folder. Users with Publisher or

higher access that that are
the folder owner.

Delete Folder

Deletes the folder and all
documents it contains.

Users with Publisher and
Delete or higher access that
are the folder owner. If the
user is Publisher and Delete
role they must be also be the
owners of all document
versions in the folder before
they can delete a document.

Clone Folder

Makes a copy of the folder
group and the folders it
contains. Does not copy
documents in folders.

Users with Publisher or
higher access.

Archive Folder

Manually sends the contents
of the folder group to the

Library Archive.

Library administrator or
system administrators only.

Export

Exports all documents in the
folders contained in the
folder group.

Users with Publisher or
higher access and that are
the folder owner.

TO CREATE A FOLDER

1. Inthe Library, right-click a drawer or folder group and select Add Folder.

2. Enter a Name for the folder.

3. Selectafolder owner for the list. Your permissions may be restricted to only allowing
yourself to be the owner of the folder.

4, Select a Default Schema from the list. The list of schemas will be only those that you have

access to.

Select a Folder Group from the list (if applicable).

Select a Weight for the folder. The lower the weight (such as -10), the higher the folder
name appears in the Library. The higher the weight (such as 10), the lower the folder name
appears in the list. Leave the weight at 0 if you want the folder groups sorted

alphabetically.
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7. Select a Color from the list. Options include: yellow (default), green, red, and blue. The
folder is displayed in the library tree in the selected colour.

Click Next.
In the Security tab, do the following:

In the Group By field, select how you want the available FileHold Groups displayed.

In the Available FileHold Groups area, select the groups you want to be able to access the
cabinet and click Add Groups. The group is added to the Current Members of Cabinet list.

In the Eligible Users in the FileHold Group, select the user you want to be able to access
the cabinet and click Add User. The user is added to the Current Members of Cabinet list.

To remove a user or group from the cabinet, select the name from the Current Members of
Cabinet list and click Remove Members.

To view all Groups and Users, click Group Members. A new All Groups/Users panel
opens on the right side of the window.

To see which user roles the user or group belongs to, select the user or group name in the
Current Members list and click Effective Permissions. The user role for that cabinet
member will appear in the Effective Permissions list.

To set advanced security options on a user or group, select the user or group hame in the
Current Members list and click Advanced Security Options. To modify the rights, select a
user role from the list and click Apply. To revert to the default user role, click Restore.
Note that if a group or user’s permissions are modified, a red dot appears on the folder that
has been modified when the user logs in.

Select the Inherit Security Permissions from Cabinet check box if you want to inherit the
security settings from the cabinet that the folder will reside. If you select this check box, you
cannot modify the members of the folder.

10. Click Next.

11. In the Auto-tagging tab, you can set the documents that are added to the folder to be
automatically tagged (metadata automatically added). See the section Creating Auto-
Tagged Folders for more information.

12. Click Save. The folder is added to the Library structure.
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TO EDIT THE FOLDER PROPERTIES

1. Right-click on a folder in the Library and select Properties. The folder properties window
opens.
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2. Make any changes to the folder properties and click Save.

TODELETE A FOLDER
1. Right-click on a folder in the Library and select Delete Folder.

NOTE: You need to have delete permissions in order to delete a folder.

2. You will receive a warning message. Click OK to delete the folder. The folder is removed
from the Library.

rWarn'lng &Jﬁ

You are about to delete a Folder. All items contained in this Felder shall
l % be deleted. This action cannot be un-done. Do you wish to proceed?

OK ] [ Cancel

TO COPY A FOLDER

1. To copy a folder, its security, and all of its contents including documents, right-click on the
cabinet and select Copy Folder.

2. Enter a name for the copied folder and click OK. The copied folder appears in the Library
hierarchy.

WARNING: Copying large folders and its contents will cause the FileHold server to consume
resources and may slow down the system. We recommend that you do this after business
hours if copying folders containing tens of thousands or many hundreds of thousands of
documents. The amount of time it will take to copy a folder and its contents is dependent on
the server hardware that powers the system; the faster the server hardware the better.

TO CLONE THE FOLDER STRUCTURE

1 To clone afolder, its security, and all of its contents including drawers, folders and folder
groups, right-click on the cabinet and select Clone Folder.

Select a destination in the Library for the cloned folder.

Enter a name for the cloned folder and click OK. The cloned folder appears in the Library
hierarchy.

NOTE: Cloning a folder does NOT copy the documents. Use Copy Folder to copy folders and
documents.

TO ARCHIVE A FOLDER

1. To send afolder and its contents to the Library Archive, right-click on the folder name and
select Archive Folder.

2. At the message prompt, click OK. The folder and its contents are moved to the archive.

o < Hold

April 2017



End User Guide FileHold 15.2

rWarning Lé]1

You are about to move the Felder to the Library Archive, This action
l % cannet be un-done. Do you wish to proceed?

oK ] [ Cancel

TOMOVE A FOLDER
1. Right-click on a folder and select Move Folder.

2. Select the destination location by navigating through the Library in the dialog box and click
OK. The folder is moved to the location.

TO SET THE DEFAULT VIEW FOR THE FOLDER

Administrators can create public views in the View preferences area and then assign the
default view to each folder. Users can create personal views and assign it to a folder.

1. Right-click on the folder and select Set Default View.

2. Clear the Inherit setting from parent container check box.
3. Select the view you want to use from the drop down list.
4

Click OK to save your settings.
10.4.1. Viewing the Folder Statistics

You are able to see how many documents, number of files and size of the repository that are
contained within a folder by looking at the statistics.

TO VIEW THE FOLDER STATISTICS
1. Right-click on a folder in the tree structure and select Properties.

2. Inthe folder properties window, files (latest version), size (in MB), files (all versions) and
size of all versions (in MB) is shown. Click Cancel to close the folder properties.

10.4.2. Creating Auto-Tagged Folders

When documents are added to the system, you need to set the document with metadata in
order to store it in the Library. Auto-tagging removes the manual step of setting the metadata
step out of the process. The metadata values to be automatically applied to all files placed in
the folder with auto-tagging configured. Auto-tagging on a folder is set on a document schema;
therefore, all files using that schema will use the predefined auto-tags.

Auto-tagging can be set at the cabinet or folder level. If some of the documents in the cabinet
or folder belong to a different schema type than what has been defined in the auto-tagging tab,
then the metadata will not be changed or overwritten.

When documents are added to a folder that is auto-tagged, they must follow the rule that is
defined and no changes can be made to that rule. For example, if the auto-tagging rule is set to
the Invoices schema, then no other document schema types can be added to that folder.

Auto-tagging rules are set up by the folder owner or higher roles.
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TO SET AUTO-TAGGING ON FOLDERS (OR CABINETS)

1.

When creating a new folder go to the Auto-Tagging tab or for an existing folder, go to
Folder Name > Properties > Auto-Tagging.

In the Auto-Tagging tab, select the Enable Auto-tagging check box to have all documents
in this folder automatically “tagged” with the same metadata based on the schema as they
are added to this cabinet. This assumes that all of the documents that are being added to
the cabinet have mostly the same metadata as all the other documents in the cabinet. This
ensures a highly compliant filing system and standardization across all documents within
the cabinet or folder. Users can select to have some standard repetitive metadata added
automatically, manually, or a combination of both.

Select the Make this the default auto-tagging settings for all folders in this cabinet if
desired if you are setting up auto-tagging at the cabinet level. This option is not available at
the folder level.

In the Auto-Tagging Metadata area, select the document schema and the metadata. You do
not have to set all the metadata fields; you can leave them blank for the user to enter them.

5. Click Save.

6. The folder with the auto-tagging rule has the letter “A” on the folder signifying that is being

automatically tagged.

EM) Liser Documentation - POF
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11.DOCUMENT ACTIONS AND FUNCTIONS

A variety of actions can be taken on individual document versions. Actions are accessible from
the contextual menu associated with a document by right-clicking on the document name.

The following actions can be performed on one or more documents at a time. The availability of
actions is dependent on the rights that the user has.

Action /Function

Description

Permissions needed

Open (FDA only)

Opens the selected
document in its native
application.

All users with access to the
document.

Open in Brava viewer (FDA
only)

Opens files in the Brava
document viewer. This
option is only available if the
Brava viewer is installed and
licensed for the user.

Users that have been
assigned a Brava viewer
license. Starting in 2017,
Brava viewer licenses are no
longer available for new
FileHold purchases.
Previously purchased Brava
viewer licenses are still
available for use in the
FileHold Desktop
Application.

Open in PDF/Image viewer
(FDA only)

Opens the document in the
PDF/Image Viewer.

All users who have been
assigned a FileHold level 1
or level 2 viewer license.

Open in FileHold viewer
(both FDA and Web Client)

Opens the document in the
FileHold Viewer.

All users who have been
assigned a FileHold level 1
or level 2 viewer license.

Make a Local Copy (FDA)
Get a Copy (Web Client)

Creates a copy of the
document to the user’s local
machine. The copy is
automatically sent to the My
FileHold Documents folder.

All users with access to a
file.

Check Out This Document
(FDA)

Check Out (Web Client)

Checks out the document
and downloads it to your
working directory which is
typically My FileHold
Documents folder.

Users with document
publisher rights or higher.

Check In This Document
(FDA)

Check In (Web Client)

Checks documents back in
the system and opens the
'lock" on the document.
Documents that are checked
in are given a new document
version number.

Users with document
publisher rights or higher.
However, only the user that
has checked the document
out of library OR the library
system administrator may
check it back in.
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Action /Function

Description

Permissions needed

Workflow > Initiate workflow
template name (FDA)

Initiate Workflow > Workflow
template name (Web Client)

Allows you to select the
workflow template name
from the list and start a
workflow. Selecting more
than one document will start
a multiple document
workflow.

Users with Document
Publisher rights or higher
and is owner of the
document.*

*Unless the ‘Allow non
document version owner to
initialize workflow”
permission setting is
enabled.

Workflow > View Sign-Off
Sheet

Listing of all users that either
approved or rejected this
version of the document,
when they did it and if they
signed-off on behalf of
someone else.

Users that are participants or
observers in a workflow.

Workflow > View Review &
Approval History

View the history of
comments for a workflow.

Users that are participants or
observers in a workflow.

Workflow > Cancel Workflow

Cancels a workflow in
progress.

Initiators of a workflow or
library administrators or
higher.

Workflow > Submit Approval

Allows you to approve a
document.

Users assigned to perform
an approval task in a
workflow.

Workflow > Submit Review

Allows you to submit a
review on a document.

Users assigned to perform a
review task in a workflow.

Courier > View transmission
status

Displays the Courier
transmission report for the
document.

Senders of the transmission
and cabinet administrators or
higher role and are owners
of the cabinet.

Courier > Initiate <Courier
template name>

Select the Courier template
name from the list and start
a Courier transmission.

Anyone with a document
publisher role or higher and
has permission to use
Courier.

Metadata and File Properties

Displays the Metadata and
file properties for a file stored
in the documents
management software.

All users with access to the
folder the document is in.

Edit Metadata

Displays the Metadata and
file properties for the
selected files and allows you
to edit the metadata en
masse.

Users with document
publisher rights or higher.

Link Documents (FDA)
Link (Web Client)

Displays the Create Links
window to link the selected
documents together.

Users with document
publisher rights or higher.
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Action /Function

Description

Permissions needed

View Linked Documents

Displays all documents that
are linked to a selected
document.

All users with access to the
folder the document is in.

Redact Document (FDA
only)

Sends a file to the Brava
viewer so that the user may
redact (black out) portions of
the text before sharing for
security reasons.

Users with a Brava viewer
license who have the role of
Document Publisher or
greater. Starting in 2017,
Brava viewer licenses are no
longer available for new
FileHold purchases.
Previously purchased Brava
viewer licenses are still
available for use in the
FileHold Desktop
Application.

Send to > Document Tray

Send a document to the
Document Tray.

All users with read only or
higher.

Send to > Virtual Folder

Send a document to a Virtual
Folder.

All users with read only roles
or higher.

Send to > Local Folder (FDA
only)

Downloads a copy of
document to a folder on your
local computer. You can
browse to where you want
the document downloaded.

All users with read only roles
or higher.

Send to > Export (FDA only)

Exports the documents to
your local computer in their
native format and a XML file
containing the metadata,
schema, and library location
for the selected documents.

All users with document
publisher roles or higher
unless restricted by
administration.

Send to > Email

Emails the document as an
attachment or a link to the
document in the document
management system.

All users with read only roles
or higher unless restricted by
administration.

Send to > Email and Check
Out

Emails the document as an
attachment or a link and
checks out the document at
the same time.

All users with document
publisher roles or higher.

Send to > Library Archive

Sends the document to the
Library Archive.

All users with Library
Administration or higher
unless restricted by
administration.

Send to > Printer (FDA only)

Send the document to your
printer. This function is
available if enabled and user
has a viewer license.

All users with document
publisher roles or higher
unless restricted by
administration.
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Action /Function

Description

Permissions needed

Send to > Existing Workflow
(Web Client only)

Add to Existing Workflow
(FDA and Web Client)

Adds a main or supporting
document to an existing
workflow.

Users with Document
Publisher role or higher.
User must have access to all
added documents and be
owner of the document
version when adding main
documents.

Publish As Allows users to convert All users with document
documents in FileHold to publisher role or higher
PDF, TIFF, DWF or CSF. unless restricted by
This function is available administration. Starting in
only if you have the Brava 2017, Brava viewer licenses
viewer. are no longer available for
new FileHold purchases.
Previously purchased Brava
viewer licenses are still
available for use in the
FileHold Desktop
Application.
Notify Me Create a Document Alert or | All users with access to the

Reminder and/or cancel
ones that have been
created.

document.

Create Shortcut

Allows the user to create a
shortcut to a selected
document in another Folder
located in the document
management system. Note
that this functionality is
disabled unless it is enabled
by an administrator.

Users with Publisher access
rights or higher that have
access to the folder the
document isin.

Go to Document Location

Takes you to the folder
location of the selected
document. This function is
available when you are not
in a folder such as in My
Favorites, search results,
virtual folder and so on.

All users with access to the
document.

Copy or Move

Make a copy of a document
or move it to another location
in FileHold.

Document Publisher and
Publisher need to have
ownership of the document.
Organizers or higher
permissions can move
documents owned by
anyone. Restrictions on
where a document can be
moved to will apply.
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Action /Function

Description

Permissions needed

Delete

Delete a document from the
system.

All users with Document
Publisher + delete
permissions or higher (and in
some cases, they can only
delete their own documents.
See User Roles for more
information). Library
administrators can recover
deleted documents within the
configured number of days.

Convert to Offline

Converts an electronic
document to an offline
document. Downloads the
file to the local machine and
deletes all versions of a file
from the document
management system.

Users with Cabinet
Administrator rights or higher
and are owners of the
cabinet.

Rename

Rename a document.

Users that created the file or
those with Document
Publisher or higher
permissions.

Change Document Owner

Change the owner of a
document version.
Ownership change can be
done one document at a
time.

Users with Organizer role
and higher. Cabinet
Administrators must own the
cabinet.

View Version History

Displays the usage logs for
the selected document
including:

* All versions of the
document. Actions that users
have taken on the document
by document version.

« Edits to the document.

All users with access to the
folder the document is in.

Download as Zip File

Downloads multiple
documents as one zip file.
Note: This command only
appears if multiple
documents are selected first.
The zip file name will include
the user name and the
download date.

Users with access to the
folder the document is in.

11.1. ADDING DOCUMENTS TO FILEHOLD

Users with Document Publisher and higher permissions can add files to the document
management system. Documents can be brought into FileHold using several methods:

e Drag and drop — Drag and drop a document from your local computer.
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Directly within FileHold — In the EDA or Web Client.
Microsoft Office applications — Use the integrated FileHold toolbar to add documents.

Microsoft Outlook — Add emails using the integrated FileHold toolbar or the “watched
folder”.

Watched Folders — Documents can be brought into the system automatically from a
scanner location. See Watched Folders for more information.

Manage Imports — Documents can be brought into the system automatically using the
Manage Imports tool. See the Library Administration Guide for more information.

WebCap — Web-based scanning through the Web Client.

For other ways to get documents into FileHold, see the Knowledge Base.

11.2. DRAGGING AND DROPPING DOCUMENTS

You can use Windows Explorer to drag and drop one or many documents into a folder or the
Inbox of the FileHold Desktop Application (FDA). If dragging and dropping multiple documents,
they will be automatically sent to the Inbox for processing. If dragging to a folder location, the
destination folder will be automatically set.

You cannot drag and drop documents into the FileHold Web Client.

TO DRAG AND DROP DOCUMENTS

1
2.
3.

In Windows Explorer, select the files to be transferred to FileHold from the local computer.
Drag and drop them to their destination folder or to the Inbox.

For files dragged to a folder destination, enter the metadata (unless the folder is auto-

tagged) and click Add. The document is added to the location.
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Metadata & File Properties

- Canadian Union/HR/ 2010 Select View: My Personal View contractmanagementl

ap (& o K = =F (7]

w Metadata

Document Name Type Linked Ver Status Last Medified On Appro
Type of Document *
= Type: HR - event budgets (1 document) R - event budgets| -
7 @ ] HolidayPartyBudget HR - event budgets 2 1 ChecedIn 08/12/2010 9:56 AM Mot Subl Format of Document *
= Type: Policy (1 document) [Electronlc Document ']
7 @ &) Copy of filehold-metadata-v1 Policy 0 1 CheckedIn 15/03/20119:53 AM Mot Sub Document Name *

* contractmanagement1

Project Code *
Document was dragged to a |code 1 ~|

folder location in the Library. Event date *
Enter the metadata and click [ 05/24/2011 [
Add Notes:

il Delete the local copy of this file after it has
been successfully added

A Email notify all folder members that this g
document has been added to this folder

4| I 3 J

4. Forfiles dragged to the Inbox, enter the metadata and select a destination.

e Click Set Metadata and Set Destination to enter the metadata and select the destination
folder.

e Click Send or Send All to send the document(s) to the folder.

Library

-] Inbox (Send to Library)

== = Select View: | Renee
Fy FTeHa

Metadata & File Properties

No document selected

Rermnove From Inbox Edit Metadata Edit Destination| Send Send All [Auto-Fie 7]
[ Checked Out Document, * i = w Metadata
[ Document Alerts Document Name  Status File Name Type Coming From Going To
Do [2J Decument Reminers car-Insurance Info Required car-Insurance.png SetMetadata C:\User...\business_solutions Set Destination
+-[] Recently Accessed
[ Recently Added
! Set the destination
=& Reviews & Approvals
R Set the metadata folder

£.[E® Waorkfinw Statis Renort

e See Entering Metadata for a Document for more information on setting metadata on
documents.

11.3. ADDING DOCUMENTS DIRECTLY FROM THE FILEHOLD DESKTOP APPLICATION

There are many ways in which you can add one or documents directly from the FileHold
Desktop Application:

e Click the Add File (+) button from the Inbox or folder location.
e GotoFile> Add Fileto Library. This option allows you to add one or many documents.

e GotoFile> Add Folder to Library. Adds the entire contents of a folder (not the folder
itself) to the Inbox.

If you are adding more than one document at a time, then the documents will automatically go
to the Inbox for processing.
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TO ADD FILES DIRECTLY FROM THE FILEHOLD DESKTOP APPLICATION
1. Do one of the following:
e From the Inbox or a folder location, click Add File (+ sign).
e GotoFile > Add File to Library.
e GotoFile > Add Folder to Library.
2. Select the file from the local computer and click OK.

If the file was added to the Inbox, the metadata and destination will need to be set. Click
Set Metadata and Set Destination to enter the information. After the information is
entered, click Send or Send All. See Entering Metadata for a Document for more
information on setting metadata on documents.

4. If the file was added to a folder, enter the metadata and click Add.

11.4. ADDING DOCUMENTS THROUGH THE FILEHOLD WEB CLIENT

When adding documents via the web client, you can only add a single document at a time. If
you need to add multiple documents, use the FileHold Desktop Application. Since there is no
Inbox in the Web Client, you add a document from within the destination folder or use the Add
Document Wizard.

TO ADD A DOCUMENT VIA THE WEB CLIENT

1. Inthe destination folder, click Add File to Folder.

Default View 3 L

' Add File to Folder

D Training and Support/FileHold 12/New Features '@

|} Document Name Type Linked Ver Status Last Modified On
Oy e [g 37 Photos 0 1 Checked Out  4/3/2012 11:05:48 AM Edit
O GE 3 Photos 0 1 Checked In 413/2012 11-16:09 AM Edit
2. When the Metadata pane opens, select the Document Schema from the list.
3. Select the format of the document, if applicable.
4. Click Browse to locate the file that you want to add to the repository.
5. Fill out the required metadata fields. See Entering Metadata for a Document for more

information on setting metadata on documents.
6. Click Save.

TO ADD A DOCUMENT USING THE ADD DOCUMENT WIZARD

1. Inthe Web Client, select Add Document from the library tree.

€ FileHold

Select aFile Select & file to add to the By
Select a Folder Sobect File*
Metadata -“m i
[
) [ mex || swemr || cocs |
104 € FileHold
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In the Select a File page, click Browse to locate the file to add to the repository.
Click Next.

In the Select a Folder page, select a destination folder from the library tree or select the
Auto-file check box to automatically set the destination. Note that auto-filing must be
configured by your administrator in order to use it. If you try to use auto-filing and it has not
been configured, you will receive a message stating "The selected document schema
doesn't have an associated auto-filing script."

Click Next.
In the Metadata page, select the schema and enter the metadata field values.
Click Submit.

11.5. ADDING DOCUMENTS FROM MICROSOFT OUTLOOK

Users can save entire emails, including attachments or save just the attachment without the
email. Emails can be brought into the system:

Drag and drop emails from Microsoft Outlook into the FileHold document management
system.

Use the Add to FileHold button from the Add Ins toolbar in Microsoft Outlook. The email
message has to be opened in order to use the Add to FileHold button as you cannot do it
from the messages view.

Using a Microsoft Outlook ‘watched folder’ allows you to add any emails into the “watched
folder” in Outlook so that the emails are brought into a folder on the local computer or
network location. Then having a watched folder or managed import set up in the FileHold
Desktop Application (FDA) (see the Library Administrator Guide for more information on
managed imports), the emails automatically get brought into system for processing.

Emails are saved as msg files and open in Outlook with their attachments. The email header
information (To, From, CC, Date, Subject and Attachment) may be automatically extracted into
the metadata fields, depending on what your administrator has configured. That way, you do
not have to type this information in; instead the system will do it for you. See Extraction Rules
in the Library Administration Guide for more information.

For the watched folder in Outlook, you can set up special email rules in Outlook to ensure the
correct emails are being moved into the document management system. You can also drag
and drop emails into the watched folder. Once an email has been sent into the document
management system, it can never be imported again.

To ADD EMAILS FROM MICROSOFT OUTLOOK

1. Do one of the following:

April 2017

From Microsoft Outlook, select one or more emails and drag and drop the files into either
the Inbox or a folder location. Enter any required metadata and/or destination information.
See Entering Metadata for a Document for more information on setting metadata on
documents.

From Microsoft Outlook, open an email and go to the Add-Ins tab and click Add to
FileHold (+ sign). Select the folder location and enter the metadata and click Add. See
Entering Metadata for a Document for more information on setting metadata on
documents.

Drag and drop or set up an Outlook rule to send documents to the Outlook watched folder.
See below for more information.
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DRAGGING AND DROPPING EMAILS FROM OUTLOOK

Drag and drop allows a user to move multiple emails from Outlook to the document
management system FDA.

1.
2.
3.

Select the email(s) that are to be moved to the document management system.
Drag and Drop to the FDA.

Emails will automatically be sent to the Inbox for processing.

Remember: Emails saved to the system can only be accessed by those with appropriate
permissions to access the folder in the document management system where the email is
saved.

ToO SET UP THE MICROSOFT OUTLOOK WATCHED FOLDER

1.

4.

Create a folder in Microsoft Outlook that you want add the emails to.

4 Quytlook Data File

a0 ) Inhiox
[ FileHold YWatched Faolder for Emails

L2#| Drafts

On your local computer or network location, create a folder that you want FileHold to
“watch” for new emails to be brought into the repository.

In the FileHold Desktop Application, do one of the following:

Set up the Watched Folder for the folder you just created on your local computer or
network drive. See Watched Folders for more information. Note that if you are using a
Watched Folder, the email header information is not extracted into the metadata fields of
the schema. If you want the email header information extracted into the metadata fields,
use a managed import instead.

Have your library administrator set up a Managed Import for the folder that was created on
your local computer or network. If using a managed import to bring emails into FileHold,
ensure that the import format has been set to “Quick Scan Pro” in the user preferences. If
the import format has been set to “Both” in the user preferences, ensure that the import
format is set to “QuickScan Pro” on the individual managed import. See the End User
Guide for more information on the User Preferences setting or the Library Administration
Guide for more information on Managed Imports.

NOTE: If you are using the “Both” option in the user preferences, ensure that folder you
select for the import profile contains only one type of XML files. The rule also applied for
any of its subfolders. The XML files for the import formats cannot coexist in the same
folder tree.

In Outlook 2010, select the Add Ins tab in Outlook and click FileHold Watched Folder.
e In Outlook 2007, click FileHold Watched Folder in the toolbar.

0| 5[ "9 |+
Horme Send [/ Receive Faolder Wiew Add-Ins

*;ﬁ FileHaold Watched Folder
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5.

FileHold Watched Folder Configuration Ed |

In the FileHold Watched Folder Configuration window, click the Enable Outlook Watched
Folder check box.

In the Watched Folder in Outlook field, click Browse to select the watched folder you
created in Microsoft Outlook.

In the Destination Folder for Export field, click Browse to select the watched folder on your
local computer or network drive.

To create an XML file when the emails are exported, select the Export XML files in
Document Import compatible format check box. This XML file is created for each .msg
file and can be using in conjunction with the Manage Imports tool to import emails into the
repository. The XML file contains the following message header information: To, From, CC,
Date, Subject, and Attachments. Note that this does not need to be turned on to work with
FileHold Watched Folders. The XML files do not get imported into the repository.

¥ Enable Gutlook Watched Folder

w'atched Folder in Outlook:
I'l,'l,OutIn:u:nk Data FilelInboxiFileHald Watched Falder For Emails Browse

Destination Folder For export:
IC:'I,Llsers'l,au:lministratnr.DCZIIIEIB'I,Du:u:uments'l,FiIeHu:uId YWatched Folder Browse

i

[ Export ML files in Document Import compatible Format

Ik | Cancel |

10.

Click OK.

Test your configuration by adding an msg file to your Outlook watched folder. Then go into
FileHold to ensure that the file has been brought into the Inbox for processing or sent to the
folder, depending on your configuration settings in the Watched Folder or Managed Import.
If you are setting up a managed import for emails, ensure that you have an email schema
and an email extraction rule configured.

TO ADD ONLY AN ATTACHMENT FROM AN EMAIL

If attachments are saved to the system without the email they are stored in their native format.

NOTE: You cannot drag and drop an email attachment. You will need to use the Send to
FileHold command.

1.

2
3.
4
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In Microsoft Outlook, select and open an email with an attachment.
Right-click on the attachment and select Add to FileHold.
Select a destination for the document.

Enter the metadata for the document. See Entering Metadata for a Document for more
information on setting metadata on documents.

Select the following options, if applicable:

Close the document before | add it — Closes the document in the application you are
working in after you have added the file.
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11.6.

11.7.

e Delete the local copy of this file after it has been successfully added — Deletes the copy of
the file from your local computer after it is added.

e Email notify all folder members that this document has been added to this folder — Sends
an email alert to all the members of the selected folder.

6. Click Add or Auto-File if the document was added to a folder that is auto-tagged.

ADDING DOCUMENT FROM MICROSOFT OFFICE APPLICATIONS

FileHold has integration with Microsoft Office applications such as Word, Excel, PowerPoint,
Visio, and OneNote (2010 only). The integrated toolbar can be found on the Add Ins tab of the
Office applications.

The FileHold Office Client (FOC) window is used when adding, browsing, checking in, adding
attachments or approving documents in FileHold from within Microsoft Office applications.

TO ADD FILES FROM MICROSOFT OFFICE APPLICATIONS (EXCLUDING MICROSOFT OUTLOOK)
1. Create or open a document in a Microsoft Office application such as Microsoft Word.
2. Save the document to your local computer.

3. In Microsoft Office 2007 or higher, select the Add-In tab and click Add to FileHold (+ sign)
or Send to FileHold > Add Document.

e In Microsoft Office 2010 or 2013, select the FileHold tab and click Add to FileHold (+
sign).

e In Microsoft Office 2007 or higher, select the Add-In tab and click Add to FileHold (+ sign)
or Send to FileHold > Add Document.

The FileHold Microsoft Office Client window opens.
Select a destination folder and enter the metadata.
Select the following options, if applicable:

e Close the document before | add it — Closes the document in the application you are
working in after you have added the file.

e Delete the local copy of this file after it has been successfully added — Deletes the copy of
the file from your local computer after it is added.

e Email notify all folder members that this document has been added to this folder — Sends
an email alert to all the members of the selected folder.

7. Click Add or Auto-File if you selected a folder that has been auto-tagged.

ADDING OFFLINE DOCUMENTS

An offline document is something that cannot be stored in the document management system
such as a map, book, or blueprints. An offline document can also point to documents that are
not yet in electronic form such as a location of a folder in a filing cabinet in a historical records
room. You will need to create an offline document schema in order to add offline documents
that have a metadata field that states where the offline document is stored. The schema simply
points to where the document is physically stored.

Offline documents are tracked in the system so you can see who has the document out or in
other words, who has taken the item from its physical location.

Offline documents can be:
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e Checked out
e Converted to an electronic document
e Undergo a workflow

e View the version history

TO ADD OFFLINE DOCUMENTS
1. Do one of the following:
e From a folder location or the Inbox in the FDA, go to File > Add Offline Document.

e Inthe Web Client, select a folder and click Add File to Folder or use the Add Document
Wizard.

2. Select the Offline Document Schema name. See the Library Administration Guide on how
to create an offline document schema.

Fill out the required metadata fields and click Add.

Set a destination folder if adding the Offline document from the Inbox.

11.8. EXPORTING DOCUMENTS IN A VIEW TO A CSV FILE

From any folder view, search results or other FileHold view, you can export the columns and
associated values to a CSV file. The CSV file contains information from the entire folder list
columns except for the icons associated with the documents (i.e. favorites and permissions).

You can customize the view in order to export the data that you want by adding or removing
columns, grouping, sorting, and so on, using the View Preferences. You can also perform an
Advanced Search to achieve the data results you want to export.

NOTE: In the FDA, only the documents displayed on the current “page” will be exported to the
CSV file. If you have additional pages of documents, you will need to export each page to CSV.
You can also increase the number of documents displayed on a “page” in the View
Preferences.

TO EXPORT FOLDER CONTENTS TO A CSV FILE
1. Open a folder or do a search to create a list of files to export.

2. Right-click in the column names header and select Export Grids to CSV.

- Training and Support/FileHold 14/Training Materials Select View:

Document Name Linked Ver Status Last Modified On

Group By 3
@ Document Schema: Application (2 docun Add /Bemoye Columns b
77 @ B travelauth i | Export Grids to CSV [ o 1 CheckedIn 12/17/20153:33 PM Edit
7 @ [E 9371 COlEpsE Al Groups 0 1 CheckedIn 12/17/2015 3:34 PM Edit

Expand All Groups

@ Document Schema: Bicycle Manuals (48 do

77 @ B warranty Bicyde Manuals 0 1 CheckedIn 12/17/20153:33PM  Edit

7 @ B this is 2 new dacument thrannh FOC Bicvde Manuals 0 1 Checked Tn 12/17/2015 3:33 PM Edit

3. Enter a name for the CSV file and select a location to save the document.
4, Click Save.

5. You can now open the document in a spreadsheet.

April 2017 R Hold 109



FileHold 15.2 End User Guide

A B & D E F G H
|D0cument Name |Type Linked Wer Status Last Modified On Approval Status Approval Date
HolidayPartyBudget HR - eveni 2 1 Checked In  08/12/20109:56 Not Submitted For Approval
FW Library Admin Training Inbound E 1] 1 Checked In 24/05/2011 11:28 Not Submitted For Approval
Copy of filehold-metadata-vl Policy 0 1 Checked In  15/03/2011 9:53 Not Submitted For Approval

11.9. ENTERING METADATA FOR A DOCUMENT

The metadata pane displays the document schema and its associated metadata as well as
system values in the version properties area. The metadata and version properties are unique
for each version of every document in the system. All of these values are can be searched on
in the system.

When documents are being added to the document management system, it requires two
pieces of information prior the file being added to the library:

1. Values for all required metadata fields.
2. A destination folder.

The status of the document is “Info Required” until the information is entered. Once the
required metadata is filled and a destination set, the status changes to “Ready to Send” and
document(s) can be sent to the library.

When entering metadata for document, all fields marked with an asterisk * indicate that the
field is mandatory and must be filled in. The type of metadata collected for a document schema
is determined by how you set up your metadata schema. Metadata is set in the Metadata
Pane.

To OPEN THE METADATA PANE

1. In afolder or search results view, do one of the following:

e Inthe FileHold Desktop Application (FDA), click _O
e Inthe Web Client or FDA, right-click and select Metadata & File Properties.
e Use the shortcut key Ctrl+Shift+P .

2. Inthe Inbox of the FDA, click Set Metadata or Edit Metadata or press the shortcut key
Ctrl+Shift+P.

Once the metadata has been set, it is displayed in the Metadata Pane along with the file
version properties associated with the selected file. The version properties are displayed below
the metadata properties. Here, the document owner, version number, status, format, URL links,
file type, library location, markup status, and file size can be viewed. All of the version
properties of a file are searchable.
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7 Search Metadata Only ™ indude Archive in Search [ Include All Document Versions [ Search Using Histor
§ 5 xF Save as Saved Search Highlight Results 7]

Location

12345 Bell 10-06-2014
145632 Bell 03-02-2015
234634 Bell 22-04-2014

Development / Project - 2 / OCR Tests
Development / Project - 2 f OCR Tests
Partners  Webinar #2 | Viewer
Partners / Webinar #2 / Viewer

Accounting / Invoices { 2012 / Costeo

= &

Search
Document schema

Invoices

7 Document Name
INV 12345 ABC Co 08-01-2013
Document Schema Link}
Invoice Number
12345
Invoices Invoice Date
Invoices Gl
Invoices P
ABC Co
Invoices
Total
Invoices §123.23
Invoices

i —

Version

1 of 1 View all versions

Owner

sysadm added on Thursday, December 17, 2015 3:31PM
Library Status

Checked In

Has Markups

No

FileHold 1D

205.1

Format

Electronic Document

Library Location

Accounting / Invoices / 2013 / ABC Co
Document URL

Copv Default URL

Al LRLs

Type of File

pdf 7
Size
5.4MB

See the table below for details on the document version properties.

Version Property

Description

Version Displays the number of versions for a document. Click the View All
Versions link to see all document versions. See Version History for
more information.

Owner The user that initially added the file or the user that added the latest

version of the file.

delete, move, etc.

Ownership is important when it comes to user roles and being able to

Library Status

checked out.

States if the document is checked in or checked out. If it is checked
out it will state who has checked out the document and when it was

Has Markups

If any markups have been added via the Brava viewer, it states Yes. If
there is no markups, it states No. Starting in 2017, Brava viewer
licenses are no longer available for new FileHold purchases.
Previously purchased Brava viewer licenses are still available for use
in the FileHold Desktop Application.
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Version Property

Description

FileHold ID A unique ID number given to every document in the system.
Documents are numbered sequentially as they are added. The
number after the period (.) indicates the version number.

Format Electronic Document — documents that can be checked out/in and

modified.

Electronic Record — records cannot be modified. There will only be
one version of this file.

Offline Document — physical items that reside in your office or point to
documents that are not yet in electronic format in the document
management system.

Library Location

The cabinet / drawer / folder group (optional) / folder location of the
document.

Document URL

Links that can be used to point to the document. There may be
different link types available depending upon what your library
administrator has configured. To copy the link, click the link and paste
the link into another document.

Copy Default URL — link to where the document resides using the
default URL configured by the administrator.

For example,
http://fileholdserver/FH/FileHold/WebClient/LibraryForm.aspx?docld=1

or fda://document/1

All URLS - Displays the list of URLS that are available for use. The
list is configured by an administrator. If this option is not available,
then only the Default URL can be copied.

See your library administrator for details.

Type of File

States the file type such as Microsoft Word, PDF, TXT, JPG, etc.

Size

States the size of the file.

Entering Metadata for a Single or Multiple Documents

Before a document can be added to the library, it requires two pieces of information:

e Values for all required metadata fields - When entering metadata (also called tagging or
indexing) for document, all fields marked with a * indicate that the field is mandatory and
must be filled in. Metadata is set in the Metadata Pane.

e A destination folder - The folder in the library structure where the document will reside.

IMPORTANT: The maximum number of characters in a document name is 100. This limit is in
place to reduce the risk of conflicts with filename and path length limits in Microsoft Windows.
The maximum size of the filename and path in Windows is 260 characters. This means that the
longest path that will avoid conflict with Window's limit when making a local copy of a document
from the document management system is 160 characters. The user will see an error message

if the limit is exceeded.

TIP: There may be cases where you would like the name of the document to be longer than
100 characters. You can create a metadata text field large enough to hold the large name and
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use custom naming to set the document name that would be used if the document is copied
outside of the document management system. The L mask operator can be used to truncate
the name to a length less than the maximum and an extra identifier like the document id or the
document create date and time could be added to simplify identifying the document outside of
the document management system.

TO ENTER METADATA FOR A SINGLE DOCUMENT

1. Add the file to the document management system. This can be done in the Inbox or a
folder location.

2. Do one of the following:
e Click the inline Set Metadata link.
e Click the Edit Metadata button.
e Right-click and select Edit Metadata.

e Click the metadata pane button _O

3. Select the Document Schema from the list. The metadata fields will change depending on
which schema you have chosen.

Enter in all the required metadata information. This is marked with an asterisk *.
Fill in the optional information if needed.

Select the check box to delete the local copy of the file after it is added to the Library if
required.

7. Select the check box to email all folder members that a document has been added to the
folder if required.

8. Click Add or Save & Next to add metadata to the next document in the list.

TO ENTER METADATA FOR MULTIPLE DOCUMENTS AT A TIME (FDA ONLY)

1. Add the files to the FileHold Desktop Application. By default, these documents will go to
the Inbox.

2. Select the files to be tagged (indexed). Use the CTRL or SHIFT keys to select multiple
documents.

3. Do one of the following:
e Click the Edit Metadata button.
e Right-click and select Edit Metadata.

NOTE: Do not click the inline Edit Metadata link. This will cause you to edit the metadata for
just that selected document.

4. Select the Document Schema from the list. The metadata fields will change depending on
which schema you have chosen.

5. Do one of the following:

e To enter common values for all metadata fields for all of the selected files, select the Check
All check box and enter the metadata values.
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Metadata & File Properties

Apply Metadata to Multiple Files

w Metadata

Document schema *

IInvoices j

Format of Document *
IEIech’onic Document j

You have selected & files of type:Product Documentation (8)

Use the checkboxes to selact metadata field(s) you
want to edit for all documents. Edit the field and click
Save to apply the changes.

Available Metadata Fields for Invoices documents
V' Check all

¥ Invoice Number *
¥ Invoice Date *
[ 23-12-2015 |

¥ vendor

| 5
V' Total *

To enter common values for only select metadata fields, select the check box next to the
metadata field names.

Metadata & File Properties

Apply Metadata to Multiple Files

w Metadata

Document schema *

Ilnvoices j
Format of Document *
IEIech’onlc Document j

‘You have selected 6 files of type:Product Documentation (5)

Use the checkboxes to select metadata field(s) you
want to edit for all documents. Edit the field and diick
Save to apply the changes.

Available Metadata Fields for Invoices documents

[T Check all

™ Invoice Number *

™ Invoice Date *

JI 25-12-2015 3|
" ¥ Vendor

Jeel =
1 " Total*

Select the check box to delete the local copy of the file after it is added to the Library if

required.

Select the check box to email all folder members that a document has been added to the

folder if required.
Click Save.
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9. If there are any required metadata fields that were not filled out, enter in all the required
values for the individual documents. Required fields are marked with an asterisk *.

10. Fill in the optional metadata fields if needed.
11. Click Save or Save & Next.

11.9.2. Entering Metadata Using Click to Tag

Click to Tag is a method of quickly assigning metadata to a document being added to the
repository using the FileHold Desktop Application. It allows you to “click” or “rubber band” text,
numbers, dates, etc. on the screen and inserts the value into the metadata field of the schema.
When using Click to Tag, the mechanism OCR’s (optical character recognition) the selected
area on the screen. This makes is possible to extract values not just from the document but
also from any external application accessible on the user’'s computer.

In order to use Click to Tag, it must be enabled in the User Preferences. Note that this setting
may be overwritten by your administrator.

When Click to Tag is invoked in the metadata pane, the user is prompted to open the
document in the FileHold viewer, the document’s native application, or to not to open the
document. Not opening the document allows you to tag the document using an alternative file
or from another application.

Once an option to tag the document is selected, the screen is covered with an opaque white
mask called the “fold”. This indicates that the Click to Tag process is in effect. A tool tip
displaying the metadata field name to tag is shown. You can then click or rubber band the
value for the metadata field. After the first metadata field is tagged and validated, the next
metadata field in the list can be captured. The process is repeated until all the values have
been captured. The “fold” can be activated and deactivated at any time during the tagging
process in the event that a document needs to be scrolled to other page, zoomed, or tagged
from a different screen.

When tagging metadata fields, read-only and auto-tagged fields are skipped from the tagging
process. Check box type metadata fields are also skipped. For drop-down or drill down type
metadata fields, the information that is being selected on the screen must be an exact match. If
no matching value is found, an error message is displayed. Similarly, date type fields will need
to be properly formatted on the screen or an error message is displayed. If date, currency,
number, or drop down list values do not match what has been captured or is not formatted
correctly, the system will prompt you to enter a correct value.

The selacted bext was nokt recognized as & vabd dropdoen Feld
wabue, Yiou can marusaly cormect the walus and bry sgain.

OCR Tet: [ICBC |

ok coreel |

If no metadata fields are present in the selected schema, the Click to Tag button is not
available.

Note that the quality of the documents that are being tagged using Click to Tag need to be

reasonably high. For this reason, only documents that are electronic in origin should be
used with Click to Tag. Prior to using Click to Tag, you should test the tagging process with
your various electronic documents to ensure that it will work well.

Font/text size needs to be of a reasonable size as Click to Tag does not work well with small
fonts. If Click to Tag is not working well with the current font size, zoom into the document to
increase the size of the font on the screen. Due to various quality, font size, or font type
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reasons, some text may not be able to be read (ORC’d) from the screen and cannot be tagged
using Click to Tag. In these cases, metadata values have to be entered manually.

Scanned documents may present issues in tagging due to poor quality scans so for this
reason, the OCR capabilities of your scanning software should be used to tag the documents
and not Click To Tag. See the Knowledge Base for more information on scanning documents
and importing metadata into the document management system.

Click to Tag supports only the English language “out of the box”. This can be modified in the
FDA.exe.config setting <add key="ClickToTagLanguage" value="eng"/>. For other
language support, contact FileHold Professional Services at sales@filehold.com.

TO ENTER METADATA USING CLICK TO TAG
1. Add a new document(s) or select an existing document(s).
2. Select a Document Schema from the list if adding a new document.

3. Inthe metadata pane, click Click to Tag.

Metadata & File Properties *

scanned_pdf_bell-abc

w Metadata
Document schema *
I:Jroduct Documentation j
Format of Document *
IEIe-:trc-ni-: Document j
Document Name *
|scanned43df_bell-abc
Type of Documentation *
| o
Version *
| [
Author (file properties)
Click To Tag |

4. Inthe Click to Tag window, select one of the following options:

e Open the document in the native application — The document opens in its native
application. For example, if it is a PDF then it opens in Adobe Reader.

e Open the document in the Brava viewer — The document opens in the Brava viewer in the
FileHold Desktop Application. You may need to undock the viewer, adjust the size, or move
it to another monitor in order to tag the document. You can do this by closing the “fold”.
Starting in 2017, Brava viewer licenses are no longer available for new FileHold purchases.
Previously purchased Brava viewer licenses are still available for use in the FileHold
Desktop Application.

e Open in the document in the PDF/Image viewer — Opens the document in the PDF/Image
viewer in the FDA. You may need to undock the viewer, adjust the size, or move it to
another monitor in order to tag the document. You can do this by closing the “fold”.

e Do not open the document — Does not open the document in any viewer or application.
Use this open to tag the document from an alternative file or from another application.
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NOTE: If you are tagging multiple documents at once, then this window does not appear.
You will need to close the fold and open the document or application that you want to tag
from and then open the fold again to proceed with tagging.

Once an option is selected, the “fold”, a white opaque mask, appears over the screen.
This indicates the Click to Tag process is in effect. You may need to deactivate and
activate the fold to undock the viewer, adjust the size, scroll through a document,
zoomed, or move it to another monitor, and so on in order to tag the document. To
deactivate the fold, click Fold in the bottom right corner. To activate the fold, click the
Unfold button. See the example screen shots below:

To deactivate or close the fold, you can also right-click on the activated fold and select
Fold.

To move between windows, use Alt+Tab or the task bar instead of deactivating the fold.

e —— e T,

Deactivate Fold | Activate Fold

wopy of thisgle after it has ical copy of file after it has
sfully added

|

ilder members 3l Folder members &

sen added o this Fo \ { 15 been added to this Folder
Save & Mext | Capcgl A J Save & Next | Cang

6. Once the document is opened in the selected viewer and the fold is activated, the first
metadata field in the schema displays in a tool tip. Capture the value for the metadata field

by:

A single word is captured by clicking on it.

Multiple words or lines are captured by dragging a rectangle round the words (rubber
banding) All words located inside or intersecting the triangle are captured. See the example
below:
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File:

- =~ B

Edit

View Measure

Dpkions

B

o M

Pet Stare Supply

1-877-83%1202

To:

Pet Store
111 Marianas Trench
Vancouver BC V4R 375

Opague white mask
covers the screen
called the "fold".

5 [=] -3

Help

Invoice

"Rubber band" or click
on the metadata value

Invoice Number: 8584
Date: 14/09/2011
Customer D # 78525

T

Ship'To:
Metadata field

HHHH‘_ il
Basie's Pet btore name tool tip
Vancouver BC V=

SALESPERSON PO NUMBER S:El::';g SHIPPING TERMS | DELIVERY DATE PAYMENT TERMS
Tom Mewton 785 Ground o7it0s2011 Due an receipt

Continue tagging the rest of the metadata fields in the schema using the click or rubber

band methods. A tool tip displays each metadata field name.

If you need to change a value or skip to another metadata field, right-click on the fold

while it is activated. The list of metadata fields for the selected schema is shown. Select
the desired metadata field name from the list. The metadata field that is currently being
tagged has a check mark next to its name.

7.

8.
File Edit
&~ 5+ 8-

9.

Wit Measure  Help

Options

B X

-

Invoice

Pet Store Supply

Your cots and dogs love us!
2504664 Lougheed Hwy
Burnaby BC VSC 5T5
1-877-833-1202

To:

Pet Store
111 Marianas Trench
Vancouver BC V4R 375

Current metadata
field being tagged
Invoice Number: 8584
Date: 14/09/2011
Customer ID # 78525

Custamer Name: Basie Pie
Custarmer 1D
Invoice Date

Inwvoice Mumber

Shipping Method

Taotal

Salesperson | 1
re 4

Fold Trench =

Close V4R 375

If the value of the metadata field is not valid (does not match drop-down or drill down list

value, invalid date format or check box) or cannot be read due to reasons (such as poor
quality, font size, font type, and so on) an error message is shown stating the value is not
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valid. Click OK to retry tagging the value. When tagging a currency, number, drop down
list, or date value and Click to Tag does not recognize the value, a window opens
prompting the user to enter the correct value.

Click To Tag Correction | x| |

The selected text was not recognized as a walid date. You can
manually correct the value and Ery again,

OCR Text: [EM

(o] 4 I Zancel

10. Once the tagging is completed, right click on the activated fold and select Close.
e Alternatively, click ESC to end the Click to Tag process.

11. Click Save in the metadata pane to save the information.
11.9.3. Entering Metadata Using Database Lookups

Metadata information can be automatically populated into many metadata fields based on a
single metadata “look up” value that comes from a database such as an accounting database
or an ERP system.

If the administrator has configured the schema to use database lookups, you will see a Lookup
button in the Metadata pane. Clicking this button after entering or selecting the value from the
configured database drop down list metadata field retrieves any mapped values from the
database into the remaining metadata field values of the schema. This can reduce the amount
of time it takes to index a document with metadata.

When the list retrieved from the database is presented to the user in the drop down list, only
the first 100 items will be displayed in the FDA and the first 25 items in the Web Client. As the
user scrolls through the list or starting typing the value, more values will be loaded into the view
but is limited to viewing 100 (FDA) or 25 (Web Client) values at a time.

If there are any blank required fields after the lookup is performed, you will need to enter those
manually. The values of any read-only or automatically tagged fields are not affected by the
database lookup.

The Lookup button in the metadata pane is shown when adding a single document or when
editing the metadata of a single document. You cannot do database lookups for several
documents at once from the Inbox; look ups have to be done one document at a time.
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Metadata & File Properties *

Invoice # 10393 Save-a-lot Markets

This version is Checked In

Document schema *
IInvoices (dblookup) j

Format of Document *

IEIech’onic Document j

Document Name *
IInvoice # 10393 Save-aJot Markets 03-Jan-1997

Invoice # (dblookup) *

|10393 |

Customer Name
|5av9ﬁ-lot Markets

Invoice Date

[ 03-01-1397 |
Total

|2556.95

Lookup |

Save | Save & Next I Cancel |

For more information on creating database drop down list metadata fields or setting the
database lookup on a schema, see the Library Administration Guide.

TO ENTER METADATA USING DATABASE LOOKUPS
1. Do one of the following:
e Add a single document to the document management system.
e Select a single document in the Inbox.
e Edit the metadata of a document in the library.
Select the Document Schema.

Enter or select the value for the database drop down list metadata field that is configured to
do the lookups.

e If you enter a value in the wrong metadata field, you will receive an error message “Missing
value for <metadata field name>".

4. Click Lookup. All of the metadata fields that are configured will pull in the values from the
database.

5. Enter values in any other required metadata fields or modify any of the values that were
retrieved.

6. Click Add or Save.
11.9.4. Editing Metadata

If you have sufficient permissions (Document Publisher or higher role), you are able to edit the
metadata for a document.
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TO EDIT METADATA

1. Locate the document whose metadata you want to edit and open the metadata pane.
2. Click Edit and make any changes to the existing values.

3. Click Save.

11.9.5. Copying Metadata

You can copy metadata values when the metadata panel is in its editable or non-editable form.

TO COPY METADATA
1. Select a document and open the metadata pane.

2. Right-click and select Copy.
11.9.6. Using the Document URLs
You can use the URLs provided in the Version Properties area of the metadata pane to send

links to other FileHold users instead of sending the entire document.

Depending on how your library administrator has configured it, you may be able to copy only
the default URL or all configured URLSs.

Click the link to copy the URL. The link is copied and you can paste the link using Ctrl+V.

ToLinKk FDA AND WEB CLIENT URLS TO A WEB PAGE

You can link both Web Client URLs and FileHold Desktop Application (FDA) URLSs to a web
page; however, these links still use the security set on the document. The user attempting to
open a URL must have the cabinet, folder, and schema permissions in order to access the
document.

1. Open the metadata pane for the document's link you want to copy.

2. Under Version Properties > Document URL, click Copy URL for the web client URL or
click Copy FDA Link for the FileHold Desktop Application link.

TIP: Due to browser security, in order to copy links in Mozilla FireFox or Google Chrome, you
will need to right-click on the link and select Copy Link Location. You can then paste the link
into an email or document.

You can paste these links into your web page using CTRL+V.

4. When the URL link is clicked from a web page, you will need log in to FileHold; either the
web client or FileHold Desktop Application, depending on the link type. Both the FileHold
Desktop Application (FDA) URL and the Web Client URL are maintained.

5. Once you are in FileHold, the document will appear highlighted in the folder list. You can
get a local copy, check out, view version history, etc.

11.10. SETTING THE DESTINATION FOLDER
You will need to determine which folder the documents will reside in the library structure. You
can set the destination for one or more documents at a time from the Inbox.

TIP: You can use the Recent Folders list if you are always adding documents to the same
folder location.
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] Inbox {Send to Library)
[#]-E My FileHold
Reviews & Approvals
- Recent Folders
] New Features
[ Corporate Palicies
oz
- AN
[ Staples
[ Puralatar
[ Fedex
[ BC Hydrao
-~ Day-3
-] Training Materials
= Seardh
F-£50 ¥irtual Falders
=-EH Library
=Bl Accounting
(3P Bank Statements
=29 Invoices
D BC Hydro

TO SET THE DESTINATION FOLDER FOR DOCUMENTS
1. Do one of the following:
e From the Inbox, select a single document and click Set Destination.

e From the Inbox, select one or multiple documents to be filed under the same folder and
click Edit Destination from the toolbar. If setting the destination for multiple documents, do
not use the Set Destination link.

e Alternatively, drag and drop one or many documents to the folder location in the library
tree.

2. From the Select Location window, browse to the folder location in the library tree and click
OK. The destination for the documents will be shown in the Inbox.

11.11. DELETING FILES
You may only delete files if you the correct permissions and are owner of the document. You
can also delete previous versions of a document.
TODELETE A FILE
1. Select the document name and click Delete X.

11.12. CHECKING IN AND CHECKING OUT DOCUMENTS
Document version control ensures that changes made to documents are not accidentally
overwritten by other users. Checking out a document “locks” the document and prevents others
from making changes. Users can still get a local copy of the document (read-only) when a
document is checked out.
A unique copy of every version of a file checked into the system is retained to ensure that
documents can be reverted back to a previous version if needed. To view all versions of a
document, see the Version History.
It is important for users to remember to check documents in once they are finished editing.
Users cannot view your changes or check the document out until the document is checked
back in. To view all of the documents that you have checked out, go to My FileHold >
Checked Out Documents.
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When the file is checked out, its status is set to Checked Out. In the Version Properties area
of the Metadata pane, you can see who checked out the document and the date and time it
was checked out. When a document is checked in, its status is set to Checked In.

7 B ¥ p.0.-Sauve_FileHol_17032011 Test 0 1 _ CheckedIn  17/03/20113:58PM Continents North America >Canada >British

- Columbia >Burnaby
7 B0 ¥ P.0.-ysadm_Self-Se_07042011 Test 0 " CheckedIn  07/04/2011 10:07 AM
il ﬁi] P.0.-ysadm_Use of _06042011 Test 1 CheckeT)ut 06/04/2011 3:46 PM

Checked In Status

Checked Out Status
Version i
1 of 1 View all versions
Owner
Marvin Mallett added on March-14-11 4:06 PM
Library Status T
When and who checked out Checked Out by Marvin Mallett on March-15-11
the document 3:13 AM

TO CHECK OUT A DOCUMENT

1. Locate the document you want to check out in the Library and do one of the following:

« Click Check out 4 from the toolbar.
e Right-click and select Check Out This Document.

e To check out and open the file in its native application, hold the CTRL key and double-click
the document name.

2. The document status changes to Checked Out and is downloaded to your working folder.
Your working folder is typically C:\Users\username\Documents\My FileHold Documents.
The working folder location is set in your User Preferences.

e If you selected to check out and open the file, it will open in its native application. For
example, a .doc document will open in Microsoft Word.

11.12.1. Checking in Documents

Only the user that checked the document out of the records management system can check
the document back in. You can check in a document from anywhere the document shows up in
the system such as the folder location, My Checked out Documents, or a Microsoft Office
application.

Documents can be deleted automatically upon check in if the setting “By default delete
documents that | Check In to FileHold” is enabled in the User Preferences. It may also be
locked down by an administrator and cannot be modified.

It is possible to enable the setting “Edit metadata upon Check In action” in the User
Preferences so that the metadata pane opens for editing after checking in a document into the
document management system. If configured to do so, then the metadata pane automatically
opens upon check in so the values can be modified. This option can be locked down by a
system administrator. See the System Administrator Guide for details.

Metadata field values may be cleared upon check-in if the option "Clear at Check In" has been
enabled in the schema. If enabled, then any required metadata fields (marked with an asterisk
*) in the schema are cleared forcing you to enter new values upon check in. See your library
administrator for details.
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ToO CHECK IN FROM MY CHECKED OUT DOCUMENTS
1. Select document and do one of the following:
e Click Check In from the toolbar
e Right-click on the document name and select Check In This Document.

2. Click Browse to go the folder location where the document that you are checking in
located, if needed. FileHold keeps track of where the document was downloaded to so if
the document is still in the same location, the path is automatically entered.

3. Select any of the following options, if available/applicable:

e Edit metadata for these document(s) before check-in — This option opens the metadata
pane so the metadata field values can be edited. This option may be automatically selected
if the option “Edit metadata upon Check In action” is enabled in the User Preferences. It
may also be locked down by an administrator and cannot be modified.

e Delete the local copy of this file after it has been successfully checked in — This option
removes the local copy of the file from the user’s computer. This option may be
automatically selected if the option “By default delete documents that | Check In to
FileHold” is enabled in the User Preferences. It may also be locked down by an
administrator and cannot be modified.

e Email notify all folder members that these documents) have been checked in — This option
sends an email to all users and groups that have access to the folder. This option may not
be available, depending on the Library Administration settings. See the Library
Administration Guide for more information.

3. Click Check In.

4. If the options “Edit metadata upon Check In action” or “Clear at Check In” are enabled, fill
out the required metadata values in the metadata pane and click Save.

TO CHECK IN DOCUMENTS FROM MICROSOFT OFFICE AND OUTLOOK

1. From a Microsoft Office application, select Send to FileHold > Check In Document or
click the Check In icon from the FileHold toolbar.

e In Office 2007 and 2010 these commands are located in the Add-Ins tab.

TO CHECK IN AN UNCHANGED DOCUMENTS (UNDO CHECKOUT)

1. After checking in a document, a window will prompt you to select the new version the
document. At the top of the box is the option 'l have not changed these document(s).
Please undo the check out of these files'. Select the check box to undo the checkout
leaving the last version of the document as the most recent version.

e If this option is not selected the when the user clicks the Check-In button, the “new” file will
upload to the documents management system as the latest version of the file.

To CHECK IN MULTIPLE DOCUMENTS

1. From the My Checked Out Documents view, select the documents to check in and click
Check In.

e This option is not available through the Web Client.

2. Alternatively, use the Working Documents feature to check in multiple documents at once.
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11.13. COPYING OR MOVING FILES
The Copy or Move function in FileHold allows you to make a copy of a document and/or move
it to another location in the library.

In order to move or copy documents, Document Publishers and Publishers need to have
ownership of the document. Users who are Organizers or higher permissions can move
documents owned by anyone. Restrictions on where a document can be moved to will apply.

TO COPY OR MOVE A FILE
1. Select one or many documents.
2. Right-click and select Copy or Move.
3. In the Copy/Move window, select one of the following options:
e Move files to a new location in the library
e Copy files to a new location in the library
Click Next.

Select the destination in the library for the documents or folder and click OK. The
documents are moved and/or copied to the new location.

11.14. MAKING A LOCAL COPY

You can make a copy (download) of a document to your local machine. The document is
downloaded to the working folder location specified in your User Preferences. This is typically
in the location C:\Users\username\Documents\My FileHold Documents.

TOMAKE A LOCAL COPY OF A DOCUMENT

1. Locate the document in the Library and do one of the following:

e Inthe FDA, click Make a Local Copy (Y from the toolbar.
e In Web Client, select the check box next to the document name and click Get Copy.
e In Web Client or FDA, right-click on the document and select Make a local copy.

2. The document is downloaded to your working folder location.

11.15. EMAILING, AND EMAILING AND CHECKING OUT DOCUMENTS

You are able to email and “email and check out” documents from the Library. When sending
files from the document management system, it is important to send the file in a manner that
allows the other user to access the information while keeping sensitive data safe.

When emailing a link or attachment, emails retain the properties of your Microsoft Outlook
messages including signature blocks and other added items like legal disclaimers.

There are two ways to send files:
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e Send as an attachment — Attachments are the most common way of sharing files via email;

however, they are the least secure as anyone who receives the attachment can open the
document.

B Hd = Untitled - Message (HTML) T EH - O %
MESSAGE  INSERT  OPTIONS  FORMAT TEXT REVIEW  FileHold

il

0 ColibriBoi - |11 ~| A" &7 = -3i=- A @ -:}:@ [UJ b Q > Follow Up~ q

X ' High Importance
Paste v B I U ¥.A- E=E= E£EE= Address Check  Attach Attach Signature Zoom
- - Book MNames File Item = - ¥ LowImportance
Clipboard = Basic Text [F} Mames Include Tags . Zoom Ly
To..
=1
Cc.
Send
Becc
Subject
Attached

5 FH15-Online-Help-System-Guide.dooc 3 ME

Regards,
Renée Sauvé

FileHold Systems Inc

e Send as a link — Links are not as common as attachments when sharing documents;
however, they are the most secure. Those that do not permission in the document
management system to access the file will be unable to open the document via the link. In
other words, in order to access a file via a link, the recipient must also have access to the
document in the system. Both the Web Client URL and FDA link are appended to the body

of the email.

EH®O0 = Untitled - Message (HTML) 7 H - 0 %
FILE MESSAGE ~ INSERT  OPTIONS  FORMATTEXT  REVIEW  FileHold

-] R ] ° M f . > Up -
D TimesNew =12 - A" o = -i= -« A 56: é\n@} L”J U Q I Follow Up Q

I High Importance

Paste « B I U WA E== == Address Check  Attach Attach Signature Zoom
- - Book Mames File Item~ - ¥ LowImportance
Clipboard fa Basic Text ] Hames Include Tags & Zoom ~

Subject

The following document(s) attached to this mail are stored on the FileHold server. Please click on a
link next to the document name to go directly to the document.

FH15-Online-Help-System-Guide (Direct access, Full user interface, Internal FH use only - FDA)

Administrators can configure how emails will be sent from FileHold — either links or
attachments or both.

Emails can be sent either through Microsoft Outlook or via the built in email client in the Web
Client. When emailing from Microsoft Outlook, emails retain the properties of messages
including signature blocks and other added items like legal disclaimers.
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NOTE: Users can also send a link using the Copy URL or Copy FDA Link in the Metadata
pane. The link can then be pasted into an email. See Adding Metadata and File Properties for
more information.

TO EMAIL A DOCUMENT FROM THE FDA

1. Inthe FDA, locate the file you want to email in the Library and click Email [l=2 on the
toolbar.

2. In the Email Attachment Settings window, select one of the following and click OK:
e Attachments to the email — Sends the document as an attachment to the email.

e Links at the end of the email body — Appends the FDA and FOC (web client) to the body of
the email. When a user clicks on the link, the user will need to login to FileHold to access
the document. If the user does not have the correct permissions they will not be able to
access the document.

NOTE: The library administrator can configure the system to send files as either an
attachment or as a link or allow the user to decide. If the function is set to allow the user to
decide then they will be prompted to select an option. If not, the file will automatically be
inserted into the email in the format chosen by the library administrator. See the Library
Administration Guide for more information.

Email Attachment Settings

How would you like to send selected document(s) ?

Send as  |Please select

Please select
AMtachments to the email
Links at the end of the email body m

3. The email message is created in Microsoft Outlook with either the attachment or the links
appended to the body of the email.

TO EMAIL A FILE FROM THE WEB CLIENT

The Web Client uses its own email client to email documents. Documents are emailed from the
email address that the user is logged into the Web Client with.

1. Inthe Web Client, select the documents that you want to send by selecting the check box
next to the document name.

Select Send to > Email or Email and Checkout from the FileHold toolbar.

The FileHold email client page opens. If configured, you can change to send the type of email
sent: as attachments or links.

To... [ FindUserH

cC... | Find User ||

BCC... [ Find User ||

Subject [

Send documents as Attachments to the email E2
Aftachments to the email

Sliachsen Links at the end of the email body  |0/d Express
Bd]  ARMA Chapter Meeting April 28
[i ] Elog - calendar

| g
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Click Send.

TO EMAIL DOCUMENTS FROM MICROSOFT OUTLOOK

Create a new message in Microsoft Outlook.
From the FileHold integration toolbar, click the Add Attachment from FileHold icon.

The FileHold Office Client (FOC) window opens. Select the files that you want to attach.
Click Attach.

The files are attached to the message as attachments.

TO CHECK OUT AND EMAIL A DOCUMENT

1. Locate the file you want to email in the Library and click Check Out and Email = on the

toolbar.

2. In the Email Attachment Settings window, select if you want to send the document as an
attachment or a link and click OK. See the previous section for details.

3. The email message is created in Microsoft Outlook with either the attachment or the links

appended to the body of the email. The document is also checked out of the system and
the status is changed to “checked out”.

= Type: Test (3 documents)
7 fio ¥ p.0.Sauve_FileHol_17032011 Test 0 1 CheckedIn  17/03/2011 3:58PM
7 o ¥ p.0.-ysadm_self-Se_07042011 Test 0 2 heckedTn  (7/04/2011 10:07 AM
AEa 1 | checkedout |
_63\ HY9 ™ « )= Untitled - Message (HTML)
—-/ Message Insert Options Format Text Developer d-Ins Adobe PDF 'Q)
=l & A a7 |||l O =2 B~ {&
=3 (|| B £ W||i= - = | |EE £5| ] ]
Paste — Mames Spellin
- o ||2ZoA === = = 2 § pena
Clipboard ™= Basic Text Include T || Proofing
=1
Subject:
. . - @
The following documents attached to this mai} are stored on the a
FileHold server. Please click on the documentfname to open a web E
<1 || browser and go directly to the document.
P.O.-ysadm Use of 06042011 (View in FDA, View in WebClient)

11.16. LINKING DOCUMENTS

The ability to link documents together is a key feature that helps to organize documents into
logical groups. Links give users quick and efficient access to files that are related to the
document they are working with no matter where the file is stored in the Library. For example,
a master contract document may be linked to its amendments.

The Linked column is visible in most views and shows the total number of documents that are
directly linked to that document. These links may be of either parent or child relationship.
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Linking maintains a parent-child relationship between the documents that are linked together.
In other words, one document, the “parent”, will serve as the main document that all other files,
the “children”, will refer to. When linking two or more documents together the user must specify
the parent document in the linking relationship.

You are able to link documents that are in the same folder or from disparate areas of the library
such as the search results, virtual folder, or document tray.

TO VIEW DOCUMENT LINKS
1. From the Linked column, double-click on the linked number.

2. The Documents linked to Document Name panel opens. All of the documents that are
linked to the selected document are shown.

3. Click on the Up or Down arrow in the Parent/Child column to view the parents (Up arrow)
or children (Down arrow) of the linked document.

- FileHold Product Documentation/ 10 Version/Guides Select View: | My Personal View

CENeIES . NEINEY S L2
Document Name File Name Type Linked Ver Status Last Medified On

7 @ 7__- 2011-02-25,14.21,48.89-00002 2011-02-25,14.21.48.89-00002.PDF FileHold Product 0 1 Checked In 25/02/2011 2:23PM

% © B FileHold_EndUser_Guide_v09 FileHold_EndUser_Guide_v09.docx FileHold Product 0 3 Checked Out 13/03/2011 3:25PM

i O] 1 u

w D E’_‘] FileHold_SystemAdministrator_Guide_v 10 FileHold_SystemAdministrator_Guide_v10.docx  FileHald Product 1 5 Checked In 04/04/2011 3:06 PM

|
Documents Linked to FileHold LibraryAdministrator_Guide new Select View: | Default View - @

Document Name Parent / Child Location Type Linked Ver Status Last Modified On
% @_] FileHold_SystemAdministrator_Guide_v 10 FileHold Product Documentation § 10 Version / G... FileHold Product 1 5 Checked In -~ 04/04/2011 3:06 PM

4 m | »

TO CREATE A LINK BETWEEN TWO OR MORE DOCUMENTS IN THE SAME FOLDER
1. Select the files that are to be linked within a folder. At least two files must be selected.
2. Click Link.

3. Inthe Create Links Between Documents window, select the “parent” document from the
list and click Link. The other files are considered “children” to the “parent” file. The
documents are linked.

TO CREATE LINKS BETWEEN DOCUMENTS FOUND IN A SEARCH
1. Run asearch.
2. Select the documents to link together and click Link. At least two files must be selected.

3. Inthe Create Links Between Documents window, select the “parent” document from the list
and click Link. The other files are considered “children” to the “parent” file. The documents
are linked.

TO REMOVE DOCUMENT LINKS
1. From the Linked column, double-click on the linked number.

2. The Documents linked to Document Name panel opens. All of the documents that are
linked to the selected document are shown.
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3. Select the document and click Remove Link. The link will be removed.

TO LINK DOCUMENTS IN THE DOCUMENT TRAY
1. “Move” all of the documents you want to link into the Document Tray.

2. In the Document Tray, select the files you want to link and right-click to select Link
Documents.

3. Inthe Create Links Between Documents window, select the “parent” document from the
list and click Link. The other files are considered “children” to the “parent” file.

4. The documents are now linked. You can see how many files a document is linked to in the
Linked column.

Document Tray

i D @ FileHold_LibraryAdministrator_Guide_new FileHold Product Documentation / 10 Version / G... FileHold Product

Document Name Location Type Linked Ver Status Last Modified On
Checked In  04/04/2011 3:47PM

1 1
A aL) @ FileHold_SystemAdministrator_Guide_v10 FileHold Product Documentation / 10 Version / G... FileHold Product 1 5 Checked In  04/04/2011 3:06 PM

TO SEARCH FOR LINKED DOCUMENTS

From the Advanced Search screen, select the search criteria Special Fields > Has Link.

2. Select Yes or No from the drop down list and click Search.

11.17. CHANGING THE DOCUMENT VERSION OWNER

Every document has an owner. A document owner is the user who has added that version of
the document into the repository. The owner may need to be changed during the life of a
document.

Organizers and cabinet administrators, for cabinets they own, can change the ownership of a
document version. You can change ownership for one document at a time; it cannot be
performed en masse. Cabinet administrators and higher roles can change ownership en masse
using a utility.

This is useful when certain users need to initiate workflows and the system administrator
permission setting “Ignore document version ownership when initiating workflows or sending
Courier transmissions” is not enabled. For example, in a workflow template, the task can
automatically be assigned to the document owner instead of having to set the user name each
time a workflow is initiated. See Manually Initiating a Workflow for more information.

IApprove Docurnent 'l

Approvers ¥ "
= .

I ¥ Include Document Yersion Cwner I|_ Include WorkFlow Initiator

T 1of% = Force reservation ¥ allow Check out

TO CHANGE THE OWNERSHIP OF A DOCUMENT VERSION
1. Inthe FDA, right-click on the document and select Change Document Owner.
e Inthe Web Client, using the context sensitive menu, select Change Document Owner.
In the Find People window, enter a first and/or last name and click Find Now.

In the search results, select the user and click Select. The ownership of the document is
changed to the selected user.
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11.18. CREATING SHORTCUTS TO DOCUMENTS

Document shortcuts allow you to create and place shortcuts to documents in any folder that the
user has access to in the Library. Users with Publisher role or higher can create shortcuts
between several folders that they have access to.

Creating shortcuts does not make a copy of the document; it is only a link to the original
document location.

WARNING: This functionality may be disabled. Contact your system administrator for
information.

TO CREATE A DOCUMENT SHORTCUT
1. Right click on the document and select Create Shortcut.
2. Choose a folder in the Library that you want to put the shortcut in and click OK.

Select a folder in which you want to create the document shortcut

= E@Library
= EJcanadian Union
[ {SPAccounting
[ (BfDecision Tracking
= EPHR
=010
@Legal
= EJABC Industries
= {EP2009
@ [SiDetroit
= SfiToronto
[JAccounting
CleFax
dPurchﬁsing
[a1zranned Nncument

m

Selected: Library / ABC Industries / 2009/ Toronto / Accounting

| 0K ” Cancel |

3. The location of the document shortcut opens. The document will have an icon with an

arrow on it ] indicating that is a shortcut.

11.19. RENAMING DOCUMENTS
You are able to rename documents in the Library if you have access and have a role of

Publisher or higher.

Note that you cannot rename a document if the schema has a custom file naming pattern
configured. See your library administrator for details.

TO RENAME A DOCUMENT
1. Right-click on a document and select Rename.

e You can also click the Edit link that is in line with the document name in the folder or
search view.

e You can also edit the file name in the Metadata pane.
2. Enter a new name for the document and click Save.
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@ Type: Engineering Drawing (2 documents)

[ia] D wing Engineering Drawing 0 1 Checked In  08/12/2010 2:14 PM Edit
78] kad_drawing_1 Engineering Drawing a il Checked In - 08/12/2010 2:10 PM Save Cancel

11.20. EXPORTING DOCUMENTS IN THE FDA

132

You can export all documents from a cabinet, drawer, folder groups, or folders using the Export
option. You can also export one or more documents from a folder. Once the Export command
is selected, you can select where you want to export the documents on your local machine.

When documents are exported, they are exported with a XML file and a Documents folder
containing all of the exported documents in their native format. The folder name and xml file
that is generated is named with a date and timestamp appended to the end. For example:
documents2015100882302.

The XML file stores the metadata of all the selected documents in a FileHold compatible
format. This allows for the importation of the documents back into the document management
system. For example, if you are exporting documents out of a demo system and importing
them back into a production system.

Exporting can be done by users with a Document Publisher role or higher if they have access
to those areas and are dependent on the role that you have:

Role Can export

Document Publisher, Document Publisher + | Documents that they own.
Delete

Publishers, Publisher + Delete Documents, folder groups, and folders that
they own.
Organizer, Organizer + Delete Any documents, any folder groups and any

folders for the cabinets they have access to.

Cabinet Administrators If not a cabinet owner: documents, folder
groups, and folders that they own.

If a cabinet owner: all drawers, folder
groups, folders, and documents.

Library and system administrators All areas of the library structure and
documents.

TO EXPORT DOCUMENTS FROM THE DOCUMENT MANAGEMENT SYSTEM

1. Right-click on a cabinet, drawer, folder, folder group, folder or document(s) hame and
select Export or Send to > Export.

2. You will receive a warning message asking if you want to continue with the export: "If you
are attempting to export x number of documents. Are you sure you want to continue?"
Click OK to proceed with the export.

3. Browse for the folder location where you want to export your documents and click OK. The
documents are exported to the selected location in the Documents folder along with the
XML file that contains the metadata information for each document. Both folder containing
the documents and the xml file are named documents[date][time] and
documents[date][time].xml, respectively.
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11.21. DOWNLOADING DOCUMENTS TO A LOCAL FOLDER

You can download a copy of document to a folder on your local computer. You can browse to
where you want the document downloaded. Users with a document publisher role or higher
can access this function.

TO DOWNLOAD A DOCUMENT TO A LOCAL FOLDER

1. Navigate or search for the document you want to download.

2. Right-click on the document name and select Send To > Local Folder.
3. Select the folder location on your local computer and click OK.
4

A copy of the document is downloaded to the folder.

11.22. VIEWING VERSION HISTORY

The document management system retains a unique copy of each version of each file as it is
checked out and back into the Library. When a document is checked in and changes have
been made, FileHold automatically creates a new version of the document. FileHold versioning
are simply numbered as 1,2,3,4, and so on. You can create your own numbering system with
document control and version control numbers. See the Library Administration Guide for more
information.

When viewing a list of documents (folder view, search view), only the most recent version of
the document is displayed. The 'Ver' column shows the number of versions of a given
document. You can view previous versions of a file through the version history.

Ir L7

Document Name Type Invoice # Linked Ver Status Last Modified On

& Type: Invoice (3 documents)

@ 2 1nvoice-TP0300018852  Invoice 123445 0

I~

CheckedIn  08/12/2010 12:45PM  Edit
@ &) 1nvoice-TP0300018851  Invoice 12345 0 Edit

Checked In 08/12/2010 8:55 AM
(Checked Out 08/12/2010 12:51PM

© ) Invoice-TP0300029031  Invoice 236512 g

When document is added to the library, it starts as version 1 and is "owned" by the person who
added the document. As the document is checked out and checked back in, that number
increases by 1 and the "owner" of the version changes to the person who has checked the
document in. For example, Paul added a file to the document management system. That file
starts as version 1 and is owned by Paul. Sally has access to the file and decides to check out
the file in order to modify it with the latest report information. Sally checks the file back into the
system. That file is now at version 2 and is owned by Sally.

11.22.1. Viewing Previous Versions of a Document

When viewing the version history of a document, the "History of Document Versions for
Document Name" window opens with the list of the previous versions of the document shown.
The document name, document schema, number of linked documents, version number, status,
last modified on date, owner, and approval status is shown in the view. This view cannot be
modified.

You can get a copy, delete, or email older versions of documents. You cannot check out, check
out and email, or link older versions of documents. In order to work with an older version of a
document, you can reinstate it as the current version (see below) or download a copy and
upload it into the document management system as a new document.
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TO VIEW PREVIOUS VERSION OF A DOCUMENT
1. Select a document and click on the number of versions link in the Ver column.

e Alternatively, click on View all versions in the Version Properties area of the Metadata
Pane.

2. Alist of the previous versions will appear. To go back to the folder list, click Back to
Folder.

11.22.2. Deleting Previous Versions

Library administrators or document owners that have Document Publisher + Delete
permissions are able to delete previous versions of files. Document owners may only delete
the previous version of a document whereas library administrators can delete any version(s) of
the file in the document management system. This means that the versions shown in the
version history list are the ones that have not been explicitly deleted.

TO DELETE A PREVIOUS VERSION OF A DOCUMENT

1. View the Version History of a document. Select the version you want to delete and click
Remove (X).

2. Inthe Delete Files window, select a deletion option:
e Delete only the versions of the files | have selected.

e Delete all versions of each file that | have permission to delete.

22

Delete Files

Whatwould you like to delete?

@ Delete only the versions of the files I selected.

() Delete all versions of each file that I have permission to delete

MNOTE: Thiz delete action cannot be undone. Please contact your administrator
if you have accidentally deleted file{s).

[ oK ] [ Cancel

3. Click OK. The version of the document is removed. If you need to recover the document,
contact your library administrator.

11.22.3. Reinstating a Previous Version as the Latest Version

When viewing previous versions of a document the user can reinstate any of the previous
versions of the document as the latest version. This allows users to work with older versions of
documents such as checking out, initiating a workflow, or linking to other documents. For
example, the current version is 5 but a lot of mistakes occurred in that version and you would
like to restart from version 4. Since you cannot check out version 4, you can reinstate it as the
latest version (which would be 6) in order to check out and work on the document.

TO REINSTATE A PREVIOUS VERSION AS THE LATEST VERSION
1. Select a previous version of a document and click Reinstate as Latest Version.

2. Inthe Reinstate as Latest Version window, select one of the following options:
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134



End User Guide FileHold 15.2

e Yes, reinstate the selected version’s metadata.

e No, keep current metadata values.

Reinstate as Latest Version &]

The selected version of FileHold_EndUser_Guide_v09 will be reinstated as the latest version. Do
you want to also reinstate the metadata?

@ Yes, reinstate the selected version's metadata

() Mo, keep current metadata values

[ QK ][ Cancel ]

" 4

3. Click OK. The document is reinstated as the latest version. In other words, the version
number will increase by 1 with the older document as the latest version.

11.22.4. Viewing Edits to Metadata for Older Document Versions

The system logs all edits to metadata for each version of a document.

TO VIEW EDITS TO METADATA

1. Toview the metadata edits for a version of a document, select the version(s) from the
history of versions list and click Edits to Metadata.

2. Toview a detailed description, click Show Metadata Edits link in the Metadata Change
History view. The metadata pane opens with a list of who made the metadata change,
when it was made and what was changed. Any changes are shown in bold font.

11.22.5. Viewing the Document Usage of Document Versions

You can view how one or more of a document version has been used. The document
management system tracks how a document has been used. For example, if a document has
been emailed, checked out, linked, viewed, and so on you can see what actions have been
taken on a document. You can see who the action performer is and when the action was
performed plus any details pertaining to the action (such as a change in ownership.

Library administrators can also use the Document Usage Log to see how documents were
used.

TO VIEW THE USAGE OF A FILE

1. Inthe Version History list, select one or more (using the CTRL or SHIFT keys) document
versions and click Usage of File.

2. The File Usage for Document Name window opens with a list of all of the actions taken
upon the document versions, which user performed the action and when the action was
performed.

3. To return to the version history, click VVersion History.
11.22.6. Viewing the Sign Off Sheet

The Sign Off Sheet shows a list of all users that either approved or rejected this version of the
document, when they did it and if they signed-off on behalf of someone else.

If this was a multi-document workflow, all documents that were a part of the approval process
will be shown in the sign off sheet.
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TO VIEW THE SIGN OFF SHEET

1. Inthe folder or search view, do one of the following;
e Right-click on a document and select Workflow > View Sign Off Sheet.
e Inthe Version History screen, click Sign-off Sheet.

2. The Sign Off Sheet pane opens below with a list of all users that have approved or
rejected all of the documents in the workflow.

3. Click X to close the Sign Off Sheet pane.
11.22.7. Viewing Workflow Reviews and Approvals

The review and approval history shows each task that was completed in the workflow. The first
level in the workflow shows information about the workflow instance itself. Information includes
the type of workflow (the workflow template name), the name and version of the document,
who the initiator is, when the workflow started and when it is due and if the workflow resulted in
the document being approved or not.

To expand the workflow details, click the + sign in the FDA or the > arrow in the Web Client
next to the document name. In the task details, the percentage completed, the comments or
feedback documents provided by participants, the completion date, the due date, and status
(reviewed or approved) is shown.

The review and approval history can only be seen by those users who have completed the task
and senior administrators.

TO VIEW THE WORKFLOW REVIEWS AND APPROVALS
1. Inthe folder or search view, do one of the following;

e Inthe FDA, right-click on a document and select Workflow > View Review and Approval
History.

¢ Inthe Web Client, click the arrow next to the document name and select Review and
Approval History.

e Inthe Version History screen, click Reviews & Approvals.

2.  The Document Review and Approval History window opens with a list of all workflow
tasks.

3. To print the list of reviews and approvals click Print (FDA only). Note: The report will be
printed exactly how it appears on the screen.

4. To export the list of reviews and approvals click Export (FDA only). When exporting the
report, you can choose to export only the workflow or you can include both the workflows
and the tasks. The report can be exported to CSV or HTML. Note that for the HTML
report, the workflow must be expanded in the Workflow Status Report results to print the
tasks. In other words, the HTML report will be exported to look exactly how it appears on
the screen.

To return to the version history, click Back to Version History.

To return to the folder, click Back to Folder.

11.23. SETTING DOCUMENT ALERTS AND REMINDERS

Document alerts allow you to be alerted of changes that occur to files or folders kept in the
library. For example, a user in payroll subscribes to an Expense Reports folder that notifies
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them of when an expense report needs processing by sending an alert. You can choose to set
alerts on both folders and/or documents. Once changes have been made to either the folder or
the document, you receive an alert in the Document Alerts area of My FileHold. You can set
the type of document or folder changes you want to be notified of and the email address to
send the notifications to in your Alert Preferences.

Document reminders allow you to be reminded of when a document requires attention in the
future. For example, you can be reminded monthly to update expense reports or to review
yearly employee contracts that are up for renewal. Once a reminder comes due, you receive
an email (if configured) and an alert in the Document Reminders area of My FileHold. You can
set reminder preferences in your Alert Preferences.

TO SET AN ALERT ON A FOLDER OR DOCUMENT
1. Right-click on a folder or document and select:
e Alert Me of Changes on a folder.
e Notify Me > Alert Me of Changes on a document.
2. You will receive a message stating that “You have subscribed to be alerted when this file
changes”. Click OK.
If you subscribed to a folder, the folder icon will have an email icon on it 13 AR indicating
you are subscribed to the folder.

3. You will receive email notifications about your alerts if the system has been configured.
You can also view and manage your alerts in My FileHold > Document Alerts. See how to
manage your alerts.

TO SET A REMINDER ON A DOCUMENT

1. Right-click on a folder or document and select Notify Me > Set a Reminder on a
document.

2. In the Add Reminder for Document Name window, enter the date in which you wish to
receive the reminder.

3. Enter the frequency in which you wish to receive the reminder: Once Only, Daily, Weekly,
Monthly, Quarterly, Bi-Annually, or Annually.

Click OK.

You will receive email notifications about your reminders if the system has been
configured. You can also view and manage your alerts in My FileHold > Document
Reminders. See how to manage your reminders.

11.23.1. Managing Alerts and Reminders

Users can view and manage their document subscriptions (alerts and reminders) in the
Document Alerts and Document Reminders areas of My FileHold.

Document reminders are those documents that require attention on a certain date and time
period. You can view your document reminders in My FileHold > Document Reminders. You
may also receive an email notification if your alert preferences are configured to do so.

Document alerts are those documents or folders that have been set to trigger an alert. You can
view your document alerts in My FileHold > Document Alerts. You may also receive an emalil
notification if your alert preferences are configured to do so. Folder alerts are triggered when:

e New documents are added to the folder.
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e Documents are transferred to the folders.

e Documents are deleted from folders.
Document alerts are triggered when:

e A new version of a document is checked in.

e Metadata values are updated.

In order to receive any new alerts on a document, the current alert must be "marked as read".
Once documents are marked as read, then any new alerts are emailed and appear in the
Document Alerts folder.

Users must be subscribed to the folder or document prior to receiving an alert. See Setting
Document Alerts and Reminders.

You can determine which type of alerts you want to receive by setting the Alert Preferences.
See Alert Preferences for more information.

TOMARK AN ALERT OR REMINDER AS READ

1. Goto My FileHold > Document Alerts or Document Reminders and select an alert or
reminder.

2. Click Mark as Read. The alert or reminder is removed from the list.

TO REMOVE AN ALERT OR REMINDER

1. Goto My FileHold > Document Alerts or Document Reminders and click Manage
Alerts or Manage Reminders.

2. In the Manage My Alerts or Manage My Reminders window, select the file or folder you
want to remove the subscription to and click Remove X.

' ™
Manage My Alerts @Iﬂ
ag Llerts
Document Name -« Location Type

£ ar Canadian Union / Accounting Folder Alert
D HolidayPartyBudget Canadian Union / HR / 2010 File Alert
D P.0Q.-Sauve_FileHol_17032011 Product Development [ Guides  User Guide File Alert
[ P.0.-ysadm_chatlog_04032011 Legal / Mortgages / 2010 File Alert
0 SysAdmin Product Development [ Guides Folder Alert

L "y

TODISABLE AN ALERT ON A FOLDER

1. Right-click on a folder that has an alert and select Disable this Alert.
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12.LIBRARY ARCHIVE

The Library Archive is the area where documents that are no longer in use but still need to be
kept for historical record purposes reside. The advantage of archiving is that it keeps your
current documents in the Library and search results uncluttered with old or obsolete
information. Once documents are in the Library Archive, they can still be searched using the
Include Archive in Search check box under the Advanced Search area.

Documents can be archived using two methods:

e Manually archiving. Users with a cabinet administrator role or higher can move electronic
documents manually from the library into the library archive. Cabinet and library
administrators must be the owners of the cabinets in the library archive area in order to
move documents in and out of the archive. You need to enable the permission setting in
the Administration Panel.

e Using a scheduled event to automatically archive documents. See the Library
Administration Guide for more information on scheduled events.

Documents that have been placed in the library archive:
e Leftin the library archive indefinitely.

e Deleted from the library archive using an Event Schedule. See the Library Administration
Guide for more information on scheduled events.

e Moved back into the Library manually should the need arise.

When documents are sent to the archive, the cabinet/drawer/folder group/folder structure is
automatically duplicated. There is no need to recreate the structure. The security settings at
the cabinet and folder levels are also maintained.

TOMANUALLY SEND A DOCUMENT, CABINET, DRAWER, FOLDER GROUP, OR FOLDER INTO THE
ARCHIVE

1. Right-click on a folder and select Archive Folder or document and select Send to >
Library Archive.

2. The documents and/or folders are sent to the Library Archive and the cabinet/drawer/folder
group/folder structure is copied as well.

TOMOVE ARCHIVED ITEMS BACK TO THE LIBRARY
1. Inthe Library Archive, select the document or folder and select Copy or Move.
Select the Move files to a new location in the Library option and click Next.

Select the destination in the Library for the documents or folder and click OK.

DN

At the alert message click OK. The documents and/or folder are moved back to the Library.
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13.USING THE DOCUMENT TRAY

The Document Tray allows users to collect and perform actions on documents that are filed in
various folders throughout the system. The document tray behaves much like a shopping cart
in an e-commerce application in that it provides a temporary holding bin for documents that
users wish to perform actions on.

The Document Tray helps users perform the same actions on documents that are stored in
different folders. All actions available on the toolbar and right click commands are supported in
the document tray including get copy, check out, move/copy, email, link and delete.

NOTE: Documents that are in the Document Tray are not copied or moved. The Document
Tray is only making reference to the documents located elsewhere in library.

TO OPEN THE DOCUMENT TRAY

1. In FDA, click on the Document Tray icon g on the lower right side of the screen.
2. Inthe Web Client, click Document Tray located at the top of the hierarchy panel.

€ FileHold

Document Tray

»

= & My FileHold
1y Favorites
[ checked Out Documents

m

[ Document Alerts

The Document Tray opens at the bottom of the screen. In FDA, you can adjust the size of
the Document Tray using the slider arrow. The Document Tray in the Web Client is self-
adjusting. It will expand to fit the documents automatically.

Document Tray Select View: | Default View

Document Name Location Type Linked  Ver  Status  LastModified On
7 @ ] Filerold_LibraryAdministrator_Guide_new FieHold Product Documentation / 10 Version /G, FileHold Product 0 11 CheckedIn  04/04/20113:47PM
5 @ D FileHold 02 logo FileHold Product Documentation / 09 Version [M... FileHold Preduct 0 1 Checked In  17/11/2010 4:09 PM

I
| g Document Tray '@ Default View 3
|:| Document Name Location Iype Linked Ver Status Last Modified On
= R ',E Extended_Health_Booklet Corporate Policies - Self-Service Portal / Human R... Policy 0 1 CheckedIn J25/2011 2:46:23 PM
1l QR ',E Medical_Claim_Form Corporate Policies - Self-Service Portal / Human R... Policy 0 1 Checkedin 25/2011 2:46:24 PM

Document Tray in Web Client

To ADD DOCUMENTS TO THE DOCUMENT TRAY

1. There are many ways to send documents to the FileHold to the Document Tray. Do one of
the following:
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e In FDA or Web Client, select the document you wish to add to the document tray. Right-
click on the file and select Send to > Document Tray. You can select multiple documents
and send them to the Document Tray en masse.

e Inthe Web Client, place a check mark next to the documents you want to move into the
Document Tray and select Sent To > Tray.

e InFDA, drag and drop document(s) from one or more folders and into the Document Tray.

WARNING: You cannot drag and drop documents in the Web Client.

TO CLEAR FILES FROM THE DOCUMENT TRAY

Removing documents from the document tray does not delete the file from the library. The
document will remain in the same location.

1. Select the documents you wish to remove from the tray and click Clear.

€ FileHold »
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14.USING THE DOCUMENT VIEWERS

Viewers have many user features and many benefits that increase productivity and save
companies money. Viewers come included with each registered user license and assigned to
registered users by the system administrator. Different viewers are available for use with
FileHold:

¢ PDF/Image Viewer (FDA only)

e FileHold viewer level 1 (web and FDA viewer)

e FileHold viewer level 2 (web and FDA viewer)

If a user is assigned a FileHold viewer level 1 or level 2 viewer license, then they are also able
to use the PDF/Image viewer in the FDA.

Viewer behavior can be configured in the User Preferences > Viewer tab.

NOTE: Starting in 2017, Brava viewer licenses are no longer available for new FileHold
purchases. Previously purchased Brava viewer licenses are still available for use in the
FileHold Desktop Application. See the Knowledge Base for more information on how to use the
Brava viewer.

14.1. FULL AND PARTIAL SCREEN VIEWS IN THE FDA

The interface of the FileHold Desktop Application (FDA) can be modified to accommodate
seeing more information in the library tree and metadata pane when the viewer is in use.

Both the library tree and the metadata pane can be set to “full” or “partial’ view mode when the
viewer is open. Full mode extends the panes to the bottom of the screen where partial mode
decreases the pane size to the same level as the viewer pane. This full mode feature allows
users to look at more information in these areas while still viewing a document.

The Full and Partial buttons appear in the Library Tree and Metadata Pane only when the
viewer is activated. Full mode is useful when looking at a document and entering metadata at
the same time.
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The FDA with the library tree in "partial” mode and metadata pane in “full” mode

14.2. PDF/IMAGE VIEWER

The PDF/Image viewer supports the following file formats:
e PDF
e TIFF (single or multi-page)
e Image files (jpg, png, gif, bmp)

The PDF/Image viewer can be used in the FileHold Desktop Application and allows users to do
a number of actions on files.

Action PDF/Viewer Function

e Reorder pages using drag and drop

e Insert a PDF or TIFF file into the current PDF or TIFF file.

e Drag and drop pages between PDF and TIFF documents (of the same
format) if the option to open documents in separate tabs is enabled. This
can be enabled in the User Preferences > Viewer tab.

e Delete pages

e Publish as a PDF as a new document, a new version of a document, or as
a local document.

e Open multiple documents at a time. Each file is shown on a separate tab.
Note that the tabbing feature needs to be enabled in the User Preferences
> Viewer tab.

¢ View thumbnails pages of a document. The thumbnail pane can be

expanded or collapsed using a button on the toolbar. =

e Change the orientation of the thumbnail pane. It can be set to the top,
bottom, left or right side of the viewer pane. The orientation of the pane is
set in the User Preferences > Viewer tab.

e Select multiple pages of the document via the thumbnails.

e Undock the viewer so it is in its own window.

Modify a PDF
or TIFF file

Modify how the
file is viewed

e Pages can be rotated 90 degrees clockwise or counter-clockwise. 0 A

e The size of the image can zoomed and can be set to a fixed zoom level.

2, @,

For example, 100%, 150%, page width and so on. =

e Scroll between pages. . - 16 Qb

e Append an image to the current image file.

¢ Insert an image from one image file to another image file using drag and
drop.

e Save the image file as a jpeg file or publish as a TIFF file.

e Delete images.

e Print the document.

e Open documents in FileHold or from your local computer.

e Open documents in the Brava viewer (if you are assigned a license).

Modify an
image file

Other actions

April 2017 < Hold 143



FileHold 15.2 End User Guide

Pkt 14_Bedngun-cuicie £3| "
Fie e [ \.—f\.

Zoom

wl b H 4 ¢ H 14 o4y |, s, .08 8 1_
9. PDF pppisacyTRA" MON | \
Seroll Yy {" Destepage I l o .
through Thes, aion pr AT mang' n‘wﬂs ‘o Ehe valses
\ pages eriorod T Fekds of Rotate ‘aubomaticy, pane mobadata felds of a
M 4 schama pageE of W i

—’ - ~
POF ferms contain felds'y, A out using the e AIChe Acrobat Reador
Softean, In oodar 0 croate e ___erfou will noed soltware such as Adaba Acrobal
Frofessional. You cannol create FUR fomms using thi document management softwane,

The POF form axtraction mile i creabsd in the FilaHold Desktop Appheation (FDA)L The rule is
basad on tha PDF farm lemplate used. Multiphs PDF extraction ruled can axisl. This means
that you can have as many PDF form eaftraction nules as needed. Bath “diassic” and Adoba
XML Foems Archilecture [XFA) ane supported

Thi: matadata is extracted automatically whan tha firs! version of the form is added 1o tha { Thumbead | | !
documant management system. In subsoeguond vensions, the matsdata will nesd 1o be updated agEs wik | n
maniially OrEnilabon NI
el i ighl | [ E——
L™
S (-

11 .p

If a user is assigned a Brava viewer license, they can also use the PDF/Image viewer with the
Brava viewer, with the Brava viewer being the default viewer. They can use the function Open
to Reorder Pages/Images to open the document in the PDF/Image viewer. Note that starting in
2017, Brava viewer licenses are no longer available for new FileHold purchases. Previously
purchased Brava viewer licenses are still available for use.

NOTE: If you have the "Automatically open Document in Viewer" options selected in the User
Preferences, the documents will only be opened in a single pane as you scroll through the
documents.

14.2.1. Modifying a PDF or TIFF File

The following actions can be taken on a PDF or TIFF file:
e Reorder pages using drag and drop
e Insert a PDF or TIFF file into the current PDF or TIFF file.

e Drag and drop pages between PDF and TIFF documents (of the same format) if the option
to open documents in separate tabs is enabled. This can be enabled in the User
Preferences > Viewer tab.

e Delete pages

¢ Publish as a PDF as a new document, a new version of a document, or as a local
document.

To USE THE PDF/IMAGE VIEWER TO REORDER PAGES OR IMAGES

1. Right-click on a PDF or multiple page TIFF file and select Open to Reorder
Pages/Images. The document opens in the viewer.

2. Move the pages around using the drag and drop method.

TO DRAG AND DROP A PAGE BETWEEN TWO FILES

1. Have two PDF or TIFF files open in separate tabs in the PDF/Image viewer. In order to do
this, you will need the "Open documents in the Document Viewer using separate tabs"
option selected in the User Preferences > Viewer tab.

2. Select one or more page from the originating document.
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3. Drag and drop a page from one tab to the other tab and select a location for the page(s) in
the thumbnail view. A black bar is shown where the page(s) will be moved to.

To PUBLISH AS A PDF DOCUMENT
1. After modifying a PDF document in the PDF/Image viewer, go to File > Publish to PDF.
2. Select one of the options:

e Save this published version as a new local document - Saves the document to your local
computer. Save or open the file to the local computer.

e Save this published version as a new document in FileHold - Saves the document as a
new document to the library. If saving as a new document in the library, set the folder
location for the document and fill out any related metadata and click Submit.

e Create a new version of the file you are publishing — Creates a new version of the
document. A new version is automatically created.

TO DELETE PAGES FROM A FILE

1. Select the page or pages you want to delete in the thumbnail images. You can multi-select
pages using the CTRL or SHIFT keys.

2. Goto Edit > Remove Pages or click the Remove Pages button.

TO INSERT A PDF OR TIFF FILE INTO A PDF OR TIFF FILE

1. Open the document to be modified.

2. Select the page in the thumbnail view that you want to insert pages before or after the
currently selected image.

3. Goto Edit > Insert File Before or Insert File After.

4. Select the file to be inserted. It can be a local file or a file from the FileHold library. The file is
inserted into the current document.

14.2.2. Modifying an Image File

The following actions can be taken on image files (jpg, gif, png, bmp):
e Append an image to the current image file.
e Insert an image from one image file to another image file using drag and drop.

e Save the image file as a jpeg file or publish as a TIFF file.

TO INSERT AN IMAGE FILE INTO AN IMAGE FILE
1. Open the document to be modified.

2. Select the page in the thumbnail view that you want to insert pages before or after the
currently selected image.

Go to Edit > Insert File Before or Insert File After.

4. Select the file to be inserted. It can be a local file or a file from the FileHold library. The file
is inserted into the current document.

€ FileHold e
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TO DRAG AND DROP AN IMAGE FILE INTO ANOTHER IMAGE FILE

1. Have two image files open in separate tabs in the PDF/Image viewer. In order to do this,
you will need the "Open documents in the Document Viewer using separate tabs" option
selected in the User Preferences.

2. Drag and drop an image from one tab to the other tab.

TO SAVE A PAGE AS AN IMAGE FILE (JPEG)
1. After modifying a PDF document in the PDF/Image viewer, go to File > Save Page As.

2. Save the current page to your local machine as a jpeg file.

14.2.3. Other Actions of the PDF/Image Viewer

14.3.

TO PRINT A DOCUMENT

e Goto File > Print or click the Print button.

TO UNDOCK THE VIEWER

e Click the Undock Viewer button.

TO CLOSE A DOCUMENT IN A TAB
e Click the X in the tab or go to File > Close File.

NOTE: If you have the "Automatically open Document in Viewer" options selected in the User
Preferences, the documents will only be opened in a single pane as you scroll through the
documents.

FILEHOLD VIEWER LEVEL 1 AND 2

The FileHold level 1 and 2 viewers allow users to view image files (jpg, jpeg, png, bmp, gif, tif,
tiff), Microsoft Word (docx), and PDF documents in both the Web Client and FileHold Desktop
Application (FDA). Each registered user account comes standard with a FileHold level 1
viewer. A system administrator can change this to a level 2 viewer in the user account, if
purchased.

See the table below for features support by the level 1 and level 2 viewers.

Feature Level 1 Level 2

Open multiple documents X

Publish document to local computer

Publish document to FileHold

Print document

X[ X| X| X
X| X| X| X| X

Automatically open documents in folders and search results

Basic annotations and markup X

With the FileHold viewer, some features of some of the supported file formats are not
supported for viewing. For example, if viewing docx type files, generally only plain text is
properly rendered. Other items such as tables, images, word art, headers, footers, and
footnotes may be partially shown or not shown at all. Only internal document links work in the

146

’ HOld April 2017



End User Guide

FileHold 15.2

FileHold Viewer. External links, while showing as hyperlinked, do not work. Itis recommended
that you test your documents in the viewer in order to determine how your documents are

rendered.

NOTE: The help link for the FileHold viewer in the FDA does not work on Windows Server

2012R2.

To USE THE FILEHOLD VIEWER

1. Inthe FDA or Web Client, select an image file (jpg, png, bmp, gif, tiff), Microsoft Word

(docx), or PDF document.

2. Using the contextual menu, select View Document. The document is opened with
thumbnails displayed on the left side of the viewer. The currently selected page is

displayed in the main part of the viewer.

3. To manipulate the pages, use the toolbar buttons to zoom in and out, navigate between
pages, and close the viewer to return to the list of documents. See the table below for a list

of functions and descriptions.

Function

Description

|""'|
+
Zoom In

Zooms in on the image.

Zoom Out

Zooms out from the image.

, , B Adjusts the image on the screen to fit the full
Fit to Width width of the image.
| w Adjusts the image on the screen so the entire
L.
Best Fit image is displayed.
. Shows the full image size.
Full Size :

Close Viewer E:]

Closes the viewer and returns to the folder.

Previous Page

Previous image is displayed in the document.

Next Page

Next image is displayed in the document.

<page number> :2

Enter a page number to show the image.

Print%

Prints the document.

Submit

Add document as a PDF into the FileHold
repository as a new document, as a new
version, or save as a local copy of the
document.
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TO USE ANNOTATIONS FOR THE FILEHOLD VIEWER LEVEL 2

1. Inthe FDA or Web Client, select an image file (jpg, png, bmp, gif, tiff), Microsoft Word
(docx), or PDF document.

2. Using the contextual menu, select View Document. The document is opened with
thumbnails displayed on the left side of the viewer. The currently selected page is
displayed in the main part of the viewer.

3. To annotate the pages, select the Annotations icon . To return to the thumbnails view,
|
select the Thumbnails icon HA.

4. Select the annotation option, fill out the related annotation properties, and then draw on the
screen where the annotation is to be placed. Use the following table to learn more about
annotations:

Function Description

Allows you to add a rectangle highlighter
\& annotation onto a document. A number of
highlighter properties are available to set the

Highlighter colour and rotation.

Allows you to draw a freehand highlighter
annotation onto a document. A number of
Freehand highlighter — — freehand highlighter properties are available
to set the colour, rotation, and border width.

Allows you to add a rubber stamp annotation
onto a document. A number of stamp

Rubber stamp — properties are available such as font, colour,
opacity, rotation, borders, radius, and line
styles.

Allows you to add a rectangle annotation

onto a document. A number of rectangle

Rectangle properties are available to set the colour,
opacity, rotation, borders, radius, and line
styles.

Allows you to add an ellipse annotation onto
' a document. A number of ellipse properties
~— are available to set the colour, opacity,
rotation, borders, and line styles.

Ellipse

Allows you to add a line annotation onto a
document. A number of line properties are
Line available to set the colour, start and end cap,
opacity, rotation, borders, and line styles.

Allows you to add a connected line
) j\ annotation onto a document. A number of
Connected lines connected line properties are available to set
the colour, opacity, rotation, borders, and
line styles.
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Function Description
Allows you to draw a freehand annotation
N d A number of freehand
Freehand onto a document. A number of freehan

properties are available to set the colour,
opacity, rotation, borders, and line styles.

e

Arrow

Allows you to add a line arrow annotation
onto a document. A number of arrow
properties are available to set the arrow
height, width, colour, opacity, rotation,
borders, and line styles.

Ruler @

Allows you to add a ruler annotation onto a
document. The total length of the line is
displayed. A number of ruler properties are
available to set the font, font size, colour,
opacity, rotation, borders, and line styles.

Polygon ruler EE]

Allows you to add a polygon ruler annotation
onto a document. The total length of the
polygon is displayed. A number of polygon
ruler properties are available to set the font,
font size, colour, opacity, rotation, borders,
and line styles.

T]

Text

Allows you to add a text annotation onto a
document. A number of text properties are
available to set the measurement unit,
colour, position, justification, opacity,
rotation, borders, and line styles.

(=

Sticky note

Allows you to add a sticky note annotation
onto a document. A number of sticky note
properties are available to set the font, font
size, colour, position, justification, opacity,
rotation, borders, and line styles.

To PUBLISH AS A PDF DOCUMENT

1. Click Submit .

2. Select one of the options:

e Save this published version as a new local document - Saves the document to your local
computer. Save or open the file to the local computer.

e Save this published version as a new document in FileHold - Saves the document as a
new document to the library. If saving as a new document in the library, set the folder
location for the document and fill out any related metadata and click Submit.

e Create a new version of the file you are publishing — Creates a new version of the
document. A new version is automatically created.

3. Click OK.
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NOTE: Closing the FileHold Viewer in the FDA will not remove any annotations. In order to clear
annotations on the document, close the X on tab.

Document Viewer

20170224-1031 Q)|

20170224-1031

<

BB Thumbnails
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15.SETTING PREFERENCES

Preferences and Settings allows you to modify the document management system to suit your
personal needs. You can modify your password, document list views, document alerts,
workflow (if purchased), and FastFind preferences (if purchased).

Some, none, or all of these settings may be determined and/or enforced by your system
administrator. See your system administrator for details.

TO SET PREFERENCES

1. Do one of the following:

e InFDA, goto File > Preferences and Settings.

e InWeb Client, right-click on My FileHold to access View, Alert and User preferences.
Right-click on Reviews & Approvals to access the Workflow preferences.

e Inthe Web Client, go to Administration Panel > My FileHold.

2. Set the following preferences:

e View Preferences

e User Preferences

e Alert Preferences

e Workflow Preferences

e FastFind Preferences (FDA only)

e Reset My Password (Web Client only)

15.1. USER PREFERENCES

The User Preferences allows you to edit your contact and password information. This includes
the users account information, contact information, company information as well as default

language preferences.

The General tab contains user’s account setting information. The Contact and Company tabs
contain user contact and company information respectively. The Advanced tab allows the user
manage the functionality of the system. Some, none, or all of these settings may be
determined and/or enforced by your system administrator. See your system administrator for

details.

TO SET THE USER PREFERENCES

1. In FileHold Desktop Application (FDA), go to File menu > Preferences and Settings >

User Preferences.

e Inthe Web Client, right-click on My FileHold and select My User Preferences.

e Inthe Web Client, go to Administration Panel > My FileHold > User Preferences.

2. The General tab contains the user account information. Use the following table to fill out
the information in the General tab:

Field Name

Description

First Name

Your first name.

April 2017

< Hold

151




FileHold 15.2

End User Guide

Field Name

Description

Last Name

Your last name.

User Logon Name

You are not able to modify your user name in
the User Preferences. Contact your system
administrator if you need to change your user
name.

Source

Local FileHold account or a domain account
(synchronized with Microsoft Active Directory).

Default Language

Select the default language. This is typically
English. If the language you want is not
available please contact your system
administrator and ask them about obtaining
additional language packs from FileHold
Systems.

Default page after log in (Web Client
only)

Determines the window that is displayed after
log in: Blank, Simple Search, Advanced Search,
My Tasks, or Dashboard (if permitted. See your
system administrator for details).

Edit metadata upon Check In Action
(Web Client only)

When enabled, the metadata pane is displayed
in edit mode after a new version is checked in.
This allows the user to enter new metadata. If
disabled, the user can check the document back
in without editing metadata.

Clear required metadata fields upon
Check In (Web Client only)

When enabled, any required fields in the
schema are automatically blanked out (current
value is deleted) when checking in a new
version of a document. The users are forced to
fill in the required field prior to checking in the
document.

Number of expanded drawers (Web
Client only)

The number of drawers that can be
simultaneously expanded in the library tree can
be set. The lower number of expanded drawers
allows for a faster page loading time due to the
lower number of permissions that needs to be
calculated before displaying the library structure
to the user. The last drawers that were opened
by the user are preserved when the library is
refreshed. The default is 3.

Reset all “Don’t Show This Message
Again” reminders (Web Client Only)

If you have selected any “don’t show this
message again” check boxes in various
windows, you can have them reappear by
clicking Reset.

Change Password (FDA only)

Click Change Password to change your
password if you are using a locally-managed
account. In the Set Password, enter your old
password and a new password twice and click
OK. NOTE: If you are using a domain user
account (Active Directory), you will not be able
to change your password. See your system
administrator.
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Field Name

Description

Default Local Working Folder (FDA only)

This is where your working documents are
stored on your local machine. This is the path to
where documents are checked out and
downloaded. To change the path, click Browse
and select the new working folder location.

NOTE: For the Web Client, documents are
downloaded to the location that is set in your
web browser settings.

3. Inthe FDA only, in the Advanced tab, select the settings you want enabled. NOTE: These
options may be locked down by your system administrator.

Field Name

Description

Default page at start-up

Determines the window that is displayed
after log in: Blank, Simple Search, Advanced
Search, My Tasks

Format of document imports

Select one of the following options:

e QuickScan Pro — select this option if you are
using the EMC Captiva QuickScan Pro
scanning software.

e Capture — select this option if you are using
SmartSoft Capture scanning software.

e Both — select this option if any users could
be using both QuickScan Pro and Capture
at the same scanning station, for example
sharing inboxes and imports, or using the
Outlook Watched folder and Capture at this
computer.

If you are using the “Both” option, ensure
that folder you select for the import profile
contains only one type of XML files. The rule
also applied for any of its subfolders.
Capture and QSP XML files cannot coexist
in the same folder tree.

Number of expanded drawers

The number of drawers that can be
simultaneously expanded in the library tree
can be set. The lower number of expanded
drawers allows for a faster page loading time
due to the lower number of permissions that
needs to be calculated before displaying the
library structure to the user. The last drawers
that were opened by the user are preserved
when the library is refreshed. The default is
3.
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Field Name

Description

Enable Click To Tag

When enabled, the Click To Tag button
appears in the metadata pane and allows
you to “click” or “rubber band” text, numbers,
dates, etc. on the screen and inserts the
value into the metadata field of the schema.

If disabled, the Click to Tag button does not
appear in the metadata pane.

Show Welcome Screen at Startup

Displays the FileHold Welcome Screen after
you start the FDA: Blank, Simple Search,
Advanced Search, Inbox, My Tasks, or
Calendar.

Prompt me for download location when |
make copies of files

Allows you to select a location on your local
machine to save your copied files.

Prompt me for download location when |
check out files

Allows you to select a location on your local
machine to save your checked out files.

Prompt me to remove files when sending
them from the Inbox

A prompt will ask you if you want to remove
the files from your local machine when
sending them from the Inbox.

Prompt me to clean up my FileHold working
folder when | close the FileHold Desktop
Application

A prompt will ask you if you want to remove
the files in your working folder on your local
machine when you exit out of FDA.

By default close documents that | add/check
in to FileHold

Documents will be closed in their native
application when it is checked in or added to
the Library.

By default delete documents that | add to
FileHold

Documents will be deleted from the working
folder on your local machine after they are
added to the Library.

By default delete documents that | Check In
to FileHold

Documents will be deleted from the working
folder on your local machine after they are
checked into the Library.

Auto-send documents to Auto-Tagged
folders

Documents in the Inbox will be automatically
sent to their location in the Library if the
folder is Auto-tagged. You will not need to
click the Auto-File button.

Auto-send documents after completing
metadata

Documents in the Inbox will be automatically
sent to their location in the Library after the
metadata has been sent. You will not need
to click the Send or Send All button.

Move to recycle bin instead of permanently
deleting

Documents that are set to be deleted after
checking in or adding to the Library will be
moved to the Recycle Bin on your local
machine instead of being deleted.
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Field Name

Description

Out messages

Enable Smart Check In and Smart Check

Smart messages are the messages that
appear when checking in and out a
document using Microsoft Office
applications. This setting is enabled by
default. To turn off "Smart Messages", clear
the check box. Examples of smart messages
that are displayed in Microsoft Office
applications from FileHold are:

e When saving and closing a document
without checking in a checked out
document.

e When getting a local copy of a document,
making edits, and saving without checking
out the document.

e When checking out and opening a
document and close the document after
making no changes.

e When opening and checking out a
document (CTRL+double-click), and closing
the document without making any changes.

Edit metadata upon Check in action

When enabled, the metadata pane is
displayed in edit mode after a new version is
checked in. This allows the user to enter new
metadata. If disabled, the user can check the
document back in without editing metadata.

In

Clear required metadata fields upon Check

When enabled, any required fields in the
schema are automatically blanked out
(current value is deleted) when checking in a
new version of a document. The users are
forced to fill in the required field prior to
checking in the document.

reminders

Reset all “Don’t Show This Message Again”

If you have selected any “don’t show this
message again” check boxes in various
windows, you can have them reappear by
clicking Reset.

4. Inthe Viewer tab (FDA only), select the check boxes next to the features to enable. Note:
These options may be locked down by your system administrator.
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Field Name

Description

PDF/Image viewer only

Orientation
of thumbnail
view

Select the position of the thumbnails in the PDF/Image viewer: Top, Bottom,
Right or Left.

PDF/Image viewer and Brava viewer

Automatically

Any selected document in the Inbox will open in the Viewer automatically. If

open in the this option is selected, only one tab will be opened at a time. This prevents
Viewer users from opening several tabs at a time and using up a lot of system
selected memory in the process.
?ocument n NOTE: Starting in 2017, Brava viewer licenses are no longer available
nbox ; - ;
for new FileHold purchases. Previously purchased Brava viewer
licenses are still available for use in the FileHold Desktop Application.
Open Documents will be opened in multiple tabs in the viewer. NOTE: This option
documents in | cannot be selected in conjunction with the "Automatically open in the Viewer
the selected document in folders and search results" or "Automatically open in
Document the Viewer selected document in Inbox" options.
Viewer using
separate
tabs
Allow A single document can be opened several times in multiple tabs using both
opening one | Brava and PDF/Image viewers. Note that "Open documents in the Document
documentin | Viewer using separate tabs" needs to be enabled in order to enable this
multiple tabs | feature. This feature is useful in multiple monitor situations.
All viewers

Automatically
open in the
Viewer
selected
document in
folders and
search
results

Any selected document in the folder view or search results will open in the
Viewer automatically. If this option is selected, only one tab will be opened at
a time. This prevents users from opening several tabs at a time and using up
a lot of system memory in the process.

5. In the Contact Information tab, enter your personal contact information. This is for both the
FDA and the Web Client. This information may be filled out if you are an Active Directory

user.

6. Inthe Company tab, enter your organization information. This is for both the FDA and
Web Client. This information may be filled out if you are an Active Directory user.

7. Click OK.
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15.2. VIEW PREFERENCES

You can create or modify “views” in order to suit how you want documents displayed. There
are several different view types, such as the folder list, checked-out documents, Inbox,
Document Tray, and so on. You can customize each view to display specific columns and
determine how you want the view sorted and grouped. The views can be made private or
public which allows other users to access them. Users can also set a default view which
displays the documents according to the default type unless otherwise specified. Changes to
your view settings will not affect how other users view their folders or lists.

The following is an example of a folder list view. You can change your view type by selecting
an option from the Select View drop-down list.

- Product Development/Guides/User Guide Select View: My Personal View
on (Y «f - SE e Default View
Document Name Type Linked Ver Status Last Modified On ’ My Personal View
i e E“"_] FileHold_EndUser _Guide_v03 Quality Assurance a 1 Checked Out  14/03/2011 4:06 PM
7 B #] p.0.-Sauve_FileHol_17032011 Test 0 1 Checked In 17/03/2011 3:58 PM Edit
7 B B p.0.-ysadm_Self-Se_07042011 Test 0 2 CheckedIn  07/04/2011 10:07 AM Edit
a

I
=

"7 0 M) P.0.-ysadm_Use of 06042011 Test Checked In 06/04/2011 3:45 PM Edit

The benefit of customizing the views is that the user is able to see key information on a file
without having to open up the file or view its metadata. For example, if a user is working in an
engineering department and the majority of documents to be stored in the library will have a
'Part Number' metadata value associated with it, then the part number field can be added as a
column in the users folder display.

The number of documents that are displayed per “page” is set in the view preferences. In the
FDA, there can be 5 to 1000 documents displayed per page. In the Web Client, there can be 5
to 30 documents displayed per page. The page numbers are shown in the right-hand top and
bottom areas of the screen. The number of documents that are shown in the FileHold Office
Client window when using the Microsoft Office Add-Ins can also be configured.

- Training and Support/FieHold 14/ Training Materials Select View: My Personal View

Document Name Document Schema Linked Ver w Status Last Modified On
= Document Schema: Application (2 documents)
77 @ E travelauth Application 0 1 CheckedIn 12/17/20153:33PM Edit
77 G [E 9371 Application 0 1 CheckedIn 12/17/20153:34 FPM Edit

I \ » My Personal View

Training and SupportFileHold 14/Training Materials ‘@'

Document name Document schema Linked Ver Status

& @E 1 Bicycle Manuals ] 1 CheckedIn
7 @ ll_—] 131120082449 Schema with all md fisld types 0 1 CheckedIn
o @ li_'] 131208134128 Credit Card 1 Checked In 12M7/2015 3:30:52 PM Edit

Library administrators can create views and set them as the system default for all users. They
can also reset the personal views of other users to a global view of their choice. They can also
assign default views to cabinets, folders, virtual folders, and saved searches.
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View settings are exclusive to the user, however Views can be made public allowing other
users of the document management system to use them if you are an Administrator. Changes
to one users view settings will not affect how other users view their folders or lists.

NOTE: If you are logged in as an Administrator and are modifying a Public View (such as
adding or removing columns), the document management software will automatically create a
new Personal view using the changes made to the existing Public view.

TO SET YOUR VIEW PREFERENCES

158

1. Do one of the following :

e InFDA, goto File > Preferences and Settings > View Preferences.

e InWeb Client, right-click on My FileHold and select View Preferences.

e Inthe Web Client, go to Administration Panel > My FileHold > View Preferences.

2. In My Global View Preferences window, use the following table to fill out the form.

Field

Description

Select View
Type

Select the view type you want to customize: Checked Out Documents,
Document Alerts, Document Reminders, Document Tray, Folder List,
Inbox, Linked Document List, My Favourites, My Workflow Tasks,
Recently Accessed, Recently Added, Search Results, Workflow
Documents (Show Documents pane), and Virtual Folder.

For example, Checked out Documents will customize the My FileHold >
Checked out Documents list. Inbox will customize the Inbox view.

Select View

Select a view from the list if it already exists for that view.

Add

Click Add to create new view. Enter a view name and select if it is a
Personal or Public view and click OK. A personal view will only visible to
you while public views can be seen by all users. Only Administrators can
create public views.

Edit

Click Edit to modify the name of the view. Rename the view and/or select
a view type (personal or public) and click OK.

Delete

Click Delete to delete a view. Click OK at the confirmation message. The
view is deleted.

Set as System

When logged in as Library or system administrator, you can add a new

Default View System Default View for the system. When creating a hew System
Default View, you must make the new view a Public view. Then click Set
as System Default View. Now all users will see this view when logging
onto the system.

Set as My When creating a new view, you can set it as your own default view. This

Default View view overrides the System Default View in any of the view types that do
not have a designated view applied to them.

Create My Create a personal view for a view type not seen by any other user such

Personal View | as personal search view or personal virtual folder.

Current Lists all the column names, their descriptions, and the order they are

Fields/Columns | sorted across the screen.

used in this .

view To reorder the columns, select a number from the drop-down list.

To remove a column, click the X.
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Field

Description

Add a field
(column) to the
view

Select a metadata or system value to add to the view from the list and
click Add Field.

Once you have added a field, you can sort the order of the columns in the
Order Column.

Sort view by Select the column you want to sort by from the drop-down list and select if
you want the documents displayed in ascending or descending order.
Group by Select the check box and select how you want the documents grouped.

Select a descending or ascending order. This is only available in the FDA.

In the example below, the documents are grouped by Document Schema:

- Training and Support/FileHold 14/Training Materials

Select View: My Personal View

1231

Document Name  Document Schema Linked Ver Status Last Modified On

& Document Schema: Application (2 documents)

@[5 9371
7 @ travelauth

CheckedIn  12/17/2015 3:34 PM Edit
Checked In  12/17/2015 3:33 PM Edit

Application 0

Application 0

& Document Schema: Bicycle Manuals (48 documents)
77 @ E 131119101407
7 @[x 131120092321
7 @ E 131120092321
@ T 2013-02-27.13.27.05.95-00002

Bicyde Manuals

Checked In  12/17/2015 3:34 PM Edit

Bicycle Manuals

Checked In  12/17/2015 3:30 PM Edit
Checked In  12/17/2015 3:34 PM Edit
CheckedIn  12/17/2015 3:33 PM Edit

0
0
Bicyde Manuals 0
0

Bicycle Manuals

Show x items in

Enter the number of documents you want displayed in the Web Client.

this view (Web | Enter a value from 5 to 30.

Client only)

Number of Enter the number of documents you want displayed “per page” in the
documents per | FileHold Desktop Application. For example, if you have 4000 documents
page — Main in a single folder, then 500 documents will be shown on a “page”. It is
FDA window recommended that this value be set to 500.

(FDA only)

Number of Enter the number of documents you want displayed “per page” in the
documents — FileHold Office Client window. It is recommended that this value be set to
FOC windows 20.

(FDA only)
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My Global View Preferences 2=

Select View Type:

Manage Folder List Views

Select View: My Personal View - Add | Edit Delete |

This is your personal view. Itis selected as your default view,

Set as System Default View | Reset to System Default View | Create My Personal View |

Current Fields (Columns) Used in This View

Column Name Column Description Order

Document Name A Document Name system field, 1 ﬂ

Document Schema A Document Schema system field. 2 j

Linked A Linked system field. 3 j

Ver A Ver system field. 4 ﬂ
I |status A Status system field. 5 j
' |LastModified On A Last Modified On system field. [ j
i

Meodify My Personal View:

Add  field (column) to this view  [Accepted / Refused >| _ AddField |
Sort view by I\fer j in IDescending j order
v Group by IDocumentSchema j in I.-'-\scending j order

! Number of documents per page

' Main FDA window: ISD 3: {recommended values from 5-100)
FOC windows: I 20 3:
OK I Cancel Apply |

3. Click Apply or OK to save the view settings.

15.2.1. Creating Ad-Hoc Views

You can modify any view by adding or removing columns, grouping documents, expand or
collapse groups, or reorder columns “on the fly”.

TO CREATE AD-HOC VIEWS
1. In any view, right-click on a column header and select one of the following:

e Group By — Group documents by document name, type, linked, version, status, or last
modified date.

e Add/ Remove Columns — Add or remove columns from the view. All system values and
metadata values can be added or removed from the view. All values with a check mark
beside the name are shown in the view. To remove the column, select the value with the
check mark.

e Add/ Remove Columns > Reorder Columns — This opens the Global View Preferences
window. You can reorder the columns in the Order column. See View Preferences for more
information.

e Expand/ Collapse All Groups — This expands/collapses grouped documents. You can also
click the +/- sign next to the Group Name.
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Document Name Type Linked Ver Status Last Meodified On
\_DrGroup By 4 | Document Mame
= Type: Invoice (2 documents) ‘Add / Remove Columns 3 Type
77 @ Erl_] AsbestosRemoval_QUOTE  Invoice o 1 Checked In  16/03/2011 3:56 PM Export Grids to CSV Linked
7 @ B 1nvoice-TPO300018852 Invoice o 1 Checked In =~ 04/03/2011 1:46 PM Collapse All Groups Ver
@ Type: Purchase Order Request (1 document) Expand All Groups Status
7 @ B Invoice-TP0300029031 Purchase Order Request 0 1 Checked In  04/03/2011 1:46 PM Edit Last Modified On

2. For exporting the document list to a CSV file, see Exporting Documents in a View to a CSV
File.

15.2.2.  Showing the Review or Approval Status in the Folder View
Adding the Review and Approval Status field to a folder view allows the user to be able to tell
at a glance the state of approval for all documents contained in that folder.

These fields can be added (or removed) in all views including search results, my FileHold, or
any other list customizable with the users personal view preferences.

TO ADD THE REVIEW OR APPROVAL STATUS COLUMN TO A VIEW ON THE FLY
1. Right-click column header and select Add/Remove Columns.

2. Select Review Status or Approval Status from the list. The Approval Status is added as a
column to the view.

Docwwen..  Linked Ver Stabus: Last Modiied .  Rel.
6 Fopkcatin 4 b Tresckesd In

i pbion 1] i Fwnchd In 12442014 21

EEE

pphestion ] 3 Chaschoad I
Foplosten . L Tk In 10

Eppheation o 1 Fsckaed In

EEE

b sty o i Cwcked In  10{24/2014 32

08082

TO MODIFY THE VIEW PREFERENCES TO ADD THE REVIEW OR APPROVAL STATUS COLUMN

1. Goto View Preferences and select the view you want to modify from the list.

2. Inthe Add Field drop down list, select Approval Status or Review Status and click Add
Field.

3. Click OK to save changes.

15.2.3.  Setting the Default Cabinet Drawer, Folder Group, Virtual Folder, or Saved Search
View

Cabinets, drawers, folder groups, virtual folders, and saved searches can have specific views
created and assigned to them so that the views are displayed in a certain way. Administrators
can create public views in the View preferences area and then assign the default view to the
search. Users can also do this for their "My Saved Searches" and “My Virtual Folders” using
personal views.

You can set a default view for a folder but it cannot be made default or forced.

TO SET THE DEFAULT VIEW FOR A CABINET, FOLDER, VIRTUAL FOLDER, OR SAVED SEARCH

1. Create a new view to be used. For folders, cabinets, public saved searches and public
virtual folders, administrators will need to create a public view. For personal saved
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searches (My Saved Searches) end users can create personal views. See View
Preferences for more information.

2. Right click on the folder, cabinet, virtual folder or saved search name and select Set
Default View.

3. Select the view you want to use from the drop down list. To use the global default view,
select the Use global default view check box.

4.  To make this the default view all users, select the Make it the default setting for all
users check box.

5. To enforce the use of this view for this saved search, select the Force all users to use
this default setting check box.

6. Click OK to save your settings.

15.3. ALERT PREFERENCES

You can set alert preferences so that you are notified when a change occurs to a document or
folder. You can view alerts in My FileHold > Document Alerts and/or receive an email alert, if
you system has been configured. In order to receive an alert, you must have set an alert on a
document or folder. See Setting Document Alerts and Reminders for more information.

The alert preferences allow you to determine which type of change you want to be notified of,
such as a document addition, change to metadata, or when a file is checked. Users can also
be notified via email and alerts of specific date based events call user defined events. For
example, policies must be updated or reinstated at least once every three years. The policy
team would like to review the documents 60 days before the three year anniversary. The event
can be set up so that every three years, the owner of the policy will be notified 60 days prior to
the policy expiry date. User defined events are set on the document schema by the library
administrator. For more information, see the Library Administration Guide.

Some, none, or all of these settings may be determined and/or enforced by your system
administrator. See your system administrator for details.

TO SET ALERT PREFERENCES
1. Do one of the following:
e InFDA, goto File > Preferences and Settings > View Preferences.
e In Web Client, right-click on My FileHold and select VView Preferences.
e Inthe Web Client, go to Administration Panel > My FileHold > View Preferences.
2. Inthe My Alert Setting window, select the following folder alert options:
¢ New documents/versions are added to folders | have subscribed to.
e Documents are transferred to folders | have subscribed to.
e Documents are deleted from folders | have subscribed to.
3. Select the following File (document) alert preferences:
e A new version of a document | have subscribed to is checked-in.
e Metadata values are updated for a document | have subscribed to.

4. In the Email Alert Preferences, select the check box if you wish to receive an email in
addition to displaying alerts in the My FileHold > Document Alerts area.

5. Enter the email address that the alert should be emailed to.
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6. Select an alert frequency:
e Send email immediately — Sends the email as soon as the change is made.
e Send a daily summary — Sends the email once per day with a summary of all the alerts.
e Send a weekly summary — Sends the email once per week with a summary of all the alerts.

7. Inthe Reminders area, select the Send email... check box to have reminders emailed to
the specified account.

8. Select an email reminder frequency:
e Send email immediately.
e Send a daily summary.

9. Click OK.

15.4. WORKFLOW PREFERENCES

You can set preferences to be notified via email when certain workflow events involving you
occur and delegate your tasks to someone else if you are away from the office for a period of
time.

Workflow tasks can be viewed in Reviews and Approvals > My Tasks list. See Viewing
Workflow Tasks for more information.

Some, none or all of these settings may be determined and/or enforced by your system
administrator. See your system administrator for details.

TO SET WORKFLOW ALERTS
1. Do one of the following:
e Inthe FDA, go to File > Preferences and Settings > Workflow Preferences

e Inthe Web Client, right-click on Reviews and Approvals and select My Workflow
Preferences.

2. In the My Workflow Preferences window, select the check boxes for the events you want to
be emailed for. NOTE: These options may be locked down by your system administrator.

e Atask is assigned or delegated to me

e Atask is assigned to me is overdue

e Atask assigned to me is overridden

e Atask assigned to me has been reserved by another participant.

e Atask assigned to me is cancelled

e Atask assigned to me is restarted

e A document associated with a task assigned to me is added or removed
e A document associated with a task assigned to me is checked out or checked in
e If tasks in workflow | am the initiator are overdue

e Activity is completed for a workflow | initiated

e Workflow is completed for a workflow | initiated

e Workflow is restarted for a workflow | initiated

April 2017 < Hold 163



FileHold 15.2 End User Guide

e Document is added or removed from a workflow I initiated

e Workflow is completed for a workflow | am an observer of

e Workflow is restarted for a workflow | am an observer of

e Document is added or removed from a workflow | am an observer of
e Activity is completed for a document that | own

3. Inthe email alert frequency, set how often you wish to receive email alerts. NOTE: These
options may be locked down by your system administrator.

e Send email immediately — Sends the email as soon as the change is made.
e Send a daily summary — Sends the email once per day with a summary of all the alerts.
e Send a weekly summary — Sends the email once per week with a summary of all the alerts.

4. To automatically delegate your tasks to someone else in the event that you will be
unavailable due to a vacation, sabbatical, or iliness, select the Automatically delegate
tasks... check box and click Find. To delegate a workflow on a case per case basis, see
Delegating Tasks to Another User.

NOTE: A library administrator can delegate tasks on a user’s behalf. See the Library
Administration Guide for detalils.

In the Find People window, enter a name or email address and click Find.
In the Search Result select the user and click Select User(s).
Click OK.

15.5. FASTFIND PREFERENCES

FastFind provides search capability from third party windows-based forms applications such as
Windows Desktop Applications such as accounting or GIS software. FastFind works in
conjunction with the FileHold Desktop Application (FDA). Users can use keyboard shortcut
shortcuts that perform searches directly from the chosen application in the document
management system to find relevant data instantly.

FastFind is relatively easy to set up and use by most users with some basic instructions;
however, FastFind can be leveraged to perform a more dynamic search of the document
management system by someone who can work with regular expressions. You can also set up
FastFind templates to improve your searches from various third party applications.

For example, a search in a Microsoft Word document for the term “FastFind” using the shortcut
key CTRL +D, returns the search results in the FileHold Desktop Application. In the example
below, there are 97 results found.

Advanced Search Hide Advanced '_@"

[ search Metadata Only [~ Indude Archivein Search  [] Indude Al Document Versions  [—] Search Using Historical Metadata Fields

,.. Search Results 1-97 of 97 Select View: | Default View
2 & % 1 57 | save as Saved Search Highlight Results 7]
Document Name Location Type Linked Ver Status o
7 @ = Invoices for October 2010 Product Development [ General / LGES - Invoice... Project Management 1] 1 Checked In
17 @ = Invoice for November 2010 Product Development [ General / LGBS - Invoice... Project Management 1] i Checked In
1 =

7 @ = nvoices for December 2010 Product Development [ General / LGES - Invoice,.. Project Management 1] Checked In

FastFind searches can be based on a full text search (file and metadata search) or a quick
search. If based on a quick search, it will only search on that specific search parameter and
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nothing else in the system (unlike a full text search which will search through everything).
Advantages of using up a quick search with FastFind would be to be able to limit the search
results. For example, if FastFind was only used to locate an invoice in FileHold from your
accounting software, the search results would be limited to what documents would be found
using “Invoice Number” quick search. See Quick Searches for more information on configuring
quick searches.

NOTE: FastFind preferences can only be set in the FileHold Desktop Application. It cannot be
set in the Web Client.

Some, none, or all of these settings may be determined and/or enforced by your system
administrator. See your system administrator for details.

In order to use FastFind, you must purchase this optional feature. Contact sales@filehold.com
to purchase the FastFind module.

My FastFind Preferences ? *

Enable FastFind [] Update FastFind templates when 1 log in to FileHold
Enable mouse search Alt+5

Enable selection search Ctrl4+D

Enable Clipboard search Alt+C

Enable screen OCR. search Alt+F

Searchusing: (@) File and metadats
() Quick search

Sharteut Summary

Name Description Last Modified Date Last Modified By

Cancel Apply

ToO SET THE FASTFIND PREFERENCES

1. InFDA, goto File > Preferences and Settings > FastFind Preferences. NOTE: These
options may be locked down by your system administrator.

2. To enable FastFind, select the Enable FastFind check box.

To have the FastFind templates updated when you log onto the document management
system, select the Update FastFind templates... check box. Read more about FastFind

templates.
4. Select the check boxes for the following shortcut key options:

e Mouse Search (Alt + S) — Activates an on-the-fly screen scraper. When this is done a
green bar appears in the bottom-left corner of the user’s desktop screen. Users can now
start moving their mouse over screen form objects such as data fields or field labels. The
text under the current mouse position is captured and displayed in the green bar. If a user
wishes to search with the captured text they may left click to invoke the FileHold search.
This initiates the Full Text and Metadata search in FileHold and the search results are
displayed within the standard search results screen. Pressing the ESC button at any time
will stop the mouse search mode.

e Selection Search (Alt + D) — Highlighting a word or string or partial string in a third party
application and pressing Alt+D will initiate a Full Text and Metadata search and display
results within FileHold application.

< Hold .
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6.

7.

15.5.1.

Clipboard Search (Alt + C) — This uses a 2-step process to search for documents in the
Library. First, you copy any text from the screen to the Windows clipboard using traditional
“Copy” menu option or the Alt+C shortcut available in most Windows applications. Next,
press Alt+C to use the contents of the Windows clipboard to activate a Full Text and
Metadata search in FileHold. Since FastFind uses the contents of the clipboard, any string
or partial strings can be copied to the clipboard and searched upon.

Enable screen OCR search (Alt + F) — Allows you to do a search based on the Click to Tag
functionality. Once the shortcut key is invoked, you can click on the text on the screen or
draw a bounding box (rubber band) around the text. Then a search is performed in FileHold
to meet the selected criteria from the screen.

In the Search using area, select one of the following:

File and metadata — Searches document name, metadata, document contents and file
properties

Quick search — Searches for only the quick search parameter. Click ... to select the quick
search. To learn how to create a quick search, see Quick Searches.

To activate FastFind templates, select the check box next to the template name. Learn
more about creating FastFind templates.

Click OK.

Changing the FastFind Keyboard Shortcuts

You can change the predefined keyboard shortcuts to a different shortcut key. You would do
this if the default FastFind shortcut key conflicts with another preset shortcut key in the
application that you are doing the searching from. For example you can change the mouse
search shortcut to Shift + F3 instead of using Alt+S.

TO CHANGE THE SHORTCUT KEY

1.

In FDA, go to File > Preferences and Settings > FastFind Preferences. NOTE: These
options may be locked down by your system administrator.

Click the keyboard shortcut type you want to change (mouse search, selection search, or
clipboard search).

In the Change Shortcut screen, change the default keyboard combination and click OK.

My FastFind Preferences 7] x|
™ Enable FastFind ™ Update FastFind templates when I log in ta FileHald
™ Enable mouse search Alt+5
™ Enable selection search Chrl+Dr
[ Enable Clipboard search Alt+C “. Click shortcut to change it
™ Enable screen OCR search Alk+F
Change shortcut
Shaorbouk Summary
Select new shortcut
Last Modified By
I shit I cul ¥ ar |F |
ak. | Cancel |

166

’ HOld April 2017


http://www.filehold.com/help/user/fastfind-templates

End User Guide FileHold 15.2

15.6. RESET MY PASSWORD (WEB CLIENT)
A locally managed user (non-Active Directory user) can change their password at any time.
This section describes the process on how to change a password via the Web Client.
To change your password in the FileHold Desktop Application, go to the user preferences.

Note: If FileHold is synchronized with Active Directory, this option is not available. See your
system administrator to change your password if using Active Directory.

TO CHANGE YOUR PASSWORD USING THE WEB CLIENT

1. InWeb Client, right-click My FileHold and select Reset My Password.
2. Enter your current password.

3. Enter your new password twice.
4

Click Update. The new password will take effect next time that you log in.
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16.WORKING DOCUMENTS

FileHold makes managing the documents that users have downloaded to their local machine
easy. These "working documents” can be ones that have been checked out of FileHold for edit
or downloaded as local copies for local reference.

When the user wants to clean up the files that they have downloaded or checked out to their
local machine they can do so by logging into the FileHold Desktop Client and using the
Working Documents tool.

The Working Documents window displays the contents of the default "local folder*. It lets
users know if the file has been checked out, the local version number and whether it is the last
version located in FileHold. This information helps users decide what action to take for each
file.

NOTE: The "local folder" is the "My FileHold Documents” folder that is automatically created by
FileHold when it is installed on a local computer. This is typically under /My Documents/My
FileHold Documents folder.

In order to see documents that a user may have downloaded to folders other than the default
folder, the user can clear the Show my local working folder only check box setting. The list
of all documents that a user has downloaded or checked out will appear.

=¥ Working Documents

1 show my local working Folder anly (C:\Documents and SettingshAdministratariMy Documentsiiy FileHold Documents)

Local File Path Local Wersion  Last Wersion  Status Maodified
CHDocuments and Settings) AdministratorDeskiopiMarkDavis, docx 1 es Checked In Mo
CDocuments and Settings) AdministratoriDeskioptQuath the raven. docx 1 Yes Checked In Mo
CHDocuments and Settings) AdministratorDeskiopiRonald Davis, docx 1 Yes Checked In Mo
ChDocuments and SettingstAdministratoriDeskiopt Sophia Randle. docx 1 ¥es Checked In Mo
ChDocuments and SettingstAdministr atoriDeskiop! Testing URL as link.docx 1 Yes Checked In Mo
ChDocuments and SettingstAdministrato.. .\ This is a WORD 2003 doc for testing purposes.doc 1 ies Checked In Mo
CDocuments and SettingstAdministratorify Docume..\2010-05-05,12, 24, 15.57-00003.F0F 1 ies Checked In Mo

Users can then select files one at a time or in groups and using the Synchronize button at the
bottom of the results screen, choose which local folder(s) clean-up function they would like to
perform. Users have 3 functions to select from:

e Get newer version of files from the library —Downloads a more recent version of a
document from FileHold to the local folder when the version on FileHold is newer than the
one in the local machine.

168 ‘ HOld April 2017



End User Guide FileHold 15.2

Check-in files that | have updated locally — Checks in files that users have updated locally
but not yet returned to the system.

Remove duplicate or older files that | have on my local computer— Checks for files that are
duplicated or are older versions of documents that have newer versions available and
deletes them from the local folder

Synchronize Local Files with the FileHold Library

This wtility will synchronize Files you have stored on your local computer with files stored in the FileHold library.
It does this by determining if files on wour machine are older, newer or the same as the ones stored in the
FileHald server, By selecting a synchronization option and clicking the 'Preview' button you will be able to view
and seleck exactly which files will be processed.

w |

or
Check-in Files I have updated locally

Remove duplicate or older files that I have on my local computer

The Working documents list can be accessed when users are disconnected from the server
and working offline, however they will not be able to synchronize the files until they are again
hooked up to the server. This means that they may not have access to the very latest version
of a document or that any updating that they do to a document offline will have to wait until they
are reconnected to the server to be updated in FileHold.

TO ACCESS THE WORKING DOCUMENTS TOOL

1.

2
3.
4

Open the FileHold Desktop Application.
Select Tools > Working Documents. The list of working documents appears.
Click Synchronize.

Select from the options outlined above.
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17.WATCHED FOLDERS

170

Watched folders create a kind of direct line that allows users to place their documents into the
watched folders and from there they are automatically sent to the document management
system. Users can create as many watched folders as they need. When a user creates a
Watched Folder, the files that are placed there are automatically associated with an existing
document schema and metadata and then sent either to the Inbox or to a mapped folder in the
Library. Files configured to be sent to an existing folder in the Library can be sent ONLY if the
schema selected does not have any required fields missing. If the fields are required and the
values are missing, the files will go to the Inbox for processing even if a destination folder has
been mapped.

The Watched Folder does not perform Auto-filing because in many cases the files will not have
completed metadata values associated with them. However, documents can be tagged quickly
en masse the Inbox. Once the files are prepared in the Inbox, the user can then click Auto-File
in the Inbox to send all the files to their final destination.

Watched folders are typically used in conjunction with scanning stations; however, you can
also use this feature to import a large quantity of documents into the system. When scanning
documents, you can set an output folder for the batch and then configure the Watched Folder
to watch that output folder for any new scanned images. FileHold will automatically import any
new documents from the output folder into the Inbox of FDA or configured folder in the Library.
A different output folder for each batch type should be created in the scanning software (QSP)
as well as a corresponding Watched Folder should be created for each output folder. See the
QSP Best Practices for more information on creating batches. Watched folders should be used
when you are scanning documents with Full-Text OCR or no OCR batches. For Zonal OCR
scanned batches, use the Manage Imports tool.

Watched Folders can only be created in the FileHold Desktop Application (FDA).

NOTE: The following file types cannot be brought into FileHold using Watched Folders: asp,
asx, bas, bat, cer, chm, cmd, com, cpl, crt, csh, exe, fxp, hlp, hta, inf, ins, isp, js, jse, ksh, Ink,
mda, mdb, mdt, mdw, mde, mdz, msc, msi, msp, mst, ops, pif, prf, prg, reg, scf, scr, sct, shb,
shs, tmp, vb, vbe, vbs, vsmacros, vss, vst, vsw, ws, wsc, wsf, and wsh.

To CREATE A WATCHED FOLDER
1. InFDA, goto Tools > Watched Folders and click Add.

2. In the Browse for Folder window, select the folder that you want to "watch" on your local
computer or network drive. For example, select the output folder for a scanned batch of
documents.

In the Watched Folder Properties window, the Folder Path to the Watched Folder is shown.

Select the Delete input files check box to automatically delete the files from the folder that
is being watched. This keeps the folder clean and reduces the folder size; this could
potentially get quite large if you are scanning a lot of documents.

5. To automatically send the files to a specific folder in the Library, select the Automatically
send files to selected folder in FileHold check box and click ... to select a destination
folder.

6. To set the metadata for the documents, select the Automatically set metadata for input
files check box and select the Document Schema name from the list.

7. Enter the metadata values. You can determine which metadata fields will receive a fixed
value for all the documents by selecting the check box next to the metadata field name and
entering a value. If the check box is selected and the metadata field is required, a value
must be entered into the field. If the check box for the metadata field is not selected, a
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10.
11.
12.

value is not required even if the field is required. However, the “Automatically send files to
the FileHold Library” cannot be enabled since the required value is missing and will need to
be entered in the Inbox. If the metadata field is set to “read-only”, then you cannot select
the check box; this field will always use the default initial value set up in the schema.

Select the Automatically "Send files" to the FileHold Library to automatically send the
files to the set folder location. If you do not select this option, then all files will go to the
Inbox instead of being automatically sent to the folder location. This option is not available
unless the Automatically set metadata for input files is selected.

To delete the files that are successfully imported into the library, select the Delete input
files sent to library check box.

Click OK when done.
The new Watched Folder will appear in the List of Watched Folders.

To delete a Watched Folder, click the red X next to the Watched Folder name in the
Watched Folders list.

April 2017
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18.VIEWING ALL FILES IN TRANSFER

If you are moving a bulk load of files into the system, you can view the files that are in transfer
into the document management system. This is helpful when you want to see how the file
transfer is progressing, or if you need to pause or cancel a transfer.

In the View Files in Transfer window, you can pause, resume, cancel, or clear completed and
cancelled transfers into the system. You can also view only those files that are being sent into
the Library at the current time.

Pawse Resume Cancel Clear Completed & Canceled
W inchade ‘Coming From' ibrary Stwtuws: F o pendng M Completed F Error
Document Mame Document Schema  Application  Coming From Stakus :l

1_', 13016145027-0L Fhedes FD& CriUsersiAdmi. . \dooument Completed
H 100 Applcation PO C\Users Sdmi. . docun 2 oenpletad
ol 13101614522) Eutwi, Sttt FD& Compheted
B 131016145857-X Clairnasnt Form oA et
e Eaard Mirute: FD& penpleted
m Inwckes FOA Coenpleted
s Applcaton FOu Completed

TOVIEW ALL FILES IN TRANSFER

1. Inthe FDA, goto View > All Files in Transfer. The following table describes the functions
in the All Files in Transfer View:

Function Description

Pause Puts a hold on the transfer of a document.

Resume Removes a pause on a document so it can be transferred into the
Library.

Cancel Cancels a document from being transferred into the Library.

Clear Completed and Removes all completed and canceled transfers from the view.

Canceled

Include "coming from" When enabled, all documents being sent to the library and

library downloaded from the library are shown. If disabled, only the
documents that are or will be sent to the library are shown.

Status: Pending Shows all documents that pending to be sent to the library with a
status of “Scheduled to Send” when enabled.

Status: Completed Shows all documents that have been sent successfully into the
library with a status of “Completed” when enabled.

Status: Error Shows any errors that occurred while sending documents into the
library with the status of “Failed” when enabled. TIP: Hover over
the “Failed” status to see why the document failed to be sent to
the library.
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19.FILEHOLD COURIER

FileHold customers need to send documents stored in the repository or approval tasks to
employees, customers, partners, contractors, or associates who are not licensed users of the
FileHold system. Courier allows you to transmit documents for viewing or approving to people
inside or outside the FileHold system.

Some typical scenarios where this feature will be used include the following:
e Engineering transmittals
e Contract approvals
e Employee attestations
e  Private document lists
e EXxpense reports

Courier is a “proof of delivery” system where unlike email it is a secure method of sending
documents. With emalil, there is no way to know if the documents ever arrived, if the
attachment could be opened by the recipient, and so on. With Courier, it notifies recipients by
email of a transmission, but the transaction is fully tracked.

Courier is a pay per use system. Documents can be sent to an enabled FileHold registered
user for “free” or customers can prepay for a certain number of uses of the portal by non-
registered users. As a “transmission” is sent to a non-registered user, the transmission will be
deducted from the amount of Courier license units they purchased.

Customers can purchase Courier licenses in packs. These Courier license packs contain the
number of units purchased. Units are consumed when documents are sent out through a
Courier process. The number of units consumed in a view or approve action depends on what
type of Courier license pack was purchased. For example, viewing a document consumes one
unit, but approving a document requires two units. Packs can be priced differently according to
volume. Contact sales@filehold.com for Courier license pricing.

The ability to send documents to the easy viewing and approval portal is controlled by a global
configuration option. See the System Administration Guide for more information.

The following image is a high level overview of the Courier process on documents for end
users.

Sender
Recipient Recipient checks
logs into completes transmission
Courier view or status in

Recipients
clicks link

and goes to
Courier
portal

portal approval Courier
(optional) action transmission
report

19.1. INITIATING A COURIER TRANSMISSION

A user with a role of document publisher or higher can initiate a Courier transmission. The only
exception to this is if the user belongs to a group that have the “Disable sending to Courier”
option enabled. The initiator of the transmission must be the owner of the documents unless
the permission setting “lgnore document version ownership when initiating workflows or

sending Courier transmissions” is enabled. See the System Administration Guide for more
information.
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Courier transmissions can be initiated on one or more document. When initiating a
transmission, the sender may be able to modify some of the Courier template information such
as the name of the transmission, the description, the recipient information, target date, sender
notification, and additional options. The transmission cost (number of Courier units reserved for
the transmission) as well as the number of remaining units are shown in the Send
<Transmission Name> window.

Post-initiation, the status icon in FileHold for the documents changes to a red dot @ unless the
system administrator permission setting “Enable editing document metadata when a workflow
or Courier approval transmission is active” is enabled. If enabled, then status icon changes to a
red and yellow dot © indicating that the metadata can be changed while under the Courier
process. See the System Administration Guide for more information on permission settings.

The same Courier template cannot be re-initiated on the same documents that are currently
have an active Courier transmission with an approval task. However, the same documents can
have a different Courier template initiated on them.

View actions can be transmitted on older versions of a document. Approval actions can only
occur on the latest version of a document.

If an approval transmission has been marked as “Not Approved”, the system does not allow a
second transmission to be done on the same document version. Instead, a new version of file
will have to be added to the system and the Courier transmission re-initiated.

When the Courier process is initiated, Courier license units are held in reserve until the activity
is completed. Once the activity has been completed, Courier usage units are consumed. One
time usage is given to a specific user for a specific operation. For example, if ten users need to
view single document then ten units must be granted. If a single user is given five documents
to approve they are granted ten units. Registered FileHold users do not consume Courier
license units, only external recipients of the transmission.

All Courier transmission activity is recorded in the Courier transmission log.

TO INITIATE A COURIER TRANSMISSION

1. Select all of the documents to go into the Courier transmission. You can locate the
documents through a search, a virtual folder, My Favourites, document tray, etc.

e Inthe FDA, use the CTRL + click or SHIFT + click to select multiple documents.
e Inthe Web Client, select the check boxes next to the document names.
2. Right-click and select Courier > Initiate Courier <template name>.

e All documents must have the same Courier template as a part of its schema. If all
documents do not have the same Courier template in their schemas, then an error
message appears stating that the transmission cannot be initiated.

3. The Courier template opens. You may be able to modify some or all of the template details.
See the table below for information on the template details.

Field Name Description

Recipients tab

Name Enter a name for the workflow template.

Description Enter a description for the Courier template. It is recommended that you

enter as many details as necessary so that users will know exactly what this
Courier template is for.
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Field Name

Recipients

Description

The recipient’s area is used to assign users to an activity. At least one
recipient is required for the Courier template.

Click Add 3 to assign a user a task.

In the Add recipients page, select an Activity type:

View — Sends the documents to a user for viewing. A “view” occurs when
the document is downloaded through the Courier portal.

Approve —Sends the documents to a user for approving. The user can
“approve” or “not approve” the documents as needed in the Courier portal. A
signature can also be enforced when approving documents if the Require
approval password check box is enabled.

Select the Source type and assign the recipients to the activity:

External —Users that do not have registered user accounts and are outside
of the FileHold system. Enter the email addresses of the recipients of the
activity separated by commas (,) or semi-colons (;).

Internal —Internal FileHold registered users. Select the users or groups in
the Details tab and click Add Group or Add User. Assigned users show in
the Current Recipients list.

Metadata — Select the metadata field that contains the email addresses for
the users for the assigned activity. In the text type metadata field, multiple
email addresses can be separated by semi-colons, comma, or new lines.
The address can refer to an external user or a FileHold registered user.

In the Instructions field, enter the instructions to be completed by the
recipients in the activity. Click OK when done.

The recipient’s activity is added to the list in the template with the action type
specified:

o
o View &l

e Approve ﬂ

Continue to add more recipients and activities to the list by clicking Add 3

To edit a recipient, click Edit :

To remove a recipient, click Delete E!

Transmission costs

Transmission
cost in Courier

units

Courier units

remaining

April 2017

The number of Courier units held in reserve and charged if the transmission
is completed.

The number of Courier units that remain in the purchased licensing packs.
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Field Name Description
Settings tab
Target date Select the Approval or view due by check box and enter the number of

days and hours the recipient has to complete the activity.

e Due date is calculated when the transmission is launched, so this field
should be configured for the number of days or hours from launch that the
first task will be due. For example, if the task needs to be completed in 5
hours, you would enter 0 days and 5 hours.

An exact date and time (fixed) can be specified in the template if enabled.

To send reminders of the activity, select the Send reminders every check
box and enter the number of days and hours.

If the transmission is to expire after a certain time period, select the
Transmission expires after check box and enter the number of days. After
the transmission expires, the documents are no longer accessible through
the Courier portal.

An exact date and time (fixed) can be specified in the template if enabled.

Sender Select the Notify before transmission is overdue check box to send an
notification email to the sender of the transmission prior to the due by date and time of
the activity. Enter the number of days and/or hours.

To repeat the overdue task email notification for the transmission sender
after a specified period of time, enter the number of hours to resend the
email in the Repeat notification every x days and x hours area. For
example, if 8 hours is entered, an overdue email will be sent every 8 hours
until the task is complete. If the repeat notification time is not set, the
notification is sent only one time.

Options Select the Allow postpone approval check box to allow documents to be
marked as "Approval Postponed" for an approval activity.

The “Postpone Approval” option can be used in circumstances where a
document cannot be approved because some conditions have not been met
but there is nothing wrong with the document itself.

In the Courier portal, to postpone on an approval, click Request Changes.

The following 1 documents require your approval.

Document name Type of File Action Prod ID

2K13_Magic_Setup_Guide PDF o 830 ‘
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Field Name

Description
Select the Require access password check box if the user must log into the
Courier portal with a password in order to see the transmission.

If a password is required to log into the portal, then the first time the user
accesses the portal they are required to set their password.

If sent to a registered FileHold user, then their password is the same as the
FileHold password.

Courier N FileHold Courier

Email rsauve@hotmail.com
New password P ®
Re-enter new ®
password

Couriar nowarad hv FilaHnld

Select the Require approval password check box if the user must enter
their password to complete the approval process. This is akin to an
electronic signature and verifies the approver.

C our. i eri FileHold Courier

The sender has asked you to provide your password to confirm you approve the
document(s) in this transmission.

Email rsauve@hotmail.com

Password F *

Forgot your password?

Courier, powered by FileHold

4, Click OK to start the transmission.

5. You will receive a message stating that the transmission has been successfully initiated.

Click OK.
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19.2. VIEWING DOCUMENTS IN THE COURIER PORTAL

A recipient of a transmission will get an email containing details of the transmission along with
a link they can use to view the documents in the Courier portal. When the link is clicked, the list
of documents they have been given access to view is displayed. The recipient may be required
to login to the Courier portal prior to viewing the document list.

NOTE: If the recipient of the transmission is using an email address that is being used in a
FileHold user account, then the password to log into the portal is the same as the FileHold
user.

There may an option to “view” the document using the built-in viewer if the format is supported.
Supported formats include jpg, jpeg, png, bmp, gif, tif, tiff, docx, and pdf. A View button will
appear for any supported document format. There is no configuration required to make the
viewer work with Courier. The viewer will open the document in a separate pane. In the viewer
you can scroll through pages, zoom in and out, fit width, fit length or whole page.

The information displayed in the portal is configured by the system and/or library
administrators. Below is an example of what might be seen by a recipient in the Courier portal.

C our. ier M FileHold Courier

My account -  Logout

sysadm sysadm wants you to view 1 documents

Hide

Sender sysadm sysadm

Date sent 03-03-2017

View by 05-03-2017

Transmission number b83e09dc-59¢ec-45ab-a0c9-163e174¢86¢3

The following 1 documents are available to be viewed.

Document name Type of File Action Prod ID

Policy_Sample_Electronic_Records_Retention_full PDF .@' 833

Courier, powered by FileHold

In order to view documents in the natively supported application, they must first be downloaded
or viewed using the built in viewer. To download a document, click the document name and
click Download. Once the document is downloaded it is considered as “viewed” and the
Courier unit held in reserve for this transmission is consumed. Each document downloaded
consumes one Courier unit.

The view action icons are the following:
k=4 — The view action in the transmission is pending.
&% — The view action in the transmission is overdue.

2% — The view action in the transmission is completed.
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19.3.

The sender may suspend viewing of the document after the approval has been completed. If it
has been suspended, the following message appears:

Transmission visibility has been suspended.

If a transmission is overdue but not yet expired, the view can still be completed. The view
action details can be seen in the Courier transmission report.

APPROVING DOCUMENTS IN THE COURIER PORTAL

A recipient of a transmission will get an email containing details of the transmission along with
a link they can use to approve the documents in the Courier portal. When the link is clicked, the
list of documents they have been given access to approve is displayed. The recipient may be
required to login to the Courier portal prior to viewing the document list.

NOTE: If the recipient of the transmission is using an email address that is being used in a
FileHold user account, then the password to log into the portal is the same as the FileHold
user.

There may an option to “view” the document using the built-in viewer if the format is supported.
Supported formats include jpg, jpeg, png, bmp, gif, tif, tiff, docx, and pdf. A View button will
appear for any supported document format. There is no configuration required to make the
viewer work with Courier. The viewer will open the document in a separate pane. In the viewer
you can scroll through pages, zoom in and out, fit width, fit length or whole page.

The information displayed in the portal is configured by the system and/or library
administrators. Below is an example of what might be seen by a recipient in the Courier portal.

Courier N FileHold Courier

basiepie1@gmail.com My account - Logout

sysadm wants you to approve 1 documents

Sender sysadm

Date sent 27-01-2017

View by 29-01-2017

Transmission number 2e6C7760-6470-42ab-b35a-1c0b7275cd37

The following 1 documents require your approval. You must view or download all documents before you will have the
option to approve.

Document name Type of File Action Prod ID
Invoice # 10398 Save-a-lot Markets 09-Jan-1997 PDF '(i)'
[ =]

Courier, powered by FileHold

The document needs to be downloaded or viewed prior to being able to approve the
documents. To download the document, click the document name and then click Download. If
the document format is supported by the viewer, a View button is available in order to view the
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document. If documents are not viewed nor downloaded then only the Do not approve and
(possibly, depending on configuration) the Request changes buttons appear.

Once the document is viewed or downloaded, the Approve button appears. All documents are
approved, not approved, or changes are requested (approval postponed) as a group.
Documents cannot be approved individually when in a single transmission.

The following 1 documents require your approval.

When a document is downloaded or viewed, each document consumes a Courier unit held in
reserve. Once the document has been marked as “Approve”, an additional Courier unit is
consumed for each document. If the documents are marked as “Do not approve” with or
without first downloading a document, two Courier units are consumed for each document in
the transmission. If the document is marked as “Request changes”, then no Courier units are
consumed.

When approving documents, comments and attachments are allowed to be sent back to the
sender for additional information. The comments and attachment document can be seen by the
sender in the Courier transmission report.

Courier D FileHold Courier

basiepie1@gmail.com My account ~ Logout

Action | approve this document(s)

Comments

Attachment
Browse...

Courier, powered by FileHold

When approving documents, you may be required to enter your password. This verifies that the
correct person is approving the document.
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Courier D FileHold Courier

The sender has asked you to provide your password to confirm you do not approve the documents(s) in this

transmission.

Email basiepiel ma n

Password *

Forgot your password?

Courier, powered by FileHold

After the approval is complete, the status icon changes. The approval action icons are the
following:

o @ — The document requires downloading prior to marking as approved.

N & The approval action in the transmission is pending.

o ﬂ — The approval action in the transmission is marked as approved.

o U — The approval action in the transmission is marked as approval postponed.
o D — The approval action in the transmission is marked as not approved.

o U — The approval action in the transmission is overdue.

Your approval had been requested for the following 3 documents.

Document name Type of File Action Prod ID

131016145027-JL JPG c 830
131016145221 JPG a 830

131016145857-JL JPG c 830

If a document is not approved, the actions for any other recipients are immediately cancelled
and Courier units are returned if the action has not already completed. A message is displayed
when attempting to access a transmission that has been not approved:

“This transmission was not approved by another approver on 11/2/2015
10:35:44 AM and is no longer available. The transmission identifier is
8fd24e24-e6bc-4914-a554-1aa33d390ede.”

If the transmission was marked as “Request changes”, the actions for any other recipients are
voided and Courier units are returned if the action has not already been completed. A message
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is displayed when attempting to access a transmission that has been already marked as
“request changes” (approval postponed).

If a transmission is overdue but not yet expired, the approval can still be completed.

The sender may suspend viewing of the document after the approval has been completed. If it
has been suspended, the following message appears:

Transmission visibility has been suspended.

The approval action details can be seen in the Courier transmission report.

COURIER TRANSMISSION REPORT

The Courier transmission report is a list of all the transmissions that are pending, completed,
overdue or expired in the system. It provides an audit trail that is maintained each time a
Courier transmission is sent and Courier units are reserved or consumed. The report includes
a number of items such the transmission name, the recipients of the transmission, the sender
of the transmission, the documents involved, the date of transmission and when the
transmission is due, and the number of Courier units granted and consumed.

Once the Courier transmission report has search results, the transmission details can be
viewed. The Courier transmission detail contains a summary of the transmission, the
documents, the recipients, a documents and recipients matrix, and the transmission log.

A sender of a transmission with a document publisher role or higher can access the Courier
transmission report.

To VIEW THE COURIER TRANSMISSION REPORT

1. Inthe Administration Panel, go to Workflow management > Courier transmission
report.

2. Use the filter can be used to narrow down the results. Click the + or — to expand or
collapse the filter as needed. See the following table for filter options.

Filter option Description

Status in the list The current status of the transmission:

e Approved

e Viewed

e Pending

e Overdue

e Cancel

e Postponed

e Not approved

o Expired
Type The type of transmission:
e Approve
o View
Transmitted date The date the transmission was sent:

From <select date>
To <select date>

x days ago
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Filter option

Description

Due date

The date the transmission is due:
From <select date>
To <select date>

x days from now

Completed date

The date the transmission was completed:
From <select date>
To <select date>

x days ago

Completed % range

The percentage of the transmission
completed. Minimum value 0, maximum
value 100.

Transmission name contains

Enter a full or partial name of the
transmission.

Document name contains

Enter a full or partial name of the document
sent in the transmission.

Sender

Select the sender of the transmission from
the list.

Recipient email

The email address of the recipient of the
transmission.

3. Click Apply Filter to see the search results.

settings.

Click Clear Filter to clear all of the filter

4. The search results are shown in a table below. See the following table for a description of

the Courier transmission report columns.

Column

Description

Transmission name

The name of the Courier template unless
changed by the initiator.

Documents

The documents that are involved in the
transmission. If there is more than one
document, the number of documents
transmitted is show and is hyperlinked to the
Courier transmission details where the
documents can be viewed in the Documents
summary area.

Recipients

The name or email address of the recipient
of the transmission. If there is more than one
recipient, the number of recipients is shown
and is hyperlinked to the Courier
transmission details where the recipient
names can be viewed in the Recipients
summary area.

Transmitted

The date that the transmission was sent.
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Column Description

Due The due date of the required action
(view/approve).

Completed The date or percentage (%) completed.

Status Current status of the transmission:

Approved

Viewed

Pending

Overdue (yellow)
Cancel (red)
Postponed (yellow)
Not approved
Expired (red)

Sender The initiator of the Courier transmission.

O/T granted The number of Courier units held in reserve
for the transmission.

O/T consumed The number of Courier units that were
consumed after the transmission is
completed.

5. To cancel a pending transmission, select the check box next to the transmission name and
click Cancel transmission.

6. To rename a pending transmission, select the check box next to the transmission hame
and click Rename. Note that the “Allow sender to define” check box must be enabled on
the Courier template in order to modify a Courier transmission name. See the Library
Administration guide for more information.

7. To resend the notification emails to the recipients for a pending transmission, select the
check box next to the transmission name and click Re-send pending. The notification
emails are resent.

8. To export the search results into a CSV file, click Export all as CSV.

To VIEW THE COURIER TRANSMISSION DETAILS
1. From the Courier transmission report, click on a Transmission name in the search results.

2. The Courier transmission detail is shown. See the following table for the transmission
details descriptions.

Field Description

Transmission Summary

Name Name of the transmission. This is the name
of the Courier transmission template or if the
transmission was renamed manually by the
sender.
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Field

Description

Status

Current status of the transmission:

e Approved
Viewed
Pending
Overdue
Cancel
Postponed
Not approved
Expired

Transmitted

The date the transmission was sent.

Due The date the transmission is due.
Expires The date the transmission expires and is no
longer accessible through the Courier portal.

If no expiry date was set, this is blank.

Completed The percentage of the transmission that is
completed.

Sender The sender of the transmission.

Type The type of transmission:
e Approve
o View

Visibility This field is available when a transmission
has been viewed or approved:

e Suspended - Document viewing access is
removed in the portal. If an approved or
viewed transmission expires, the visibility is
suspended.

¢ Enabled - Document viewing access is
available in the portal.

Click Suspend viewing to remove

document viewing access.

Click Enable viewing to restore document

viewing access.

Documents The number of documents sent in the
transmission.
Recipients The number of recipients the transmission

was sent to.

Courier grants

The number of Courier units held in reserve
for the transmission.

Courier consumed

The number of Courier units used upon
completion of the transmission.

Transmission number

The unique identifier for the transmission.

Documents summary

Name

The name of the document.
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Field Description
FHID The unique FileHold ID number.
Version The version number of the document sent in

the transmission.

Transmissions that have only view activities
in the Courier template can be sent on older
versions of a document. In this case, the
version number is shown.

Transmissions that have approval activities
in the Courier template can only be sent for
the current version of a document. In this

case, “Current (version humber)” is shown.

Remaining events

The number of view or approval actions left
on the documents.

Recipients summary

Name

The name of the recipient.

If the recipient is not registered and is
considered a Courier user, the email
address of the recipient is shown.

Type

Registered — The recipient is a registered
user of FileHold or has an account in the
Courier portal. An account in the Courier
portal is created for a user if the user
requires a password to approve a document.
This is set on the Courier template.

Courier — The recipient is a Courier user of
Courier and is not registered in the system.

Email

The email address of the recipient.

Remaining events

The number of view or approval actions left
for the recipient.

Comment Any comments entered by a recipient for an
approval action.
Attachment Any attachments added by the recipient for

an approval action. Click the attachment
name to download a copy.

Documents and recipients matrix

Document name

The name of the document.

Recipient name

The name of the recipient the document was
sent to.

Transmission type

Type of transmission:

e View
e Approve

<®
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Field

Description

Status

The current status of the transmission:

Completed — The action has been
completed.

Pending — The action has not yet been
completed.

Voided — If a document was not approved or
approval postponed then all other
transmission types are voided.

Cancelled — The transmission was
cancelled.

Expired — The transmission is expired.

Transmission log

Action Displays what happened with the

transmission:

e Sent

¢ Notify

e Remind

e Download

e Approve

e DoNotApprove

e PostponeApproval

User The name of the sender or recipient or was a
system process that completed the action.

Recipient The recipient of the action. May be blank if
there is no recipient for the actions such as
“Sent”.

Document The FileHold ID of the documents sent in the
transmission. May be blank if the document
is not part of the action such as “Sent” or
“Notify”.

Date/time The date and time of the action.

IP address The IP address of the recipient. May be
blank for certain actions such as “Sent” or
“Notify”.

Status The status of the action such as “Success”.
May be blank for certain actions such as
“Sent”.

Details Displays any details about the action such

as comments or attachment name. May be
blank.

3. Toresend any pending transmissions, click Resend pending notifications. The
notification emails are resent to the recipients.

4. To cancel a pending transmission, click Cancel transmission.
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5. To return to the Courier transmission report, click Return to the report.
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20.WEBCAP - WEB BROWSER SCANNING

FileHold WebCap is a web-based scanning feature that allows remote users to scan
documents via a web browser without the need of scanning software installed except for the
scanner drivers and the browser connector. Remote users can scan and store documents into
the FileHold document management repository from anywhere they have access to the internet
and a scanner. Note that WebCap works only with scanners that correctly support the TWAIN
driver interface.

This feature is useful for organizations that have many remote offices or many mobile workers
who need to scan documents such as contracts, bill of sales, expenses, or work estimates into
a document management system. It is especially powerful for companies who want these
documents to go into a workflow to automate review and approval processes after they have
been scanned.

20.1. USING WEBCAP

WebCap scanning is done via the FileHold Web Client which is a browser based client. The list
of supported browsers can be viewed in the FileHold System Requirements. In the Web Client,
all scanning and viewing of the documents is done in the Scanner Inbox.

In order to scan images, ensure that you have the TWAIN driver installed on your computer for
your scanner. You will also need to install the Twain Web Connector in order for the scanning
to work.

The quality of the scan and compression of the final document that is uploaded to the
document management repository or saved to the local computer can be controlled in WebCap
settings.

WebCap allows pages to be previewed, added, removed, zoomed, de-skewed, rotated,
compressed, loaded from, and saved to disk. Documents can be stored in FileHold in TIFF or
PDF format.

Documents in the Scanner Inbox are saved to the FileHold server until they are removed. This
allows users to log off and come back to the images at a later time without losing them.

In order to start scanning, you will need to:
e Install the correct TWAIN driver for the scanner
e Install the TWAIN Web browser connector
e Connect WebCap to the scanner

TIP: Before you make a final scanner selection to use with WebCap you should test WebCap,
the scanning workstation, the TWAIN driver, and the scanner together. WebCap supports the
TWAIN 2.3 standards, but this is not true for all scanner vendors, on all operating systems, and
with all of their models.

WARNING: Currently only HTTP protocol can be used with WebCap. WebCap does not work
with SSL connections.

20.2. INSTALLING THE SCANNER TWAIN DRIVER

WebCap works with scanners that support the TWAIN driver interface. Using the software that
came with your scanner, install the TWAIN driver. If your scanner did not come with TWAIN
software for your scanner, contact the scanner manufacturer for support.
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20.3. INSTALLING THE TWAIN WEB CONNECTOR

When starting the Web Client and going to the Scanner Inbox for the first time, you will be
prompted to install a TWAIN Web connector. Depending on the browser you are using you
may receive various messages and pop-ups to install the plug-in.

For example, in Google Chrome, you may see a following message to install “TWAIN Web
Connector not found”. You will need to download and install the connector from the link
provided in the message.

Administration Panel User: sysadm | Help | Log Oul

TWAIN Web Connector not found

TWAIN Web Connector for FileHold WebCap is not available or not running or not
installed. Download the latest version here

You can still manage already acquired pages or add new from file.

TO INSTALL THE CONNECTOR
1. Log into FileHold and go to the Scanner Inbox.

2. Click the download link in the browser message to download and install the connector.
Follow all prompts to install the Web Scanning connector.

3. Refresh the browser by clicking F5. The connector will load. You are now ready to start
scanning.

20.4. CONNECT WEBCAP TO THE SCANNER

WebCap allows you to scan from a web browser into the document management repository or
the local computer. Prior to scanning, you will need the TWAIN driver for the scanner and the
TWAIN Web connector for the browser installed. You will also need to connect WebCap to the
scanner and configure the scanner settings. The scanner settings is dependent upon the type
of scanner being used.

You will need to select the scanner you want to use for scanning.

TO SELECT THE SCANNER

1. Inthe Scanner Inbox, click Select a Scanner &

2. Select the scanner from the drop-down list and click Close.
20.4.1. Scanner Inbox

The Scanner Inbox is where all of the scanned or added images are stored in the Web Client
version of FileHold. Documents in the Scanner Inbox are saved to the FileHold server until they
are removed. This allows users to complete other functions in the document management
system or log off and come back to the images at a later time without losing them.
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TO ACCESS THE SCANNER INBOX
1. Log in to the Web Client version of FileHold.
2. Click onthe Scanner Inbox in the Library Tree area.

N €FileHold

-

Document Tray

@ Scanner Inbox -
ﬂ‘ﬂ Add Document
& 8z My FilsHold

In the Document Viewer area, the thumbnails for the images are shown on the left and the
entire image is shown on the right for the currently selected thumbnail. The thumbnail
pane can be open or closed.

€ FileHold

nPanel  User: Renee Sawve | Help | LogOf

& scanner Inbox. B
[@ Add Document
& My FileHolg
R Reviews & Approvals
P search
@ (5 Virtual Folders
= B Library
= B Acceunting
@5 Bank Statements

[ Allinvoices
B corporate LS
B Human Rescurces
B Partners
B cusity Assurance
[ sakes
[ Training and Support
A~ Administration
C - Counti, Boards and By-Laws

D - Development and Planning
Development

B E- Environmental Services
B Engineering =
B F - Finance and Accounting

Bl H - Human Resources

J- Justice

L - Legal Affairs
I - Media and Public Relaticns

P - Protection and Enforcement Si
B R - Recreation and Culture
B s - social and Health Care Senvice .

“« » p—

20.4.2.

view
BURNABY BC V5C 6T5

lnvoice Summary

Invoice Numher \[ lovoice Date [ Account Number Page
[ roie3a7s || Febz, 20 | Tord
Shiping Address Exprass GSTHST; 121632850
currently selected FILE HOLD SYSTEMS INC Bxpress OST: 1003874920
page in thumbnail DRAPER, HUGH

4864 LOUGHEED HWY SUITE 250

Ground GST/HST: 140728450

Ground OST: 1018940643

Questions or Address Changes
Phane: 1.800 GoFedEx 1.800.463.333%

Website:  fedexca

EaLLEJ;_E_)T(ess Semvices

Transportation Charges: 208.20
Fuel Surcharge 30,94
TOTAL CAD s231.18

Scanning, Adding, and Removing Images

FedEx Nows!
Bundle Up for the Playalfs and you could win, Don't miss out.
(Over 1,300 prizes available to be won. Register today at

fedex cafplayofls. Contest closes March 8, 2012. No purchase
necessary. Some restrictions apply. For full details and Official
Rules, visit fedex.cafplayoffs.

Once everything is configured for the scanner, you can now scan images into the Scanner
Inbox of the Web Client of FileHold.

With WebCap, you can add, replace, and delete pages as well as clearing the entire document

from the Scanner Inbox.

See the table below for a list of functions and descriptions.
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Function Description

;’ Scans all documents in the scanner and
Scan a Document adds them as an image to the Scanner
Inbox. The images appear in the Document
Viewer as a thumbnail on the left side. Click
on the thumbnail for the full size image which
appears on the right.

% Replaces the selected page with a newly
Replace Page scanned page. The scanner automatically
scans and replaces the currently selected

page.

;' Allows you to add a new page from the local
Add a New Page computer. Click Browse and then Upload to
add the image. Note that only files types of
jpeg, png, bmp, emf, wmf, pcx, targa, psd,
wbmp, pcd, j2k, gif (single or multipage),
tiff (single or multipage), and pdf can be
added. If adding a multi-page giff, tiff, or pdf,
the file is split into multiple pages and
converted to jpeg format.

Deletes the currently selected page.
Delete a Selected Page ;j

a Clears all pages from the Scanner Inbox.
Clear All Pages

20.4.3. Navigating Images

Once you have images scanned into WebCap, you can use the various tools to modify how the
images are displayed.

See the table below for a list of functions and descriptions.
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Function

Description

Zoom In .EL

Zooms in on the image.

Zoom Out éj.

Zooms out from the image.

Fit to Width &-

Adjusts the image on the screen to fit the full
width of the image.

Best Fit EZ.

Adjusts the image on the screen so the
entire image is displayed.

Full Size .ﬁ

Shows the full image size.

Rotate Left ﬁ

Rotates the image 90° to the left.

R
Rotate Right Eli

Rotates the image 90° to the right.

v

Rotate 180 i

Rotates the image 180°.

3
Deskew ==].

Straightens the image so that the text of the
image is vertically aligned.

Show Document .;

Returns to the Document Viewer when a
message is being displayed. For example,
when the “delete page” or “upload page”
message appears.

Previous Page ;;1

Previous image is displayed in the
document.

Next Page 3

Next image is displayed in the document.

<page number>

Enter a page number to show the image.

20.4.4. Submitting Documents to the Repository

Once the document has been composed, you can submit it to the document management

repository for storage.

TO SUBMIT A DOCUMENT TO THE REPOSITORY

1. After the document is scanned and arranged in the Scanner Inbox, click Submit

Document@.’.

2. Select the folder location for the document from the library. The selected folder will be
bolded. The last folder used will be selected, if applicable.
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Select a Folder Select a folder to file scanned document
Submit Settings Aute-file the document according to its metadata
Metadata = ELibrary

= B Accounting

{SPBank Statements

= {Efinvoices

ez
=R

SP2014

CIAll Invoices

B corporate

E Human Resources

B Partners

B cuality Assurance

B sales

ETrsir‘ir; and Support
@ Fl A - Administration

Sel

3. Click Next.

ected: Library / Accounting / Invoices / 2014 / All Invoices

Next || submit |[ cance

4. Inthe Submit Settings screen, set the following options:

Field

Description

document

Remove cover page before submitting the

Automatically removes the first image from
the document that is being submitted.

document

Clear Scanner Inbox after submitting the

Removes all images from the Scanner Inbox
after the document is in the repository.

Bi-level image compression

Select one of the following compression
levels for black and white or grayscale
images:

e None

e CCIT Group 3

e CCIT Group 4 (default)
o LZW

For more information on compression levels,
see Compression Levels for Scanning.

Color image compression

Select a compression level for color images:
e None

o LZW

e JPEG 25%

e JPEG 50%

o JPEG 75% (default)

e JPEG 90%

For more information on compression levels,
see Compression Levels for Scanning.
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Field Description
Document file format Select one of the following
o TIFF
e PDF

5. Do one of the following:
e Click Next if you are using barcodes to index your documents.
e Click Submit to add the document to the repository.

6. If you clicked Next, review the schema and metadata information. Enter a value in any
remaining required metadata fields or edit any existing metadata values.

7. Click Submit.
The document is uploaded to the repository and is shown in the folder with the metadata
pane open.

20.4.5. Downloading Images

Single images can be downloaded to the local computer. Downloaded images can only be
saved as TIFF images.

TO DOWNLOAD DOCUMENTS

1. Select the image you want to download from the Scanner Inbox.

Click Download Document 3

Open or Save the image locally. The document is saved to the default download location
set in your browser.

4. Click OK after the document is done downloading to return to the Scanner Inbox.

20.5. TROUBLESHOOTING WEBCAP

¢ WebCap works with scanners that correctly support the TWAIN driver interface. If you are unable to
scan with WebCap, verify that you have a TWAIN driver installed for your scanner. If you are not
sure, check with the manufacturer of the scanner.

e Ensure you have the TWAIN Web Connector installed for your browser type that you are using with
the Web Client.

e If you are experiencing problems with your browser, close the browser window completely and log
back into FileHold. If you are still experiencing issues, try an alternate browser. Check the FileHold
system requirements page to see which browsers are compatible with WebCap.
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21.REFRESHING THE FILEHOLD SYSTEM

If you have made changes in the Library Administration or System Administration areas of
FileHold, you will need to update the FileHold Desktop Application by using the Refresh
function. This will load your changes into the application.

TO REFRESH THE FILEHOLD SYSTEM

e GotoFile > Refresh All.

22.ACCESSING SYSTEM AND LIBRARY ADMINISTRATION

To access the Library Administration or System Administration areas of FileHold:

e In FDA, select Administration > Administration Panel from the menu bar. You will be
redirected to the Web Client.

e In Web Client, login and click the Administration Panel link at the top of the screen.

23.VIEWING FILEHOLD REPORTS

You are able to see the reports in the Library tree if the feature has been enabled and you
have the correct permissions.

There are two preconfigured reports that can be downloaded from the Knowledge Base:

e Library List Report — Displays the contents of a cabinet.

e System Activity Report — Displays all the logon activities of users.

TO VIEW REPORTS IN THE LIBRARY
1. Inthe Library, go to Reports > FileHold Reports.
2. Select a report from the list and click Show Report. The Report Manager opens.

3. Select or enter the parameters you want to be shown in the report and click View Report.
The report results are shown.

4. You can now export the report into a XML, CSV, PDF, MHTML, Excel, Tiff, or Word file.
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| | hitp://qa-2008r2entb4/FH/FileHold/LibraryManager/ReportFerm.aspx?reportld= e9d26b99- ccf5-4fbl -b143-92db3ef9f382 T,T|
Client Type FDA - User 1D | NULL
Select or enter the
Last Name NULL First Name  Basie [ report parameters
Login Time | S MInu Logout Time | E Mo
4 4 [1 of1 b Pkl L &

FileHold Application

A TIFF file
Clentype Lt tame i
FDA McMarvin Bacie

XML file with report data
CSV (comma delimited)
Acrobat (PDF) file

— | MHTML (web archive)
Excel

Bacip Mol

12/8/2010 9:02:18 AM

44— Select an export format
Report

12/8/2010 9:05:11 AM

FDA McMarvin Basie Basie McMarvin 12/8/2010 9:05:19 AM ~ 12/8/2010 10:27:32 AM

) i 44— Reportresults
FDA McMarvin Basie Basie McMarvin 12/8/2010 12:39:01 PM 12/8/2010 2:11:55 PM
FDA McMarvin Basie Basia McMarvin 12/8/2010 2:12:13 PM 12/8/2010 2:17:20 PM
FDA McMarvin Basie Basie McMarvin 12/8/2010 2:18:33 PM 12/8/2010 2:49:12 PM
FDA McMarvin Basie Basie McMarvin 12/8/2010 3:02:34 PM 12/8/2010 3:02:48 PM
FDA McMarvin Basie Basia McMarvin 12/8/2010 3:03:02 PM 12/8/2010 4:11:08 PM
FDA McMarvin Basie Basie McMarvin 12/9/2010 9:20:13 AM 12/9/2010 9:53:08 AM
FDA McMarvin Basie Basie McMarvin 12/9/2010 9:59:52 AM 12/9/2010 2:17:16 PM
FDA McMarvin Basie Basie McMarvin 12/9/2010 3:08:47 PM 12/9/2010 3:40:08 PM
FDA McMarvin Basie Basie McMarvin 12/13/2010 9:50:33 AM  12/13/2010 11:01:21 AM
Done

24.FILEHOLD HELP

To read a help topic, click a question mark (?) in the window. You will be redirected to the
relevant topic in the online help.

You can also access the home page for the online help by selecting Help > Help from the
menu bar in the FileHold Desktop Application.
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INDEX

Document Reminders, 25
A document tray
clear documents, 144
Document Tray, 143
document URLs, 122

Add Attachment from FileHold, 11
Add documents, 23

Add File, 4 document viewer, 145
alert preferences, 166 A
full or partial views, 145
alerts, 139 documents
disable on folders, 141 A
licon, 19

mark as read, 140
removing, 140
Auto-File, 23

actions and functions, 98
add document wizard, 105
adding, 102
adding emails. See emails
B adding from FDA, 104
adding from Microsoft Office applications, 109
adding from Web Client, 105
adding offline documents, 110
C alerts, 139
cancel check out, 126
change document owner, 132
checkingin, 124
checking in from Microsoft Office applications, 125

Browse to FileHold, 11

cabinet administrator role, 17
cabinets, 89
auto-tagging, 96

managing, 89 checking in multiple documents, 126
calendar, 25 checking in/out, 124
Capture, 157 checking out, 124

Checkout, 5,8 creating shortcuts, 132

Check out and Email, 5 deleting, 123
Checked Out Documents, 24 downloading to local folders, 134
Click ToTag, 116 drag and drop, 103

entering metadata, 117
connection options, 2

emailing. See emails, See emails
exporting, 133

Conv.ert to offline, 9 exporting to CSV file, 110
Courier grey dots, 19
approving documents, 183 linking, 130

initiating transmissions, 177

overview, 177

Transmission details, 188

trans.mlssmn report, 186 purple dot, 19

viewing documents, 182 rectangle with dots, 19
CSV files red dots, 18

exporting, 110 red, yellow dots, 18

red, yellow, green dots, 18

make a local copy, 126
managing alerts and reminders, 139
move or copy, 126

D reminders, 139
removing links, 131
database lookups, 120 renaming, 133
entering m.etadata, 121 setting alerts and reminders, 139

default domain, 3 setting destination folder, 123
Delete, 5, 8 version history, 135
Document Alerts, 24 drawers, 89
document owner managing, 89

changing, 132
document publisher + delete role, 16
document publisher role, 15
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Edit Destination, 23
Edit metadata, 8
Edit Metadata, 23
electronic documents, 113
electronic records, 113
Email, 5
emails
adding, 106
adding only attachments, 108
email and check out, 129
emailing attachments, 127
emailing documents, 127, See emails
emailing links, 127
extraction rules, 106
from Web Client, 129
Microsoft Outlook, 129
Microsoft Outlook Watched Folder, 107

F

FastFind
changing shortcut keys, 170
clipboard search, 170
enable, 80
mouse search, 169
preferences, 168
screen OCR search, 170
selection search, 170
FDA, 1
accessing, 1
connection options, 2
Inbox, 22
login, 3
menus and toolbars, 4
refreshing, 200
shortcut keys, 5
FileHold
about, 1
accessing, 1
FileHold Desktop Application. See FDA
files in transfer, 176
folder groups, 89
assigning to a folder, 90
delete, 91
edit, 91
managing, 89
statistics, 91
folders, 91
archiving, 95
auto-tagging, 96
cloning, 95
colour, 94
copying, 95
creating, 93
default view, 96
deleting, 95

managing, 91
moving, 96
properties, 94
statistics, 96

Get a copy, 8
guest user role, 15

help, 201
hotkeys, 5

icons

document permissions, 18
Inbox

shared inboxes, 6

shared inbox, 22
Inbox, 22

library
cabinets, 89
drawers, 89
folder groups, 89
folders, 91
inbox, 20
library archive, 21
library tree, 21
My FileHold, 20
recent folders, 20
reports, 21
reviews and approvals, 20
search, 20
structure, 88
structure overview, 20
virtual folders, 21
Library Administration
accessing, 200
library administrator role, 17
library archive, 142
manuallly archiving, 142
moving documents back to library, 142
moving objects to archive, 142
scheduled archiving, 142
Link, 8
Link documents, 5
linking
documents, 130
local copy
documents, 126
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Make a local copy, 4
metadata
Click To Tag. See Click To Tag
copying, 122
database lookups, 120
document URL, 113
editing, 122
entering, 111
entering for a single document, 114
entering for multiple documents, 114
FileHold ID, 113
format, 113
has markups, 113
library location, 113
library status, 113
link to a web page, 122
owner, 112
size, 113
type of file, 113
version, 112
metadata pane, 111
Microsoft Office applications, 9
accessing, 1
adding documents, 109
checking in, 125
FOC window, 11
workflow, 46
Microsoft Outlook
adding emails, 106
Move/copy, 8
multiple documents workflow, 36
My Favorites, 24
My FileHold, 24

offline documents, 110, 113
organizer + delete role, 16
organizer role, 16

passwords
lost or forgotten, 12
reset, 13
userid, 13

PDF Image viewer
closing, 149
delete pages, 148
drag and drop, 148
drag and drop image, 149
insert files, 148
insert image file, 148
modify images, 148
modifying files, 147
printing, 149

200

Hold

publish as PDF, 148
reorder pages, 147
save image file, 149
undocking, 149
permission icons, 18
preferences, 155
publisher + delete role, 16
publisher role, 16

QuickScan Pro, 157

read-only role, 15
recent folders, 26
Recently Accessed, 25
Recently Added, 25
reminders, 139
mark as read, 140
removing, 140
Remove from Inbox, 23
reporting services
reports, 200
reviews and approvals, 138, See workflow
roles and permissions, 15

S

scanning. See Capture, See QuickScan Pro
see WebCap, 193
search, 64
"and" connector, 69
"not w/n" connector, 70
"not" connector, 70
"or" connector, 70
"w/n" connector, 70
# phonic, 69
% fuzzy, 69
& synonym, 69
* wildcard, 69
? matches any character, 68
~ stemming, 69
= matches any digit, 68
accessing, 65
advanced search, 71
Advanced Search, 64
boolean, 68
contains in db, 65
contains in fts, 65
empty saved search, 79
FastFind, 64, 80
for documents in a workflow, 81
for previous versions, 81
fts wildcard limitation setting, 67
full text search, 70
general usage, 66
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integrated with external applications, 81
noise words, 66
proximity, 70
quick search, 78, 81
regular saved search, 78
request types, 68
saved searches, 77
search operators, 76
security, 65
simple search, 70
Simple Search, 64
url builder, 83
words and phrases, 69
Send, 23
Send All, 23
Send to > Email, 9
Send to > Email and check out, 9
Send to > Library archive, 9
Send to > Tray, 9
Send to > Virtual folder, 9
Send to FileHold > Add Document, 11
Send to FileHold > Check In Document, 11
Send to FileHold > Send Review / Approval Feedback, 11
senior library administrator role, 17
sign off sheet, 137
System Administration
accessing, 200
system administrator role, 18

user preferences, 107, 155

Vv

version history
deleting previous versions, 136
document usage, 137
reinstating previous versions, 136
reviews and approvals history, 138
sign off sheet, 137
viewing, 135
viewing metadata edits, 137
viewing previous versions, 135
version properties
document URLs, 122
view preferences, 161
ad-hoc views, 164
setting default view, 165
workflow views, 165
viewers
publish as PDF, 153
viewers, 145
annotations, 151
FileHold viewer, 149
level 1, 149
level 2, 149
PDF/Image viewers, 146
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viewing
files in transfer, 176
virtual folders, 86
adding documents, 86
creating, 86
deleting, 86
removing documents, 87

watched folders, 174

web client, 7
accessing, 1
login, 7
menus and toolbars, 8

Web Client
reset password, 171

WebCap, 193
adding pages, 195
connecting to scanner, 194
downloading images, 199
installing WebCap Twain connector, 194
installing driver, 193
manipulating pages, 196
navigating pages, 196
removing pages, 195
scanner inbox, 194
scanning, 195
submitting to repository, 197
troubleshooting, 199
using, 193

workflow, 27
1ofX, 47,49
adding and removing documents, 38
adding documents, 39
administration panel workflow status report, 57
approval postponed, 35
approving documents, 41
automatic initiation, 40
automatically restarting, 51
cancelling, 52
checked out documents, 42
checking in documents, 50
checking out documents, 49
convert main documents to PDF, 35, 42
convert to electronic record, 30
dashboard, 59
delegate initiators, 60
delegate participants, 60
delegating tasks, 52
disable refresh of My Tasks list, 53
example, 27, 36
force reservation, 47
get a local copy, 50
initiate multiple documents, 36
initiate single document workflow, 29
main documents, 36
manually initiating, 28

Hold -



FileHold 15.2 End User Guide

multiple document initiation, 38 reviews and approvals history, 138
overriding activities, 63 sign off sheet, 137

postpone approval, 41 sign-off sheet, 53

preferences, 64 status report, 53, 54

removing documents, 40 supporting documents, 36

require password, 34 tasks, 40

reserving tasks, 47, 48 undo reservations, 49

restarting, 41 workflow change log, 58
restarting manually, 50 workflow preferences, 167

review and approval history, 60 working documents, 172

reviewing documents, 44
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